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はじめに

目的
『Cisco Unified Contact Center Express 1 サービスおよびトラブルシューティング ガイド』では、

Cisco Unified Contact Center Express（Cisco Unified CCX）の Serviceability ツールの使用手順につい

て説明し、Cisco Unified CCX システムで発生する問題解決に役立つ情報を提供します。

対象読者
『Cisco Unified Contact Center Express サービスおよびトラブルシューティング ガイド』は、Cisco 
Unified CCX システムの管理とトラブルシューティングを担当する管理者および担当者を対象として

います。

マニュアルの構成

1. Cisco Customer Response Solutions（Cisco CRS; シスコ カスタマー応答ソリューション）は、Cisco 
Unified CCX 7.0(1) 以降は、Cisco Unified Contact Center Express（Cisco Unified CCX）と呼ばれ
ます。この名前は、すべてのシスコ CRS 製品、プラットフォーム、エンジン、およびソリューショ
ンに適用されます。たとえば、Cisco CRS エンジンは、Cisco Unified CCX エンジンとなります。

パート /章 タイトル 説明

パート 1 Serviceability
第 1 章 Serviceability について Cisco Unified CCX の Serviceability サポートおよび拡張

サーバ使用時に提供されるサービスの概要を説明します。

第 2 章 Simple Network 
Management Protocol の
サポート

SNMP を使用して、Cisco Unified CCX システムを監視

および管理する方法について説明します。

第 3 章 アラーム サービス Cisco Unified CCX アラーム サービスを設定して、ア

ラーム メッセージを表示する方法について説明します。

第 4 章 トレース コンポーネント トレース ファイルおよびトレース レベル 
オプションの設定方法、トレース ログ ファイルを収集、

表示、および解釈する方法について説明します。

第 5 章 Cisco Discovery 
Protocol（CDP）のサ

ポート

CDP ドライバの使用方法、CDP ドライバのプロパティの

表示方法、CDP ドライバおよびインターフェイス ファイ

ルの検索方法について説明します。
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はじめに
関連ドキュメント
次のマニュアルも参考にしてください。

 • 『Cisco Unified Contact Center Express Administration Guide』

 • 『Cisco CAD Service Information Guide』

 • 『Cisco Unified Contact Center Express Database Schema Guide』

 • 『Cisco Unified Contact Center Express Getting Started with Scripts』 

 • 『Cisco Unified Contact Center Express Editor Step Reference』

 • 『Cisco Unified Contact Center Express Historical Reports User Guide』

 • 『Cisco Unified CCX Gateway Deployment Guide』

第 6 章 Cisco サポート ツール Cisco Unified CCX でサポートされているシスコ サポー

ト ツールの概要を説明します。

パート 2 トラブルシューティング

第 7 章 Cisco Unified CCX の問

題の診断と解決

 Cisco Unified CCX システムで発生するほとんどの問題

のトラブルシューティングに役立つ手順について説明し

ます。

第 8 章 トラブルシューティング

のヒント

Cisco Unified CCX システムのさまざまな要素に関する

トラブルシューティングのヒントです。各ヒントには、

問題の症状、考えられる原因、および問題を解決するた

めの対策が含まれています。ヒントはカテゴリ別に分類

されています。

パート /章 タイトル 説明
xiv
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はじめに
表記法
このマニュアルは、次の表記法を使用しています。

マニュアルの入手方法およびテクニカル サポート
マニュアルの入手方法、テクニカル サポート、その他の有用な情報について、次の URL で、毎月更新

される『What's New in Cisco Product Documentation』を参照してください。シスコの新規および改訂

版の技術マニュアルの一覧も示されています。

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

表記法 説明

太字 太字は、ユーザ入力などのコマンド、キー、ボタン、フォルダお

よびサブメニュー名を表すときに使用されます。例：

 • [Edit] > [Find] を選択します。

 • [Finish] をクリックします。

イタリック体  イタリック体は、次の内容を表すときに使用されます。

 • 新しい用語の出現時。例：スキル グループとは、類似したス

キルを持つエージェントの集合です。

 • 強調するとき。例：数字の命名規則は使用しないでくださ
い。

 • ユーザが置き換える必要がある構文値。例：IF (condition, 
true-value, false-value)

 • 書籍のタイトル。例：『Cisco Unified Contact Center Express 
Installation Guide』

ウィンドウ フォント Courier などのウィンドウ フォントは、次の場合に使用されま

す。

 • コードやウィンドウに表示されるテキスト。例：
<html><title>Cisco Systems, Inc.</title></html>

< > かぎカッコは、次の場合に使用されます。

 • ASCII 出力など、イタリック体を使用できない場合の引数。

 • パスワードなど、ユーザが入力するけれども、画面に表示さ

れない文字列。
xv
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C H A P T E R 1

Serviceability について

Cisco Unified CCX Serviceability は Cisco Unified CCX システムの遠隔からのネットワーク管理サ

ポートを可能にします。Serviceability による遠隔サポートは、CiscoWorks および標準プロトコルを使

用する任意のサードパーティ ネットワーク管理システム（NMS） から行うことができます。ここで標

準プロトコルとは、Syslog、Simple Network Management Protocol （SNMP; 簡易ネットワーク管理プ

ロトコル）、XML、および HTTP を指します。

このセクションは、次のトピックで構成されています。

 • 「Cisco Unified CCX Serviceability について」（P.1-1）

 • 「Serviceability のサポート」（P.1-2）

 • 「CiscoWorks のサポート」（P.1-3）

 • 「Syslog のサポート」（P.1-3）

 • 「遠隔サービサビリティ」（P.1-4）

 • 「Cisco Unified CCX コール統計情報、記録、モニタリング サーバのサービサビリティ サポート」

（P.1-4）

Cisco Unified CCX Serviceability について
Cisco Unified CCX Serviceability は Cisco Unified CCX システムの遠隔からのネットワーク管理サ

ポートを可能にします。Serviceability による遠隔サポートは、CiscoWorks および標準プロトコルを使

用する任意のサードパーティ NMS から行うことができます。ここで標準プロトコルとは、Syslog、
SNMP、XML、および HTTP を指します。
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Serviceability のサポート
Serviceability のサポート
Serviceability により任意の NMS から Cisco Unified CCX システムのインストール済みのコンポーネ

ント、サブシステム、およびサービスを監視しそれらの状態を知ることができます。また、

Serviceability から得られた情報をトラブルシューティングに活用することもできます （トラブル

シューティングの詳細については、このガイドのパート 2 を参照してください）。

Serviceability によるサポートとして次の事項を含みます。

 • SNMP サポート：CiscoWorks あるいは SNMP ベースの NMS との統合が可能になります。SNMP 
エージェントにより Management Information Bases （MIB; 管理情報ベース）に基づいてネット

ワーク装置の監視が行われます。詳細については、「CiscoWorks のサポート」（P.1-3）および

「Simple Network Management Protocol のサポート」（P.2-1）を参照してください。

 • SNMP トラップ：Cisco Unified CCX Engine の緊急度の高いエラーに関する通知メッセージを送

ります。詳細については、「Simple Network Management Protocol のサポート」（P.2-1）を参照し

てください。

 • アラーム：アラームを使用して Cisco Unified CCX システムの状態やランタイム状態を取得し、問

題が検出されれば修正措置を取ります。アラームを Syslog サーバ、SNMP トラップ サブエージェ

ント、またはWindows イベントログに転送することもできます。詳細については、「アラーム 
サービス」（P.3-1）を参照してください。

 • トレース：システム問題の解決に役立つ Cisco Unified CCX の具体的で詳細な情報を提供します。

更に詳しく解析するためにアラームをトレース ファイルに転送することができ、また、どのレベ

ルのイベント情報をトレース ファイルに転送するかを指定することもできます。詳細については、

「トレース」（P.4-1）を参照してください。

 • Cisco Discovery Protocol （CDP; シスコ ディスカバリ プロトコル）のサポート：指定されたマル

チキャスト アドレスに、システム情報を載せたメッセージを送信します。詳細については、

「Cisco Discovery Protocol（CDP）のサポート」（P.5-1）を参照してください。

 • Syslog のサポート：任意のサードパーティ Syslog サーバに共通イベントログ メッセージを標準の 
Syslog フォーマットで送信します。詳細については、「アラーム サービス」（P.3-1）を参照してく

ださい。

 • Cisco Support Tools：Cisco Support Tools の Node Agent ユティリティによりログ情報を収集し 
Cisco Unified CCX サーバのトラブルシューティングに役立てることができます。詳細について

は、「Cisco サポート ツール」（P.6-1）を参照してください。

次のツールを使用してトラブルシューティング情報をさらに収集することができます。

 • CiscoWorks：シスコ製の機器を管理するための Web ベースのアプリケーション一式です。詳細に

ついては、「CiscoWorks のサポート」（P.1-3）を参照してください。

 • サードパーティ ネットワーク管理システム：簡易ネットワーク管理プロトコル（SNMP）ベース

のブラウザ、Syslog のサポート、およびその他のシステム管理ツールを提供します。

 • Microsoft Windows 2003 パフォーマンス モニタ： Cisco Unified CCX システムのパフォーマンス

を監視することができます。詳細については Microsoft Windows のマニュアルを参照してくださ

い。

 • Microsoft Windows 2003 ターミナル サービス：遠隔システムからターミナル エミュレータにより 
Windows ベースのアプリケーションにアクセスすることができます。Windows 2003 Server ター

ミナル サービスは Windows 2003 のオペレーティング システムに含まれています。詳細について

は Microsoft Windows のマニュアルを参照してください。
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CiscoWorks のサポート 
CiscoWorks のサポート
CiscoWorks は個別パッケージとして提供され、シスコ製の装置を管理する Web ベースのアプリケー

ション一式が含まれます。NMS である CiscoWorks は、Cisco Unified CCX システムおよびその他の

シスコ製装置に対応します。

Cisco Unified CCX システムは次の CiscoWorks アプリケーションと統合することができます。

 • Cisco Unified Operations Manager （Operations Manager）：Operations Manager はネットワーク

内のシスコ製の音声装置を積極的にモニタして Cisco Unified Communications 環境の正常性を監

視することにより、問題の可能性があれば運用スタッフに通知し、Unified Communications のダ

ウンタイムを最小限に留めます。

 • Resource Management Essentials （RME）：複数の情報源から Syslog メッセージを収集してシス

テム レベルの障害を監視し分析するためのツールです。

 • Campus Manager：ネットワーク トポロジ サービスの提供、ユーザ トラッキング、およびパス分

析を行います。Campus Manager Topology Services はネットワーク図を表示するとともに、ネッ

トワーク上の個々の装置のさまざまな情報も表示することができます。装置内のアプリケーション

のバージョン情報、ランタイム状態、および URL を表示しますが、フィルタリングして指定され

た装置だけを表示することもできます。User Tracking は Voice over IP （VoIP; ボイスオーバー 
IP）ネットワーク上の IP 電話機の追跡を行います。Path Analysis はネットワーク上に指定された 
2 点間の接続をトレースし、物理パスおよび論理パスを分析する診断アプリケーションです。

CiscoWorks の詳細については、次の URL のマニュアルを参照してください。
http://www.cisco.com/en/US/products/sw/cscowork/ps3996/tsd_products_support_series_home.html

Syslog のサポート
トレース ファイルに情報を書き込むとともに、Cisco Unified CCX システムでは 標準イベントログ 
メッセージを Alarm Service を介して Syslog サーバへ送信します。これらメッセージには Cisco 
Unified CCX Engine およびサブシステムの動作に関する情報が含まれています。Syslog サーバを使用

してこれらのメッセージを分析することができます。

Syslog メッセージを分析するために、Cisco Unified CCX システムを CiscoWorks RME と統合するこ

とができます。RME Cisco Syslog Analyzer はすべてのイベント メッセージを制御し、表示します。こ

れによりメッセージを解読し、フィルターし、システム運用やトラブルシューティングに利用すること

が容易になります。Syslog Analyzer ではこれらのレポートが WorkFlow Report で参照できます。

Cisco Unified CCX システムからの Syslog 出力を加工して、標準 Syslog を受信できる別のネットワー

ク管理システムで利用することができます。

Syslog サーバの設定に関しては 「アラーム サービスの設定」（P.3-3）を参照してください。

CiscoWorks の詳細については、次の URL のマニュアルを参照してください。
http://www.cisco.com/en/US/products/sw/cscowork/ps3996/tsd_products_support_series_home.html
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遠隔サービサビリティ
遠隔サービサビリティ
Cisco Service Engineer （CSE; シスコ サービス エンジニア） は、さまざまなサービサビリティ ツール

を使用して Cisco Unified CCX システムの運用管理をサポートすることができます。トラブルシュー

ティングやシステム診断が必要な時に、CSE がこれらツールを使用してシステム情報やデバッグ情報

を遠隔から収集することができます。

CSE は許可を得たうえで Cisco Unified CCX にログインしてデスクトップまたはシェルを取得するこ

とにより、ローカルに実行できる機能をすべて実行することができます。

遠隔サービサビリティ用のツールとして次のものがあります。

 • CiscoWorks：Cisco Unified CCX システムおよび Cisco Unified CCX ネットワークの遠隔管理機

能を提供します。詳細については、「CiscoWorks のサポート」（P.1-3）を参照してください。

 • Microsoft Windows 2003 パフォーマンス モニタリング： Cisco Unified CCX システムのパフォー

マンス カウンタをローカルあるいはリモートシステムから監視することができます。詳細につい

ては Microsoft Windows のマニュアルを参照してください。

 • Microsoft Windows 2003 ターミナル サービス：遠隔システムからターミナル エミュレータにより 
Windows ベースのアプリケーションにアクセスすることができます。Windows 2003 Server ター

ミナル サービスは Windows 2003 のオペレーティング システムに含まれています。

 • Virtual Network Computing （VNC; バーチャル ネットワーク コンピューティング）は コンピュー

タを遠隔から制御するデスクトップ プロトコルです。キーボード操作やマウスのクリックを 1 台
のコンピュータから別のコンピュータに転送し、画面表示の変化をネットワーク上で逆方向に転送

します。今日ではさまざまな VNC フリーウェアが入手可能です。

Cisco Unified CCX コール統計情報、記録、モニタリング 
サーバのサービサビリティ サポート

Cisco Unified CCX の統計情報をモニタ、記録、そして管理するための専用サーバを設置することがで

きます。このようなサーバを Cisco Unified CCX コール統計情報、記録、モニタリング サーバと呼び

ます。さらにモニタ専用のサーバを 1 台または複数台設置することもできます。このサーバを Cisco 
Unified CCX コール モニタリング サーバと呼びます。Cisco Unified CCX のインストール手順により、

自動的にこれら専用サーバのサービサビリティが設定されます。

サービサビリティにより CiscoWorks およびサードパーティ NMS のサポートが可能になります。サー

ビサビリティとして次の事項を含みます。

 • CDP のサポートにより CiscoWorks から Media Convergence Server （MCS; メディア コンバー

ジェンス サーバ）が自動的に検出されます。

 • CISCO-CDP-MIB のサポート。

 • SYSAPPL-MIB のサポートにより、音声録音および音声モニタサービスに関するランタイム状態

やバージョン情報の提供、およびアプリケーション ディスカバリが可能になります。

 • 標準のサードパーティ MIB のサポート。

 • CiscoWorksのためのEMBLEM のサポート。
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Simple Network Management Protocol の
サポート

このセクションは、次のトピックで構成されています。

 • 「Simple Network Management Protocol について」（P.2-1）

 • 「SNMP の基本」（P.2-2）

 • 「SNMP エージェントおよびサブエージェント」（P.2-2）

 • 「SNMP 管理情報ベース」（P.2-2）

 • 「SYSAPPL-MIB」（P.2-3）

 • 「CISCO-VOICE-APPS-MIB」（P.2-6）

 • 「CISCO-CDP-MIB」（P.2-6）

 • 「SNMP トラップ」（P.2-6）

 • 「SNMP トラップ メッセージ」（P.2-7）

 • 「SNMP トラップの設定」（P.2-8）

Simple Network Management Protocol について
Simple Network Management Protocol（SNMP; 簡易ネットワーク管理プロトコル）は、ネットワーク 
デバイス間で管理情報を交換するための業界標準インターフェイスです。SNMP とそのコンポーネン

トは、Cisco Unified CCX システムに関する情報を提供します。この情報を参照して、Cisco Unified 
CCX システム、サブシステム、インストールされている関連コンポーネントのステータスを監視およ

び管理できます。この情報は、問題発生時のトラブルシューティングにも使用できます。

Cisco Unified CCX システムで生成された重大度の高いメッセージやエラーを自動的に通知する SNMP 
トラップを設定できます。
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SNMP の基本
SNMP の基本
Network Management System（NMS; ネットワーク管理システム）は、SNMP を使用して、ネット

ワーク上のデバイス間の管理情報を交換します。SNMP で管理されるネットワークは、次の主要コン

ポーネントで構成されています。

 • 管理対象デバイス：それぞれが SNMP ノードを含むネットワーク ノード。管理対象デバイスは、

情報を収集および保存して、この情報を SNMP で使用できるようにします。

 • エージェント：管理対象デバイスに置かれるネットワーク管理ソフトウェア。エージェントには、

ローカルの管理情報が含まれ、エージェントはその情報を SNMP と互換性のある形式に変換しま

す。

 • 管理ステーション：NMS がインストールされ、システム管理者が管理対象デバイスからの情報を

取り出し、評価するコンピュータ。

SNMP エージェントおよびサブエージェント
Microsoft Windows SNMP サービス（SNMP サービス）は、SNMP のフレームワークとなり、SNMP 
サブエージェントとインターフェイスする SNMP エージェントを提供します。

SNMP サービスは、システムを起動すると自動的に起動します。問題が発生した場合や自動的に起動

しなかった場合は、SNMP サービスを再起動または停止できます。

詳細については、「SNMP サービスの開始、停止、および確認」（P.2-10）を参照してください。

SNMP サービスの設定方法については、「SNMP トラップ」（P.2-6）を参照してください。

SNMP 管理情報ベース
Management Information Base（MIB; 管理情報ベース）は、階層的に編成された情報のコレクション

です。MIB には SNMP を使用してアクセスします。MIB は、オブジェクト ID で識別される管理対象

オブジェクトで構成されます。管理対象オブジェクトは、1 つまたは複数のオブジェクト インスタンス

で構成され、基本的に変数です。MIB は、ステータスの監視、プロビジョニング、および通知を提供

します。

Cisco Unified CCX システムは、次の MIB をサポートします。

 • SYSAPPL-MIB：インストールされているアプリケーション、アプリケーション コンポーネント、

製品バージョン、実行中のプロセス、プロセスの開始時刻などのシステム情報を提供します。詳細

については、「SYSAPPL-MIB」（P.2-3）を参照してください。

 • CISCO-VOICE-APPS-MIB：サポートされる SNMP トラップに関する情報が含まれます。詳細に

ついては、「CISCO-VOICE-APPS-MIB」（P.2-6）を参照してください。

 • CISCO-CDP-MIB：デバイス ID、Cisco Discovery Protocol（CDP; シスコ検出プロトコル）の実

行ステータス、CDP の転送頻度、および受信デバイスが CDPメッセージを保持する時間（存続可

能時間）に関する情報を提供します。詳細については、「Cisco Discovery Protocol（CDP）のサ

ポート」（P.5-1）を参照してください。

標準的なサードパーティ MIB は次のとおりです。

 – マイクロソフトの標準 MIB（MIB II など） 

 – Compaq Insight Agent MIBS for Compaq MCS 78xx プラットフォーム 

 – IBM UM MIB for IBM 3xx MCS プラットフォーム 
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SYSAPPL-MIB
SNMP コミュニティ名は、MIB オブジェクトへのアクセスを認証し、SNMP 情報へのパスワードとし

て機能します。システムは、同じコミュニティにあるシステムの SNMP 情報だけを交換できます。コ

ミュニティの設定の詳細については、「SNMP トラップ レシーバの設定」（P.2-8）を参照してくださ

い。

MIB の詳細については、次の URL を参照してください。
http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml

SYSAPPL-MIB 
SYSAPPL-MIB は、インストールされているパッケージに関するシステム情報を提供します。この情

報には、製品名、製品バージョン、Cisco Unified CCX Administration ページの URL、ランタイム ス
テータス、アプリケーションの起動時間、および現在実行中のプロセスが含まれます。

SYSAPPL-MIB では、CiscoWorks やサードパーティの NMS ブラウザを使用して、次の Cisco Unified 
CCX コンポーネントに関する情報にリモート アクセスできます。

 • Cisco Unified CCX Administration

 • Cisco Unified CCX Node Manager

 • Cisco Unified CCX エンジン

 • Cisco Unified CCX リポジトリ データストア

 • Cisco Unified CCX 履歴データストア

 • Cisco Unified CCX 設定データストア

 • Cisco Unified CCX エージェント データストア

 • Cisco Recording

 • Cisco Monitoring

SYSAPPL-MIB では、次の Cisco Unified CCX サービスにもアクセスできます。

 • Cisco Unified CCX クラスタ ビュー デーモン

次のマネージャを含みますが、これらに限定されません。

 – Manager Manager

 – Log Manager

 – Config Manager

 – Executor Manager

 – Cluster Manager

 – Node Manager

 – Socket Manager
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SYSAPPL-MIB
 • Cisco Unified CCX Administration

次のマネージャを含みますが、これらに限定されません。

 – Manager Manager

 – Log Manager

 – Config Manager

 – Executor Manager

 – Cluster Manager

 – Node Manager

 – File Manager

 – Prompt Manager

 – Grammar Manager

 – Document Manager

 – Resource Manager

 – Script Manager

 – Expression Manager

 – Socket Manager

 • Cisco Unified CCX エンジン

次のマネージャを含みますが、これらに限定されません。

 – Manager Manager

 – Log Manager

 – Config Manager

 – Executor Manager

 – Cluster Manager

 – Node Manager

 – File Manager

 – Prompt Manager

 – Grammar Manager

 – Document Manager

 – Resource Manager

 – Script Manager

 – Expression Manager

 – Socket Manager

 – RTP Port Manager

 – Contact Manager

 – Channel Manager

 – Session Manager

 – ICM サブシステム

 – JTAPI サブシステム
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SYSAPPL-MIB
 – CMT サブシステム

 – MRCP ASR サブシステム

 – MRCP TTS サブシステム

 – E メール サブシステム

 – RmCm サブシステム

 – 音声ブラウザ サブシステム

 – コア リアルタイム報告サブシステム

 – エンタープライズ サーバ データ サブシステム

 – データベース サブシステム

 –  VoIP モニタ サブシステム

 – HTTP サブシステム

 – アウトバウンド サブシステム

 – SIP サブシステム

 – <その他のカスタム サブシステム>
 • Cisco Desktop License and Resource Manager

 • Cisco Desktop Call and Chat Service

 • Cisco Desktop Enterprise Service

 • Cisco Desktop IP Phone Agent Service

 • Cisco Desktop Recording and Statistics Service

 • Cisco Desktop VoIP Monitor Service

 • Cisco Desktop Recording Service

 • Cisco Desktop LDAP Monitor Service

 • Cisco CCX SQL サーバ：リポジトリ 

 • Cisco CCX SQL サーバ：履歴 

 • Cisco CCX SQL サーバ：設定

 • Cisco CCX SQL サーバ：エージェント

 • Microsoft SQL エージェント

 • Microsoft Distributed Transaction Coordinator

SYAPPL-MIB では、CiscoWorks またはサードパーティの NMS を使用して、次の Cisco Unified CCX 
標準パッケージおよびエンハンスト パッケージに関する情報にもリモート アクセスできます。

 • Cisco Unified CCX Recording and Statistics (RAS) Server 

 • Cisco Unified CCX Telephony Agent Interface (TAI) Server 

（注） TAI Server は、Cisco Desktop IP Phone Agent Service とも呼ばれます。

 • Cisco Unified CCX Enterprise Server 

 • Cisco Unified CCX VoIP Monitor Server 

 • Cisco Unified CCX Chat Server 
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CISCO-VOICE-APPS-MIB
SYSAPPL-MIB では、CiscoWorks またはサードパーティの NMS を使用して、Cisco Unified CCX 
Call Statistics、Recording、および Monitoring Server または Cisco Unified CCX Call Monitoring 
Server 上の次のサービスに関する情報にもアクセスできます。

 • Cisco Unified CCX RAS Server 

 • Cisco Unified CCX VoIP Monitor Server 

SYSAPPL-MIB では、CiscoWorks またはサードパーティの NMS を使用して、SQL サービスの 
MSSQLService および SQLServerAgent のステータスに関する情報にもアクセスできます。スタンド

アロン Cisco Unified CCX サーバ（Cisco Unified Communications Manager（Cisco Unified CM）で

はなく Cisco Unified CCX がインストールされるサーバ）の場合、および Database Expansion Server 
の場合、この情報は "Cisco Unified CCX Database" として表示されます。

SYSAPPL-MIB は SNMP を使用して、ネットワークから収集した情報を整理し、配信します。Cisco 
Unified CCX システムは次の SYSAPPL-MIB テーブルをサポートします。

 • SysApplInstallPkgTable：インストールされたアプリケーションに関する製造元、製品名、製品

バージョン、インストール日、場所などの情報を提供します。場所は、関連付けられた Cisco 
Unified CCX Administration Web ページにアクセスするための URL の一部です（該当する場合）。

 • SysApplRunTable：アプリケーションの開始時刻とランタイム ステータスについて説明します。

 • SysApplInstallElmtTable：SysApplInstallPkgTable で定義されたアプリケーションを構成する

個々のアプリケーション要素または関連付けられた実行可能ファイルについて説明します。

 • SysApplElmtRunTable：ホスト システムで現在実行中のプロセスについて説明します。Windows 
のタスク マネージャに表示されるプロセスと似ています。

SYSAPPL-MIB の詳細については、次の URL を参照してください。
ftp://ftp.cisco.com/pub/mibs/v2/SYSAPPL-MIB.my

CISCO-VOICE-APPS-MIB
CISCO-VOICE-APPS-MIB は、サポートされる SNMP トラップに関する情報を提供します。

CISCO-VOICE-APPS-MIB の詳細については、次の URL を参照してください。
ftp://ftp.cisco.com/pub/mibs/v2/CISCO-VOICE-APPS-MIB.my

CISCO-CDP-MIB
CISCO-CDP-MIB は、デバイス ID、CDP の実行ステータス、CDP の転送頻度、および受信デバイス

が CDPメッセージを保持する時間（存続可能時間）に関する情報を提供します。この MIB は、

cdpGlobalInfo と呼ばれるテーブルに情報を保存します。

CISCO-CDP-MIB の詳細については、次の URL を参照してください。
ftp://ftp.cisco.com/pub/mibs/v2/CISCO-CDP-MIB.my

SNMP トラップ
Cisco Unified CCX エンジンからの重大度の高いメッセージやエラーを自動的に通知する SNMP ト
ラップを設定できます。SNMP エージェントは、これらの重要なシステム イベントを識別するトラッ

プを送信できます。トラップには、アラーム サービスも付属しています。アラーム サービスは、

SNMP トラップ サブエージェントにメッセージを転送します。メッセージは、そこから適切なフォー

マットで SNMP トラップ レシーバに送信されます。
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SNMP トラップ メッセージ
表 2-1 に、トラップ レシーバとして指定された NMS に送信される Cisco Unified CCX SNMP トラッ

プ メッセージを示します。これらのトラップ メッセージは、「SYSAPPL-MIB」（P.2-3）に示す各サブ

システムに送信できます。

SNMP エージェントは、アラーム条件を検出すると、トラップ（通知とも呼ばれます）を生成し、設

定された IP アドレスに送信します。SNMP トラップを設定する方法については、「SNMP トラップの

設定」（P.2-8）を参照してください。

フェールオーバー トラップ

Cisco Unified CCX フェールオーバー トラップは、cvaModuleName が "New Master xxx" の 
CvaProcessStart トラップを使用して送信されます。xxx はプロセス名です。下に、Cisco Unified CCX 
エンジンのフェールオーバー トラップのスナップショットを示します。

12/8/2006 13.51:28 SERVER-NAME Trap: P3 cvaProcessStart,  
ent=ciscoVoiceAppsMIBNotifications, comm-public, 
cvaAlarmSeverity=notice, cvaModuleName=New Master Engine, cvaProcessId=0

表 2-1 SNMP トラップ メッセージの説明 

メッセージ 説明

cvaProcessStart 起動された Cisco Unified CCX サーバに関連付けられた Windows プロ

セス。processId パラメータで Windows プロセス ID を指定します。

cvaProcessStop 停止または中止された Cisco Unified CCX サーバに関連付けられた 
Windows プロセス。processId パラメータで Windows プロセス ID を
指定します。

cvaModuleStart 正常に起動され、サービス中になったサブシステム。トラップには、

重大度とモジュール名が含まれます。

cvaModuleStop 停止されたサブシステム。トラップには、重大度とモジュール名が含

まれます。cvaModuleFailureCause パラメータで原因を指定します

（該当する場合）。

cvaModuleRunTimeFailure 発生したランタイム障害。トラップには、重大度とモジュール名が含

まれます。cvaModuleRunTimeFailureCause パラメータで原因を指定

します（該当する場合）。
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SNMP トラップの設定
SNMP トラップの設定
SNMP トラップを設定するには、トラップ メッセージの SNMP トラップ宛先を指定する必要がありま

す。

SNMP トラップに次のセキュリティ オプションを指定して、承認されたシステムだけが SNMP トラッ

プ情報にアクセスできるように設定できます。

 • コミュニティ文字列：SNMP 情報のパスワードとして機能します。システムは、同じコミュニ

ティにあるシステムの SNMP 情報だけを交換できます。

 • SNMP 要求の有効な送信元 

 • 読み取り /書き込み権限：システムを SNMP 情報の読み取り専用にするか、読み書きできるように

するかを指定します。

SNMP セキュリティの詳細については、Microsoft Windows のマニュアルを参照してください。

SNMP トラップ センダーの設定については、次の項を参照してください。

 • 「SNMP トラップ レシーバの設定」（P.2-8）

 • 「SNMP コミュニティ名の設定」（P.2-9）

SNMP トラップ レシーバの設定

トラップ レシーバとは、SNMP トラップを受け取る NMS です。この NMS の SNMP コミュニティ ス
トリングは、トラップ センダーと同じでなければなりません。Cisco Unified CCX システムは、

CiscoWorks および標準のサードパーティ NMS が受信可能なトラップを送信します。

SNMP トラップ レシーバを設定する手順は、次のとおりです。

ステップ 1 Windows デスクトップから、[Start] > [Settings] > [Control Panel] を選択します。

ステップ 2 [Administrative Tools] をダブルクリックします。

ステップ 3 [Services] をダブルクリックします。

[Services] ウィンドウが表示されます。

ステップ 4 [SNMP Services] を右クリックし、[Properties] を選択します。

ステップ 5 [Traps] タブをクリックします。

ステップ 6 [Community name] フィールドに、このコンピュータがトラップ メッセージを送信するコミュニティ名

を入力します。

少なくとも 1 つのコミュニティ ストリングを設定する必要があります。設定しない場合、SNMP は要

求に応答しません。コミュニティ名では大文字と小文字が区別されます。

ステップ 7 [Add to List] をクリックします。

ステップ 8 [Trap destinations] フィールドの下で、[Add] をクリックします。

ステップ 9 [SNMP Service Configuration] ダイアログ ボックスに、トラップの宛先の IP アドレスまたはホスト名

を入力します。

ステップ 10 [SNMP Service Configuration] ダイアログ ボックスで、[Add] をクリックします。

ステップ 11 必要なトラップ宛先ごとに、手順 7 ～ 10 を繰り返します。

ステップ 12 [OK] をクリックして変更を適用し、[SNMP Service Properties] ウィンドウを閉じます。
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SNMP トラップの設定 
SNMP コミュニティ名の設定

SNMP トラップにセキュリティ設定を使用して、承認されたシステムだけがトラップに送信された情

報にアクセスできるように設定できます。SNMP コミュニティ名は、SNMP 情報のパスワードとして

機能します。SNMP 要求に有効な送信元を設定して、システムを読み取り専用にするか、読み書きで

きるようにするかを指定できます。SNMP セキュリティの詳細については、Microsoft Windows のマ

ニュアルを参照してください。

コミュニティ名と権限を設定する手順は、次のとおりです。

ステップ 1 Windows デスクトップから、[Start] > [Settings] > [Control Panel] を選択します。

ステップ 2 [Administrative Tools] をダブルクリックします。

ステップ 3 [Services] をダブルクリックします。

[Services] ウィンドウが表示されます。

ステップ 4 [SNMP Services] を右クリックし、[Properties] を選択します。

ステップ 5 [Security] タブをクリックします。

ステップ 6 [Accepted Community Names] ペインで [Add] をクリックします。

[SNMP Service Configuration] ダイアログ ボックスが表示されます。

ステップ 7 [Community Name] フィールドに、コミュニティの名前を入力します。

ステップ 8 コミュニティに書き込み権限が必要な場合は、[Community Rights] ドロップダウン リストから 
[READ WRITE] を選択します。

ステップ 9 [SNMP Service Configuration] ダイアログ ボックスで、[Add] をクリックします。

ステップ 10 必要に応じて手順 6 ～ 9 を繰り返して、他のコミュニティ名を追加します。

ステップ 11 特定の NMS だけに SNMP サブエージェントのクエリーを許可する場合の手順は、次のとおりです。

a. [Accept SNMP packets from these hosts] ラジオ ボタンをクリックします。

b. [Accept SNMP packets from these hosts] ペインで [Add] をクリックします。

c. [SNMP Service Configuration] ダイアログ ボックスに、SNMP サブエージェントのクエリーを許

可するホストの IP アドレスまたはホスト名を入力します。

d. [SNMP Service Configuration] ダイアログ ボックスで、[Add] をクリックします。

e. 必要に応じて手順を繰り返します。

ステップ 12 [OK] をクリックして変更を適用し、[SNMP Service Properties] ウィンドウを閉じます。
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SNMP トラップの設定
SNMP サービスの開始、停止、および確認 
一般に、SNMP サービスは、常に実行されます。SNMP サービスが実行中であることを確認したり、

サービスを再起動または停止したりする手順は、次のとおりです。

ステップ 1 Windows デスクトップから、[Start] > [Settings] > [Control Panel] を選択します。

ステップ 2 [Administrative Tools] をダブルクリックします。

ステップ 3 [Services] をダブルクリックします。

[Services] ウィンドウが表示されます。

ステップ 4 [SNMP Service ] 行の [Status] フィールドを見ます。

このフィールドが [Started] の場合、SNMP サービスは実行中です。このフィールドが空白の場合、

SNMP サービスは実行されていません。

SNMP サービスを開始するには、[SNMP Service] を右クリックして [Start] を選択します。

SNMP サービスを停止するには、[SNMP Service] を右クリックして [Start] を選択します。

スタートアップ中のトラップのスナップショット

次に、スタートアップ中に Cisco Unified CCX によって生成されるトラップのスナップショット例を示

します。このファイルを Acrobat ではっきりと表示するには、[Acrobat] メニュー バーの [Zoom] アイ

コンを使用して、テキストのサイズを拡大します。

図 2-1 スタートアップ中のトラップ
2-10
Cisco Unified Contact Center Express サービスおよびトラブルシューティング ガイド リリース 7.0(1)



 

第 2 章      Simple Network Management Protocol のサポート

SNMP トラップの設定 
シャットダウン中のトラップのスナップショット

次に、シャットダウン中に Cisco Unified CCX によって生成されるトラップのスナップショット例を示

します。このファイルを Acrobat ではっきりと表示するには、[Acrobat] メニュー バーの [Zoom] アイ

コンを使用して、テキストのサイズを拡大します。

図 2-2 シャットダウン中のトラップ
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SNMP トラップの設定
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C H A P T E R 3

アラーム サービス 

このセクションは、次のトピックで構成されています。

 • 「アラームについて」（P.3-1）

 • 「Cisco Unified CCX アラーム サービス」（P.3-1）

 • 「アラーム サービスの開始と確認」（P.3-2）

 • 「アラーム サービスの設定」（P.3-3）

 • 「アラーム メッセージの表示」（P.3-3）

 • 「Syslog サーバに送信されたアラーム メッセージの表示」（P.3-4）

 • 「SNMP トラップ レシーバに送信されたアラーム メッセージの表示」（P.3-5）

 • 「Windows イベント ログに送信されたアラーム メッセージの表示」（P.3-5）

 • 「アラームの定義」（P.3-6）

 • 「アラームに関する情報の検索」（P.3-6）

アラームについて
アラームは、Cisco Unified CCX システムのアクティビティに関する情報を提供します。この情報を使

用して、システムのステータスと状態を監視し、問題が発生した場合は対策をとることができます。デ

フォルトでは、Cisco Unified CCX システムは、トレース ファイルにもアラーム情報を書き込みます。

トレース ファイルの情報を使用して、問題をさらに分析できます。

Cisco Unified CCX アラーム サービス
Cisco Unified CCX アラーム サービスは、Cisco Unified CCX のインストール中にインストールされま

す。Cisco Unified CCX エンジン、Cisco Unified CCX Node Manager、Cisco Unified CCX 
Administration、Cisco Unified CCX リポジトリ データストア、Cisco Unified CCX 履歴データストア、

Cisco Unified CCX 設定データストア、Cisco Unified CCX エージェント データストア、Cisco 
Recording、および Cisco Monitoring コンポーネントからシステム イベントに関するアラームを受信す

るのは Windows サービスです。これらのアラームは、カタログと呼ばれるファイルに XML 形式で定

義されます。カタログは、Cisco Unified CCX インストール中に設定されます。
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Cisco Unified CCX アラーム サービス
Cisco Unified CCX アラーム サービスは、カタログに基づいて、受信したアラームを次の 1 つまたは複

数の宛先に転送します。

 • Syslog サーバ：標準 Syslog 形式のメッセージを CiscoWorks またはサードパーティの Syslog サー

バに転送します。詳細については、「CiscoWorks のサポート」（P.1-3）を参照してください。

 • SNMP トラップ サブエージェント：アラームを処理し、CiscoWorks の Voice Health Monitor
（VHM）などの設定済みトラップ レシーバにこれらをトラップとして送信します。詳細について

は、「CiscoWorks のサポート」（P.1-3）と「SNMP トラップ」（P.2-6）を参照してください。

 • Windows のイベント ログ：Windows イベント ビューアに表示できるアラームを送信します。詳

細については、「Windows イベント ログに送信されたアラーム メッセージの表示」（P.3-5）を参照

してください。

Cisco Unified CCX アラーム サービスが Syslog サーバに送信するアラームの重大度を指定できます。

次の表に、アラームの重大度について説明します。詳細については、「アラーム サービスの設定」

（P.3-3）を参照してください。

アラーム サービスの開始と確認

一般に、Cisco Unified CCX アラーム サービスは常に実行されています。

アラーム サービスが実行中であることを確認したり、サービスを再起動したりする手順は、次のとお

りです。

ステップ 1 Windows デスクトップから、[Start] > [Settings] > [Control Panel] を選択します。

ステップ 2 [Administrative Tools] をダブルクリックします。

ステップ 3 [Services] をダブルクリックします。

[Services] ウィンドウが表示されます。

ステップ 4 [Cisco Unified CCX Alarm Service] 行の [Status] フィールドを見ます。

このフィールドが "Started" の場合、SNMP サービスは実行中です。このフィールドが空白の場合は、

[Name] フィールドの [Unified CCX Alarm Service] を右クリックして、[Start] を選択します。

表 3-1 アラームの重大度 

重大度 名前 説明

0 EMERGENCY_ALARM システムの緊急事態 
1 ALERT_ALARM アプリケーションは動作し続けるが、利用できなくなる

機能がある状態

2 CRITICAL_ALARM アプリケーションがタスクを実行できない重大な障害

3 ERROR_ALARM アプリケーションがタスクを実行できない重大な障害 
4 WARNING_ALARM 問題は存在するが、アプリケーションはタスクを実行で

きる状態

5 NOTICE_ALARM 正常だが重要な状態の通知

6 INFORMATIONAL_ALARM エラー、警告、監査、デバッグに関連しない情報

7 DEBUG_ALARM システム エラーおよび処理ステータスに関する詳細な

情報
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アラーム メッセージの表示 
アラーム サービスの設定

アラーム サービスを設定する場合、Cisco Unified CCX システムにアラームの処理方法に関する情報を

提供します。アラーム サービスを設定する手順は、次のとおりです。

手順 3 で説明するように、[Syslog Server Name] フィールドまたは [Syslog Message Filtering Level] 
フィールドに情報を入力する場合は、手順を実行する前にアラーム サービスが実行されていることを

確認してください （詳細については、「アラーム サービスの開始と確認」（P.3-2）を参照してくださ

い）。

ステップ 1 [Cisco Unified CCX Administration] メニューから [System] > [Alarm Configuration] を選択します。

[Alarm and Tracing Configuration] ページが表示されます。

ステップ 2 ナビゲーション バーから [Alarm Server Tracing] を選択します。

ステップ 3 アラーム サービスの下のフィールドに、次のように情報を入力します。

 • Alarm Server：Cisco Unified CCX アラーム サービスが実行されているサーバの IP アドレスまた

は名前。デフォルトでは、Alarm Server は "lokalhost" です。つまり、アラーム サービスは Cisco 
Unified CCX 上で実行されます。この情報は変更できません。

 • Alarm Server Port：アラーム メッセージの送信先となるアラーム サーバのポート。この情報は、

インストール中に入力されます。デフォルト値は 1444 です。この情報は変更できません。

 • Catalog Directory：アラーム メッセージのカタログが保存されるディレクトリ。デフォルトは 
"catalog" です。この情報は、インストール中に入力されます。この情報は変更できません。

 • Syslog Server Name：アラーム メッセージの送信先となる Syslog サーバの IP アドレスまたはホス

ト名。CiscoWorks を使用している場合、CiscoWorks サーバの IP アドレスまたはホスト名を入力

します。このフィールドを空白にすると、アラーム メッセージは Cisco Unified CCX サーバに送

信されます。

 • Syslog Message Filtering Level：ドロップダウン矢印をクリックして、Syslog サーバに送信するア

ラーム メッセージの重大度を選択します。Syslog メッセージの範囲は重大度 0（最も重度）から

重大度 7（最も軽度）です。重大度を選択すると、その重大度以上のすべてのメッセージが送信さ

れます。たとえば、ERROR_ALARM（重大度 3）を選択すると、重大度が 3、2、1、および 0 の
すべてのメッセージが送信されます。デフォルトは、"DEBUG_ALARM (Severity 7)" で、すべて

の重大度のメッセージが送信されます。

ステップ 4 [Update] をクリックします。

アラーム メッセージの表示
アラーム メッセージの表示方法は、メッセージの送信先によって決まります。表示する各アラーム 
メッセージにはアラーム名が含まれます。アラーム メッセージに表示されるアラーム名に関する情報

を検索方法については、「アラームの定義」（P.3-6）を参照してください。
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Syslog サーバに送信されたアラーム メッセージの表示
Syslog サーバに送信されたアラーム メッセージの表示
CiscoWorks Resource Management Essentials（RME） Syslog サーバに送信されるアラーム メッセージ

を表示する方法については、次の URL にアクセスして、CiscoWorks のマニュアルを参照してくださ

い。
http://www.cisco.com/en/US/products/sw/cscowork/ps2073/tsd_products_support_series_home.html

サードパーティの Syslog サーバに送信されるアラーム メッセージの表示方法については、そのシステ

ムのマニュアルを参照してください。

表 3-2 に Syslog メッセージのフィールドを示します。

表 3-2 Syslog メッセージのフォーマット 

フィールド 例 説明

<pri> <128> このフィールドは、syslog が重大度を読み取れる

ように追加されます。Syslogd は、デフォルトで 
LOCAL0|SEVERITY に設定されているこの pri 
値を探します。

n: 100: このフィールドは、Solaris の syslogd を模倣し

て、syslog メッセージに内部カウンタ szi のプレ

フィクスを付けます。SAC には意味はありませ

ん。数字は SAC によって解析されます。

MMM DD Aug 09 送信元で認識される省略形の月と日付。

hh:mm:ss.mmm 19:20:10.209 送信元デバイスの時間。タイム ゾーン名の不一致

を避けるために、UTC 時間が使用されます。

TimeZone UTC GMT など、デバイスで定義された省略形のタイ

ム ゾーン。このフィールドは、タイム ゾーン名

の不一致を避けるために、常に UTC に設定され

ます。

% FACILITY Allowed 
characters A-Z 0-9 _ 

Cisco Discovery 
Protocol（CDP; シスコ

検出プロトコル）、

ALIGN（RISC のメモリ

最適化）

メッセージが参照するファシリティを示す 2 つ以

上の大文字で構成されるコード。ファシリティに

はハードウェア デバイス、プロトコル、またはシ

ステム ソフトウェア モジュールがあります。こ

れは、UNIX Syslog サーバのロギング ファシリ

ティとは異なります。

[SUBFACILITY-] A-Z 
0-9 _

Common Link Access 
for Workstations

（CLAW）

サブファシリティ コード。このフィールドは任意

です。

SEVERITY  0 0 ～ 7 の 1 桁のコードで、状態の重大度を表しま

す。数字が小さいほど深刻な状況です。重大度は

ロギング レベルにマッピングされます。

MNEMONIC BADIPALIGN：IP のパ

ケットの無効アライメン

ト 

ニーモニック コードは、エラー メッセージを一

意に識別するためのコードです。このコードは、

CiscoWorks が syslog メッセージをメッセージ カ
タログのメッセージ情報と関連付けるために使用

します。

Message-text Module Failure 
Cause=Unknown

状態について説明する文字列。
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SNMP トラップ レシーバに送信されたアラーム メッセージの表示   
フォーマット例

<LOCAL7|SEVERITY>51:Oct 18 03:28:29.327 PDT: %MIVR-GENERIC-1-ModuleStop: Module has 
stopped; Module Name=HTTP SubSystem; Module Failure Cause=Unknown

SNMP トラップ レシーバに送信されたアラーム メッセージ
の表示

CiscoWorks VHM に送信されたアラーム メッセージを表示するには、次の URL にアクセスして、

CiscoWorks のマニュアルを参照してください。
http://www.cisco.com/en/US/products/sw/cscowork/ps2431/tsd_products_support_eol_series_home.ht
ml

サードパーティの SNMP トラップ レシーバに送信されるアラーム メッセージの表示方法については、

そのシステムのマニュアルを参照してください。

Windows イベント ログに送信されたアラーム メッセージの表示

Windows イベント ログに送信されたアラーム メッセージを表示するには、Windows イベント ビュー

アを使用します。Windows イベント ビューアを使用する手順は、次のとおりです。Windows イベント 
ビューアの詳細については、Microsoft Windows のマニュアルを参照してください。

ステップ 1 Windows デスクトップから、[Start] > [Settings] > [Control Panel] を選択します。

ステップ 2 [Administrative Tools] をダブルクリックします。

ステップ 3 [Event Viewer] をダブルクリックします。

ステップ 4 ツリー ペインで、情報を表示する項目をクリックします。
3-5
Cisco Unified Contact Center Express サービスおよびトラブルシューティング ガイド リリース 7.0(1)        

 

http://www.cisco.com/en/US/products/sw/cscowork/ps2431/tsd_products_support_eol_series_home.html
http://www.cisco.com/en/US/products/sw/cscowork/ps2431/tsd_products_support_eol_series_home.html


 

第 3 章      アラーム サービス         

アラームの定義
アラームの定義
Cisco Unified CCX は、アラーム カタログのリストを維持します。各カタログには、アラームのリスト

が含まれます。各アラームにはアラームの定義が含まれます。定義にはアラーム名、記述、説明、推奨

アクション、および関連情報が含まれます。

アラーム名は、次のようにアラーム メッセージに表示されます。

 • トレース ファイル：アラーム名は、重大度の後ろに表示されます。

 • CiscoWorks RME：アラーム名は、Syslog WorkFlow レポートの [Mnemonic] フィールドに表示さ

れます。

 • サードパーティの Syslog サーバ：アラーム名は理由の後ろに表示されます。理由が表示されない

場合、モジュール名の後ろにアラーム メッセージ名が表示されます。

 • Windows イベント ビューア：アラーム名は、重大度の後ろに表示されます。

アラームに関する情報の検索

アラーム カタログを使用してアラーム メッセージ名に関する情報を検索する手順は、次のとおりです。

ステップ 1 [Cisco Unified CCX Administration] メニューから [Tools] > [Alarm Definition] を選択します。

[Alarm Definitions] Web ページが表示されます。

次の方法でアラーム メッセージ名の情報を探します。

 • すべてのアラーム メッセージ名のリストの場合は、[Catalog] フィールドに [All] が表示されてい

ることを確認し、[Search] をクリックします。

 • 特定のファシリティおよびサブファシリティに関連するアラーム メッセージ名のリストの場合は、

[Catalog] ドロップダウン矢印をクリックし、表示する項目を選択して [Search] をクリックします。

 • 特定のアラーム メッセージ名の場合は、[Enter Alarm Name] フィールドにアラームの名前を入力

し、[Search] をクリックします。

要求したアラーム メッセージ名のリストが表示されます。リストが複数のページで構成されている場

合は、[First]、[Previous]、[Next]、または [Last] をクリックして、リストを移動できます。[Page] 
フィールドにページ番号を入力して [Page] をクリックし、そのページに移動することもできます。

ステップ 2 アラーム メッセージ名の詳細な説明を表示するには、アラーム メッセージ名をクリックします。
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C H A P T E R 4

トレース 

このセクションは、次のトピックで構成されています。

 • 「トレース ファイルについて」（P.4-1）

 • 「コンポーネントのトレース ファイル」（P.4-2）

 • 「コンポーネントのトレース ファイルの設定」（P.4-2）

 • 「トレース レベル オプション」（P.4-3）

 • 「トレース レベル オプションの設定」（P.4-7）

 • 「トレース ファイルの表示および解釈」（P.4-8）

 • 「トレース ファイルの表示」（P.4-8）

 • 「トレース ファイルの解釈」（P.4-8）

 • 「スレッド ダンプ トレース ファイル」（P.4-9）

 • 「スレッド ダンプ トレース ファイルへの書き込み」（P.4-9）

 • 「スレッド ダンプ トレース ファイルの表示」（P.4-9）

 • 「Cisco Unified CCX のログ ファイル」（P.4-10）

 • 「Cisco Desktop Product Suite インストール ログ」（P.4-11）

 • 「Cisco Unified CCX Log Collection Tool」（P.4-12）

トレース ファイルについて
トレース ファイルは、Cisco Unified CCX コンポーネントからのアクティビティを記録するログ ファ

イルです。トレース ファイルを使用して、問題のトラブルシューティングに役立つ、システムに関す

る具体的な詳細情報を入手できます。

Cisco Unified CCX システムは、すべてのコンポーネント サブファシリティのトレース情報を生成でき

ます。この情報はトレース ファイルに保存されます。トレース ファイルのサイズを制御するには、情

報を収集するコンポーネントおよびサブファシリティと収集する情報のレベルを指定します。

Cisco Unified CCX システムでは、システムで実行されているすべてのスレッドに関する情報も生成さ

れます。この情報は、スレッド ダンプ トレース ファイルに保存され、トラブルシューティングの際に

役立ちます。
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コンポーネントのトレース ファイル
コンポーネントのトレース ファイル
次の Cisco Unified CCX コンポーネントにトレース ファイルを作成できます。

 • Cisco Unified CCX エンジン

 • Cisco Unified CCX Administration

 • Cisco Unified CCX Editor

 • Cisco Unified CCX Node Manager

 • Cisco Unified CCX SQL サーバ

コンポーネントのトレース ファイルには、コンポーネントの各サブファシリティに関する情報が含ま

れます。このトレース ファイルを設定するための一般的な手順は、次のとおりです。

 • 「コンポーネントのトレース ファイルの設定」（P.4-2）

 • 「トレース レベル オプション」（P.4-3）

トレース ファイルの読み取りについては、「トレース ファイルの表示および解釈」（P.4-8）を参照して

ください。

コンポーネントのトレース ファイルの設定

デフォルトでは、Cisco Unified CCX システムはサブファシリティに関する情報を、CiscoMIVRnn.log 
などのトレースファイルに送信します。nn は、01 から始まる数値に置き換えられます。トレース ファ

イルのサイズを設定できます。設定したサイズに達するか、Cisco Unified CCX コンポーネントを再起

動すると、新しいトレース ファイルが作成され、nn が 1 つ増えます。10 番目のファイルが作成される

と（デフォルト）、トレース ファイルは、最初に作成されたファイルから既存のファイルを上書きしま

す。

ここに示す例は、Cisco Unified CCX エンジン コンポーネント用です。他のコンポーネントの場合は、

コンポーネント名を置き換えて同じ手順に従ってください。

これらのデフォルトのトレース ファイル パラメータを変更する手順は、次のとおりです。

ステップ 1 [Cisco Unified CCX Administration] メニューから [System] > [Tracing] を選択します。

[Trace Configuration] ページが表示されます。

ステップ 2 ナビゲーション バーからコンポーネントを選択し、展開します。

ステップ 3 必要に応じて、[Trace File] の下で次の情報を変更します。

 • Trace File Output：トレース ファイルに情報を送信するには、このチェックボックスをオンにしま

す。トレース ファイルに情報を送信しない場合は、このボックスをオフにします。デフォルトで

は、このチェックボックスはオンになっています。

 • File Name：トレース ファイルのベース名と拡張子を入力します。トレース ファイル名は、ベース 
ファシリティ名、ファイル番号、および拡張子で構成されます（例：CiscoMIVR01.log）。デフォ

ルトのファイル名は、Cisco<facility_code>.log です。

<facility_code> は、MIVR、MCVD、MADM、MEDT または MARC です。

 • Number of Trace Files：既存ファイルの上書きを開始するまでにシステムが作成するトレース ファ

イル数を入力します。システムは、既存のファイルが [Trace File Size] フィールドで指定されたサ

イズに達すると新しいトレース ファイルを作成します。デフォルトのトレース ファイル数は 10 で
す。
4-2
Cisco Unified Contact Center Express サービスおよびトラブルシューティング ガイド リリース 7.0(1)



 

第 4 章      トレース

トレース レベル オプション  
 • Trace File Size：トレース ファイルのファイル サイズを設定できます。つまり最大サイズをバイト

数で入力できます。デフォルトのファイル サイズは 1048576 です。

ステップ 4 [Update] をクリックします。

トレース レベル オプション
トレース ファイルは、Cisco Unified CCX コンポーネント サブシステムおよびステップからのアク

ティビティを記録するログ ファイルです。トレース ファイルを使用して、問題のトラブルシューティ

ングに役立つ、システムに関する具体的な詳細情報を入手できます。

Cisco Unified CCX システムは、すべてのサブファシリティのトレース情報を生成できます。この情報

はエンジン トレース ファイルに保存されます。エンジン トレース ファイルのサイズを制御するには、

情報を収集するサブファシリティと収集する情報のレベルを指定します。

Cisco Unified CCX システムでは、システムで実行されているすべてのスレッドに関する情報も生成さ

れます。この情報は、スレッド ダンプ トレース ファイルに保存され、トラブルシューティングの際に

役立ちます。

Cisco Unified CCX エンジンなどのコンポーネントに関するすべての情報を記録するトレース ファイル

は大きくなり、読み取りが難しくなることがあります。トレース ファイルを管理しやすくするために、

Cisco Unified CCX システムでは、情報を記録するサブファシリティを指定できます。これらのサブ

ファシリティを次の表に示します。

サブファシリティごとに、[Debugging]、[Alarm Tracing]、両方、選択なしのトレース レベルを選択で

きます。これらの選択項目では、システムがトレース ファイルに送信するメッセージを指定します。

表 4-1 に、各トレース レベル設定の効果を示します。メッセージの重大度の説明については、「Cisco 
Unified CCX アラーム サービス」（P.3-1）を参照してください。

[Trace Configuration] ペインでは、トレース レベル オプションが次のリストに分類されています。

 • アクティブ トレース レベル オプション：システムで実行されるファシリティおよびサブファシリ

ティ 

 • 非アクティブ トレース レベル オプション：システムで実行されていないファシリティおよびサブ

ファシリティ 

アクティブ ファシリティで変更を加えると、トレース ファイルは、変更を即座に反映します。非アク

ティブ サブファシリティで変更を加えると、変更は、そのサブファシリティがアクティブになったと

きに反映されます。

表 4-1 トレース ファイルに送信されるメッセージ

選択項目

送信される 

メッセージの重大度 説明 
Debugging 0, 1, 2, 3, 7 詳細な情報を送信します。主に、デバッグとトラ

ブルシューティングに使用します。

Alarm Tracing 0, 1, 2, 3, 4, 5, 6 詳細なデバッグ情報を除く、すべての重大度の

メッセージを送信します。

Debugging と Alarm 
Tracing 

0, 1, 2, 3, 4, 5, 6, 7 すべての重大度のメッセージを送信します。

選択なし 0, 1, 2, 3 優先度の高い通知、エラー、アラートを送信しま

す。
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トレース レベル オプション
警告 レベル 7 のトレースはデバッグのみで、システムの問題は反映されません。

Cisco Unified CCX トレース ライブラリを使用するすべてのアプリケーションで Syslog ファシリティ 
コードが使用されます。表 4-2 に、トレース ファイルのファシリティと説明を示します。

表 4-3 に、トレース ファイルのサブファシリティを示します。

表 4-2 トレース ファイル ファシリティ 

ファシリティ 
コード 説明

MIVR ワークフロー アプリケーション フレームワーク 
MCVD クラスタ フレームワーク 
MADM [Cisco Unified CCX Administration] ページ

MEDT エディタ 

表 4-3 トレース ファイルのサブファシリティ 

サブファシリティ コード 説明 
AC_CLUSTER アーカイブ クラスタ コンポーネント 
AC_CONFIG アーカイブ コンフィギュレーション コンポーネント

AC_DATABASE アーカイブ データベース コンポーネント 
AC_JTAPI JTAPI アーカイブ コンポーネント

AC_OS アーカイブ オペレーティング システム コンポーネント

AC_CALABRIO CAD/CSD アーカイブ コンポーネント

ADM 管理クライアント

ADM_CFG 管理コンフィギュレーション 
APP_MGR Applications Manager
ARCHIVE_MGR Archive Manager
AW_CFG Restore Administration Configuration
BARBI_CLI Backup and Restore Client Interface
BOOTSTRAP_MGR Cisco Unified CCX Bootstrap Manager
CFG_MGR Configuration Manager
CHANNEL_MGR Channel Manager 
CLUSTER_MGR Cluster Manager
CONTACT_MGR Contact Manager
CONTACT_STEPS Contact ステップ

CRA_CMM Cisco Unified CCX ClusterMsgMgr 
CRA_HRDM Cisco Unified CCX Historical Reporting Data Manager
CVD クラスタ ビュー デーモン

DB データベース 
DBPURGE_MGR Database Purge Manager
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トレース レベル オプション  
DESKTOP Cisco Unified CCX Editor Desktop
DOC_MGR Document Manager 
EDT Cisco Unified CCX Editor 一般

ENG Cisco Unified CCX エンジン

EXECUTOR_MGR Executor Manager
EXPR_MGR Expression Manager
FILE_MGR File Manager
GENERIC ファシリティの汎用カタログ

GRAMMAR_MGR Grammar Manager
GRP_CFG Group Configuration
HOLIDAY_MGR Holiday Manager
HR_MGR Historical Reports Manager
ICD_CTI Cisco Unified CCX CTI サーバ 
ICD_HDM IPCC Express Historical Data Manager 
ICD_RTDM Cisco Unified CCX Real-Time Data Manager 
IO_ICM Cisco Unified ICME Input/Output
JASMIN Java Signaling and Monitoring Interface
LIB_APPADMININTERCEPTOR Cisco Unified CCX Administration Interceptor Library
LIB_AXL AXL Library
LIB_CFG Configuration Library
LIB_CRTP CRTP Library
LIB_DATABASE Database Library
LIB_DIRECTORY Directory Access Library
LIB_EVENT Event Message Library
LIB_ICM Cisco Unified ICME Library
LIB_JASPER Jasper Tomcat Library
LIB_JCUP JavaCup Library（式の解析用）

LIB_JDBC JDBC Library 
LIB_JINI JINI サービス

LIB_JMAIL Java Mail Library 
LIB_JLEX JLEX Library（式の解析用）

LIB_LICENSE License Library
LIB_MEDIA Media Library 
LIB_RMI Java Remote Method Invocation Library
LIB_SERVLET Servlet Library
LIB_TC Tomcat Library
LOG_MGR Log Manager
MRCP_CFG MRCP Configuration

表 4-3 トレース ファイルのサブファシリティ （続き）

サブファシリティ コード 説明 
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トレース レベル オプション
MGR_MGR Manager Manager 
NODE_MGR Node Manager
PALETTE Editor Palette
PROMPT_MGR Prompt Manager 
PURGING パージ

RPT 報告

RTPPORT_MGR RTP Manager 
SCRIPT_MGR Script Manager
SESSION_MGR Session Manager
SIP_STACK SIP Stack ロギング

SOCKET_MGR Socket Manager
SS_APP Application サブシステム 
SS_CM Contact Manager サブシステム

SS_CMT Cisco Media Termination サブシステム 
SS_DB データベース サブシステム

SS_EMAIL E メール サブシステム

SS_ENT_SRV エンタープライズ サーバ サブシステム

SS_HTTP HTTP サブシステム 
SS_ICM Cisco Unified ICME サブシステム

SS_MRCP_ASR MRCP ASR サブシステム

SS_MRCP_TTS MRCP TTS サブシステム

SS_OUTBOUND Preview Outbound Dialer Express サブシステム（MIVR ログ 
ファイルを使用）

SS_RM Resource Manager サブシステム

SS_RMCM Resource Manager Contact Manager サブシステム 
SS_RTR リアルタイム報告サブシステム

SS_SIP SIP サブシステム

SS_TEL JTAPI サブシステム（テレフォニー） 
SS_VB 音声ブラウザ サブシステム

SS_VOIPMON_SRV Voice over IP Monitor Server サブシステム

STEP_CALL_CONTROL Call Control ステップ

STEP_ENT_SRV Enterprise Server ステップ

STEP_MEDIA_CONTROL Media Control ステップ

STEP_SESSION Sessions ステップ 
STEP_SESSION_MGMT Session Management ステップ

STEP_USER User ステップ

STEP_CALL_CONTACT Call Contact ステップ

STEPS_CONTACT Contact ステップ

表 4-3 トレース ファイルのサブファシリティ （続き）

サブファシリティ コード 説明 
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Cisco Unified CCX 製品を 7845 マシンで実行し、トレースをオン（デフォルト）にした場合は、

[Busy Hour Call Completions (BHCC)] を 1 時間あたり 4500 コールに制限してください。高い BHCC 
を実行する場合は、デバッグ トレースをオフにしてください。オフにするトレース サブファシリティ

は、ICD_CTI、SS_TEL、SS_RM、SS_CM、および SS_RMCM です。

トレース レベル オプションの設定

トレース レベル オプションを設定する手順は、次のとおりです。

ステップ 1 [Cisco Unified CCX Administration] メニューから [System] > [Tracing] を選択します。

[Trace Configuration] Web ページが表示されます。

ステップ 2 対象の Cisco Unified CCX コンポーネントの下で、ナビゲーション バーから [Trace File Configuration] 
を選択します。

ステップ 3 [Active] および [Inactive] トレース レベル オプション リストの対象のボックスをオンまたはオフにし

ます。

ステップ 4 [Update] をクリックします。

ステップ 5 [Inactive] トレース レベル オプション リストに変更を加えた場合は、Cisco Unified CCX エンジンを停

止してから再起動し、トレース ファイルの変更を反映させる必要があります。

STEPS_DB Database ステップ

STEPS_DOCUMENT Document ステップ

STEPS_EMAIL E-mail ステップ

STEPS_GENERAL General ステップ

STEPS_GRAMMAR Grammar ステップ 
STEPS_HTTP HTTP ステップ

STEPS_ICM Cisco Unified ICME ステップ

STEPS_IPCC_EXP Cisco Unified CCX ステップ

STEPS_JAVA Java ステップ

STEPS_PROMPT Prompt ステップ

STEPS_SESSION Session ステップ

STEPS_USER.ALARM User Alarm ステップ

USR_MGR User Manager
WEB_STEPS HTTP Contact ステップ

表 4-3 トレース ファイルのサブファシリティ （続き）

サブファシリティ コード 説明 
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トレース ファイルの表示および解釈
トレース ファイルの表示および解釈 
Cisco Unified CCX サーバは、Cisco Unified CCX コンポーネントをインストールしたディレクトリの 
Log ディレクトリにトレース ファイルを保存します。[Cisco Unified CCX Administration] メニューか

ら、すべてのトレース ファイルのリストを表示し、トレース ファイルの内容を表示できます。

トレース ファイルの表示

Cisco Unified CCX コンポーネントのトレース ファイルを表示する手順は、次のとおりです。

ステップ 1 [Cisco Unified CCX Administration] メニューから [System] > [Tracing] を選択します。

[Trace Configuration] Web ページが表示されます。

ステップ 2 ナビゲーション バーからコンポーネントを選択して展開し、[Trace Configuration] を選択します。

サブファシリティ カテゴリのリストが表示されます。

ステップ 3 サブファシリティのカテゴリを展開し、対象のサブファシリティのデバッグ レベルを選択して 
[Update] をクリックします。

別ウィンドウにトレース ファイルが表示されます。

トレース ファイルの解釈
トレース ファイルには、標準 Syslog フォーマットの情報が含まれます。ファイルには、記録されたイ

ベントごとに次の情報の一部またはすべてが含まれます。

 • 行番号 

 • イベントの発生日時 

 • ファシリティおよびサブファシリティ名 

 • 重大度 

 • メッセージ名 

 • 説明 

 • パラメータと値 
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スレッド ダンプ トレース ファイル
スレッド ダンプ トレース ファイルの名前は JVM.log です。Cisco Unified CCX サーバの Cisco 
Unified CCX エンジンのインストール先ディレクトリの Log ファイルに保存されます。このファイル

には、Cisco Unified CCX システムで実行されているすべてのスレッドに関するスタック トレース情報

が含まれます。必要に応じて、このファイルに情報を書き込めます。また、重大なシステムの問題が検

出されると、その情報がこのファイルに自動的に書き込まれます。新しい情報が生成されると、既存の

スレッド ダンプ ファイルに追加されます。

（注） メモリ ダンプ ファイルもあります。このファイルは、Cisco Unified CCX Administration のスレッド 
ダンプ ファイルと同じ場所にあります。memory<timestamp>.log というタイプのメモリ ダンプ ファ

イルが作成されます。

スレッド ダンプ トレース ファイルへの書き込み

スレッド ダンプ トレース ファイルに手動で書き込む手順は、次のとおりです。

ステップ 1 [Cisco Unified CCX Administration] メニューから [System] > [Control Center] を選択します。

[Control Center] Web ページが表示されます。

ステップ 2 [Servers] をクリックし、ナビゲーション バーからサーバのホスト名を選択します（選択されたサーバ

ではない場合）。

ステップ 3 上部にある [Server Traces] をクリックし、スレッド ダンプをイネーブルにするコンポーネントを選択

します。

ステップ 4 [Dump Threads Trace] をクリックします。

スレッド ダンプ トレース ファイルの表示 
スレッド ダンプ トレース ファイルを表示する手順は、次のとおりです。

ステップ 1 [Cisco Unified CCX Administration] メニューから [System] > [Control Center] を選択します。

[Control Center] Web ページが表示されます。

ステップ 2 [Servers] をクリックし、ナビゲーション バーからサーバのホスト名を選択します（選択されたサーバ

ではない場合）。

ステップ 3 上部にある [Server Traces] をクリックし、スレッド ダンプをイネーブルにするコンポーネントを選択

します。

ステップ 4 [Dump Threads Trace] をクリックします。

ステップ 5 [File Name] 列で、[JVM.log] をクリックします。

別ウィンドウにトレース ファイルが表示されます。
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Cisco Unified CCX のログ ファイル
Cisco Unified CCX のログ ファイル
Cisco Unified CCX ログ ファイルは、問題のトラブルシューティングに役立ちます。表 4-4 に、さまざ

まな Cisco Unified CCX コンポーネントのログ ファイルに関する情報とログ ファイルのパスを示しま

す。

表 4-4 Cisco Unified CCX ログ ファイル 

コンポーネント パス ファイル /拡張子

MSI インストーラ ¥（ルート）  • CiscoUnifiedCCXMsiInstallLog.txt 

 • CalInstall.log 

 • CiscoUnifiedCCXMsdeInstallLog.txt 

 • CiscoUnifiedCCXAutorun.log

 • CiscoUnifiedCCX-BARSJVMinstall
Log.txt

 • SQLInstallLog.txt

 • CiscoUnifiedCCXMsiUnregister.log

 • UpdateTool.log

 • CiscoUnifiedCCXPatchInstallLog.txt

 • CiscoUnifiedCCXJREInstallLog.txt

クラスタ ビュー デーモン

（CVD）

¥Program Files¥wfavvid¥log¥MCVD¥ *.log

データベース 
ADS / HDS / RDS 

Cisco Unified CCX SQL 
サーバ ログ 

¥Program Files¥wfavvid¥log¥ReplLogs¥

¥Program Files¥Microsoft SQL

Server¥MSSQL$CRSSQL¥LOG¥

*.log

*.log

*.log

Cisco Unified CCX 
Administration

¥Program Files¥wfavvid¥log¥MADM¥ *.log

エンジン、driverManager ¥Program Files¥wfavvid¥log¥MIVR¥ *.log
JTAPI ¥Program Files¥wfavvid¥log¥JTAPI¥ *.log
Cisco Unified CCX Editor ¥Program Files¥wfavvid¥log¥MEDT¥ *.log

アーカイブ ツール ¥%TEMP%¥ log¥MARC¥ *.log

Serviceability コンポーネント

1. アラーム サービス

2. SNMP SYSApp

3. SNMP CDP

1. ¥Program 
Files¥Cisco¥AlarmService¥AlarmServiceLog¥ 

2. ¥Program Files¥Cisco¥AlarmService¥Log 
¥ALARM¥ 

3. ¥Program Files¥Cisco¥bin¥

1. *.log

2. SnmpSysAppImpl.log

3. SnmpCdpImpl.log
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Cisco Unified CCX のログ ファイル    
Cisco Desktop Product Suite インストール ログ

Cisco Desktop Product Suite, Version 6.4、ログ ファイルを検索する必要がある場合は、この項を参照

してください。

各種ログ ファイルの場所は次のとおりです。

 • Install Manager のログ ファイルは、C: ドライブのルートにあります。

ファイルは次のとおりです。

 – IM<number>.dbg。<number> の範囲は 0001 ～ 0010です（IM0001.dbg）。
 – IM<number>.log

 • InstallShield サイレント インストール ファイルは C:¥Winnt にあります。

 – splk_<project>.log。<project> は、splk_base.log などの Desktop インストール プロジェクト

です。

 • InstallShield のインストールおよびアンインストールのデバッグ ファイルは、<Program 
Files>¥Cisco¥Desktop¥IM にあります。

ファイルは次のとおりです。

 – splkInstall_<version>.dbg。<version> は、Desktop ソフトウェア バージョンで、

splkInstall_6.4.0.20.dbg のようになります。

 – splkInstall_Obj_<version>.dbg。<version> は、Desktop ソフトウェア バージョンで、

splkInstall_Obj_6.4.0.20.dbg のようになります。

Desktop のアンインストール後、ログ ファイルは次の場所に置かれます。

 • Install Manager ファイルは、アンインストールでリブートされるまで上で定義した場所に置かれ、

リブート後システムから削除されます。

 • InstallShield サイレント アンインストール ファイルは、BootUp ドライブのルートに置かれます。

 • InstallShield のインストールおよびアンインストール デバッグ ファイルは、C: ドライブのルート

に置かれます。

トランザクション コンポーネント

1. Transaction Manager の 
Persistence ディレクトリ

（このディレクトリを削除ま

たは変更しないでください）

2. Transaction Manager の 
Persistence Backup ディレク

トリ

3. Transaction Manager の 
State ディレクトリ（この

ディレクトリを削除または変

更しないでください）

1. ¥Program Files¥wfavvid ¥txnMgrPersistence

2. ¥Program Files¥wfavvid 
¥txnMgrPersistence_old

3. ¥Program Files¥wfavvid ¥BSTxState

1. 内部のすべて

2. 内部のすべて

3. *.per と *.old

表 4-4 Cisco Unified CCX ログ ファイル （続き）

コンポーネント パス ファイル /拡張子
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Cisco Unified CCX のログ ファイル
Cisco Unified CCX Log Collection Tool
Cisco Unified CCX Log Collection Tool を使用すると、表示するすべてのログ ファイルを 1 つの zip 
ファイルに収集できます。ツールをリモートで実行し、zip ファイルを Cisco Unified CCX サーバから

自分のデスクトップやネットワーク デバイスに移動することもできます。

Log Collection Tool を使用してログ ファイルを zip ファイルにまとめる手順は、次のとおりです。

ステップ 1 Cisco Unified CCX Log Collection Tool にアクセスするには、[Start] > [Programs] > [Cisco Unified 
CCX Administrator] > [Cisco Unified CCX Log Collection Tool] の順に選択します。

次の警告メッセージが表示されます。

警告 Log Collection Tool はシステム パフォーマンスに影響する可能性があるため、オフピーク時に実行
してください。システムのバックアップまたは復元中にこのツールを実行しないでください。Cisco 
Unified CCX サーバのディスク スペースを節約するには、ネットワーク ドライブに zip ファイルを
作成します。あるいは、ファイルの取得後にCisco Unified CCX サーバから zip ファイルを削除し
ます。zip ファイルのファイル サイズを制限するには、Log Collection Tool Advanced Options 
を使用して、開始日時と終了日時、コンポーネントのサブセットを選択します。

ステップ 2 メッセージを読み、同意したら [OK] をクリックします。

[Cisco Unified CCX Log Collection Tool] ダイアログ ボックスが表示されます。

ステップ 3 作成する zip ファイルのパスと名前を入力し、[Save] をクリックします。これで、システムのすべての

ログ ファイルが zip ファイルに収集されます。ファイル数を日付、時刻、およびコンポーネント別に制

限する場合や、zip ファイルに別の場所を選択する場合は、[Advanced Options] チェックボックスをオ

ンにします。詳細オプションのダイアログ ボックスが表示されます。

ステップ 4 日時でログ ファイルの収集を制限する情報を入力します。ログ ファイルを収集するコンポーネントの

チェックボックスをオンにし、[Source Drive] フィールドの横にある [...] ボタンをクリックして、zip 
ファイルを移動する場所を表示します。zip ファイルの場所を選択します。その場所が、[Source 
Drive] フィールドに表示されます。[Save] をクリックします。

ネットワーク ドライブではなく Cisco Unified CCX システムの場所を選択すると、続行するかどうか

を尋ねる警告が表示されます。

ステップ 5 ファイルを Cisco Unified CCX システムに保存する場合は [Yes] をクリックします。戻ってネットワー

ク ドライブ上の別の場所を選択する場合は、[No] をクリックします。

[Yes] をクリックすると、実際に zip ファイルを書き込む前に、zip ファイルが使用する予測ディスク容

量を示すダイアログ ボックスが表示されます。

ステップ 6 続行する場合は [Yes] をクリックします。zip ファイルへのログ ファイルの収集を中止する場合は [No] 
をクリックします。

ログ ファイルの収集中、進行状況を示すダイアログ ボックスが表示されます。
4-12
Cisco Unified Contact Center Express サービスおよびトラブルシューティング ガイド リリース 7.0(1)



 

Cisco Unified Contact Center Express サービスおよ

 

C H A P T E R 5

Cisco Discovery Protocol（CDP）のサ
ポート

このセクションは、次のトピックで構成されています。

 • 「Cisco Discovery Protocol（CDP）について」（P.5-1）

 • 「CDP ドライバの使用」（P.5-2）

 • 「CDP ドライバ制御へのアクセス」（P.5-2）

 • 「CDP プロトコル ドライバのインストール」（P.5-2）

 • 「CDP プロトコル ドライバの起動」（P.5-2）

 • 「CDP プロトコル ドライバのイネーブル」（P.5-3）

 • 「CDP プロトコル ドライバのプロパティの表示」（P.5-3）

 • 「CDP プロトコル ドライバの IP アドレスのアップデート」（P.5-4）

 • 「アップデートされた CDP ドライバおよびインターフェイス ファイルの検索」（P.5-4）

 • 「デフォルトの CDP 設定」（P.5-4）

Cisco Discovery Protocol（CDP）について
Cisco Unified CCX システムでは、Cisco Discovery Protocol（CDP; シスコ検出プロトコル）を使用し

て、指定されたマルチキャスト アドレスに定期的に CDP メッセージを送信します。これらのメッセー

ジには、デバイス ID、インターフェイス名、システム機能、SNMP エージェントのアドレス、存続可

能時間などの情報が含まれます。CDP をサポートするシスコ デバイスは、これらの定期的なメッセー

ジを監視して、Cisco Unified CCX サーバを検出できます。

CDP から提供される情報を使用して、CiscoWorks サーバは Cisco Unified CCX サーバを検出し、

Campus Manager アプリケーションのトポロジ サービスは Cisco Unified CCX サーバおよび他のシス

コ デバイスを表示するトポロジ マップを作成します。

CDP は、デフォルトでは、Cisco Unified CCX システムでイネーブルになっています。CiscoWorks で 
Cisco Unified CCX サーバを検出するには、CDP ドライバを常にイネーブルにしておく必要がありま

す。

（注） Windows 2003 CDP プロトコル ドライバは、Windows 2003 Server で 10/100BaseT イーサネット ネッ

トワーク インターフェイス カードを使用する Cisco Media Convergence Server（MCS）上の Cisco 
Unified CCX と動作するように設計されています。トークン リング、ATM、Windows NT プラット

フォーム（Windows 98 や Windows NT 4.0 を含む）などの他のメディアはサポートしていません。
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CDP ドライバの使用
CDP ドライバの使用
Cisco Unified CCX がインストールされているシステムを起動すると、CDP ドライバがイネーブルに

なります。CDP を使用して、CiscoWorks で Cisco Unified CCX システムを検出し、管理できるように

することができます。

CiscoWorks はダイレクト ネイバー デバイスの CDP キャッシュ MIB を使用して Cisco Unified CCX 
サーバを検出します。CiscoWorks を使用して他の Cisco Unified CCX をサポートする MIB にプロビ

ジョンや統計情報を問い合わせることができます。

CDP ドライバ制御へのアクセス
CISCO-CDP-MIB を使用して CDP ドライバを制御できます。

警告 CDP の設定は、特殊な場合だけ変更してください。たとえば、実行時にコントロール パネルから 
CDP ドライバを再起動して、システムをリセットせずに最新の IP コンフィギュレーションの変更を
検出できます。

CDP プロトコル ドライバのインストール
Cisco Unified CCX をインストールすると、CDP プロトコル ドライバがインストールされます。Cisco 
Unified CCX のインストールが終了すると、CDP プロトコル ドライバは Windows コントロール パネ

ルのデバイス ドライバのリストに表示されます。

CDP プロトコル ドライバの起動

CDP プロトコル ドライバを起動する手順は、次のとおりです。

ステップ 1 [Start] > [Settings] > [Control Panel] を選択します。

ステップ 2 [System] をダブルクリックします。

ステップ 3 [Hardware] タブをクリックします。

ステップ 4 [Device Manager] をクリックします。

[Device Manager] ウィンドウが開きます。

ステップ 5 [View] > [Devices by connection] を選択します。

ステップ 6 [View] > [Show hidden devices] を選択します。

（注） [CDP Driver Protocol] が表示されない場合は、任意のノードを右クリックして、[Scan for 
Hardware Changes] オプションを選択します。[CDP Driver Protocol] が表示されるかどうか確

認します。

ステップ 7 [CDP Protocol Driver] をダブルクリックします。

ステップ 8 [Driver] タブをクリックします。
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CDP プロトコル ドライバのインストール  
ステップ 9 [Start] をクリックして、ドライバをイネーブルにします（デフォルトは [Start]）。

ステップ 10 [OK] をクリックします。

（注） [Startup Type=Demand] を選択すると、再起動後も [Start] 設定が維持されます。

CDP プロトコル ドライバのイネーブル

CDP プロトコル ドライバをイネーブルにする手順は、次のとおりです。

ステップ 1 [Start] > [Settings] > [Control Panel] を選択します。

ステップ 2 [System] をダブルクリックします。

ステップ 3 [Hardware] タブをクリックします。

ステップ 4 [Device Manager] ボタンをクリックします。

[Device Manager] ウィンドウが開きます。

ステップ 5 [View] > [Devices by connection] を選択します。

ステップ 6 [View] > [Show hidden devices] を選択します。

（注） [CDP Driver Protocol] が表示されない場合は、任意のノードを右クリックして、[Scan for 
Hardware Changes] オプションを選択します。[CDP Driver Protocol] が表示されるかどうか確

認します。

ステップ 7 [CDP Protocol Driver] をダブルクリックします。

ステップ 8 [Driver] タブをクリックします。

ステップ 9 [Enable Device] を選択します。

ステップ 10 [Next] をクリックしてから [Finish] をクリックして、デバイスをイネーブルにします。

ステップ 11 [Close] をクリックして、システムを再起動します。

CDP プロトコル ドライバのプロパティの表示

CDP プロトコル ドライバのプロパティを表示する手順は、次のとおりです。

ステップ 1 [Start] > [Run] を選択します。

ステップ 2 [Run] フィールドで、¥WINNT¥system32¥drivers と入力します。

ステップ 3 [OK] をクリックします。
5-3
Cisco Unified Contact Center Express サービスおよびトラブルシューティング ガイド リリース 7.0(1)        

 



 

第 5 章      Cisco Discovery Protocol（CDP）のサポート          

CDP プロトコル ドライバの IP アドレスのアップデート
ステップ 4 [cdp.sys] を右クリックします。

ステップ 5 [Properties] を選択して、CDP ドライバ プロパティを表示します。

ステップ 6 [OK] をクリックします。

CDP プロトコル ドライバの IP アドレスのアップデート
CDP プロトコル ドライバは、既存のイーサネット ネットワーク インターフェイス カード上で動作し

ます。実行時に、新しい IP アドレスを設定するときに CDP を再起動できます。

CDP プロトコル ドライバをアップデートするには、Windows Device Manager を使用して、CDP ドラ

イバを新しい IP アドレス情報でアップデートします。アップデート後、システムをリセットする必要

はありません。

アップデートされた CDP ドライバおよびインターフェイス 
ファイルの検索 

Cisco Unified CCX をインストールすると、次のコンポーネントがアップデートされます。

 • CDP ドライバ（cdp.sys）が、Windows 2003 ドライバ ディレクトリ

（WINNT¥System32¥Drivers¥cdp.sys）にアップデートされます。

 • CDP インターフェイス ライブラリ（cdpintf.dll）が、Windows 2003 System32 ディレクトリ

（¥WINNT¥System32¥cdpintf.dll）にアップデートされます。

 • CDP レジスタを再インストールするためのバックアップ Regedit エクスポート ファイルが、bin 
ディレクトリ（¥Program Files¥Cisco¥Bin¥cdp2k101.reg）にアップデートされます。レジスト

リが破損した場合は、このファイルを使用して、CDP レジストリを復元します。このファイルに

よって、CDP レジストリは HKEY_LOCAL_MACHINE¥SYSTEM¥ 
CurrentControlSet¥Services¥CDP ディレクトリに復元されます。

 • cdp2k101.reg ファイルの実行後は、システムをリセットして、CDP レジストリを復元する必要が

あります。

デフォルトの CDP 設定 
表 5-1 に CDP のデフォルト設定を示します。

表 5-1 デフォルトの CDP 設定値 

説明 デフォルト値 
デフォルトの転送頻度 60 秒
デフォルトの存続可能時間 180 秒
デフォルトの状態 CDP アドバタイズメントはイネーブル
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Cisco サポート ツール 

このセクションは、次のトピックで構成されています。

 • 「Cisco Unified CCX と Cisco サポート ツールについて」（P.6-1）

 • 「Cisco サポート ツールへのアクセス」（P.6-1）

Cisco Unified CCX と Cisco サポート ツールについて
Cisco サポート ツールは、Cisco Unified CCX サーバの管理とトラブルシューティングに役立ちます。

Cisco サポート ツールはユーティリティのセットですが、Cisco Unified CCX ではサポートされていな

いユーティリティもあります。

Cisco Unified CCX は Cisco サポート ツールの次の 2 つのコンポーネントをサポートします。

 • Node Agent Service

Node Agent Service は Cisco Unified CCX インストーラにバンドルされ、Cisco Unified CCX ソフ

トウェアをインストールするとすべての Cisco Unified CCX マシンに自動的にインストールされま

す。

 • Server

サポート ツールの Server は、別のマシンにインストールする必要があります。Server は、Web 
サーバとサポート ツールのダッシュボード ユーザ インターフェイスを提供します。

Cisco サポート ツールへのアクセス
サポート ツールの Node Agent Service は、Cisco Unified CCX とともに自動的にインストールされま

すが、使用するには、サポート ツールの Server ソフトウェアも必要です。Server ソフトウェアは、シ

スコの代理店から別途購入する必要があります。

Cisco サポート ツールの使用手順を記載したマニュアルは、次のシスコの Web サイトから入手できま

す。http://www.cisco.com/en/US/products/ps5905/tsd_products_support_series_home.html

シスコからサポート ツールを購入した場合、サポート ツールの Server ソフトウェアの CD にはマニュ

アルも収録されています。
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Cisco Unified CCX の問題の診断と解決

トラブルシューティングの項では、Cisco Unified CCX システムの使用時に発生する可能性のある問題

について説明します。このマニュアルでは、問題ごとに兆候、考えられる原因、対策を示します。

ここでは、Cisco Unified CCX Administration Web インターフェイス、Cisco Unified CCX トレース 
ファイルとログ ファイル、および各種 Windows 管理タスクをよく理解していることを前提としていま

す。詳細については、『Cisco Unified Contact Center Express Administration Guide』および Windows
のマニュアルを参照してください。

この章の内容は、次のとおりです。

 • 「一般的なトラブルシューティングの手順」（P.7-1）

一般的なトラブルシューティングの手順
次のトラブルシューティング手順は、Cisco Unified CCX 製品のほとんどの問題の診断に役立ちます。

ステップ 1 Cisco Unified Communications Manager（Cisco Unified CM）が実行されていることを確認します。

ステップ 2  Cisco Unified CCX Node Manager サービスが登録されていることを確認します。

ステップ 3 [Script Management] ページを使用して application.aef ファイルをリポジトリにアップロードし、アプ

リケーションに変更を加えたあと、Cisco Unified CCX エンジンをリフレッシュしたことを確認しま

す。

ステップ 4 既知の問題については、リリース ノートを参照してください。

ステップ 5 管理者権限をもつユーザ アカウントで Cisco Unified CCX Node Manager サービスが実行されているこ

とを確認します。

ステップ 6 Internet Information Server（IIS）を停止し、起動します。

ステップ 7 ログ ファイルを保存して、上書きされないようにします。

ステップ 8 アプリケーション（.aef）ファイルを保存します。

ステップ 9 Cisco Unified CCX Administration の問題をデバッグする前に、DM サブファシリティのデバッグ ト
レース レベル オプションをオンにします。

ステップ 10 CRA サーバとネットワーク接続していることを確認します。
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一般的なトラブルシューティングの手順
詳細な出力が次のファイルに書き出されます。

c:¥program files¥wfavvid¥log¥MADM¥jvm.stdout

エラー出力が次のファイルに書き出されます。

c:¥program files¥wfavvid¥log¥MADM¥jvm.stderr
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トラブルシューティングのヒント

この章では、それぞれのセクションで Cisco Unified CCX ソフトウェアの問題を解決するのに役立つヒ

ントを提供します。

Cisco Agent Desktop や Cisco Supervisor Desktop を使用しているときに問題が発生したら、次の URL 
で『Cisco CAD Service Information Guide』のトラブルシューティングのセクションを参照してくださ

い。 
http://www.cisco.com/univercd/cc/td/doc/product/voice/sw_ap_to/apps_5_0/english/agents/cad641si.p
df

Cisco Unified CCX を Cisco Unified ICME とあわせて Unified CCX Gateway Solution の一環として使

用している場合に問題が発生したら、『Cisco Unified CCX Gateway Deployment Guide』に記載されて

いるトラブルシューティング情報を参照してください。

（注） Cisco Unified CCX Administration のユーザ インターフェイスからトラブルシューティング に関する

次のヒントも参照できます。[Main] メニューにアクセスするには [Tools] > [Troubleshooting Tips] を
選択してください。

ヒントは次のように分類されています。

 • 「インストール問題」（P.8-2）

 • 「バックアップ、復元、およびアップデート問題」（P.8-3）

 • 「CME Telephony サブシステムの問題」（P.8-11）

 • 「Cisco Unified Communications Manager Automated Attendant の問題」（P.8-11）

 • 「Cisco Unified Communications Manager Express の問題」（P.8-12）

 • 「Cisco Unified CCX の問題」（P.8-15）

 • 「Cisco Unified IP IVR の問題」（P.8-24）

 • 「Cisco Unified CCX Administration の問題」（P.8-26）

 • 「Cisco Unified CCX Admin Utility の問題」（P.8-33）

 • 「Cisco Unified CCX Database の問題」（P.8-36）

 • 「Cisco Unified CCX Editor の問題」（P.8-40）

 • 「Cisco Unified CCX Engine の問題」（P.8-42）

 • 「Cisco Unified CCX Real-Time Reporting の問題」（P.8-56）

 • 「Cisco Unified CCX Historical Reporting の問題」（P.8-59）

 • 「Automatic Speech Recognition の問題」（P.8-73）
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インストール問題
 • 「Outbound の問題」（P.8-77）

 • 「Text-to-Speech の問題」（P.8-82）

 • 「Serviceability の問題」（P.8-87）

 • 「Cisco Unified CCX の国際化の問題」（P.8-92）

 • 「VXML の問題」（P.8-93）

 • 「ハイ アベイラビリティとブートストラップ」（P.8-95）

 • 「ハイ アベイラビリティとフェールオーバー」（P.8-96）

 • 「VoIP Monitor の問題」（P.8-103）

 • 「CDP の問題」（P.8-105）

インストール問題
このセクションでは次のインストール問題に関して、トラブルシューティングのヒントを提供します。

 • 「2 ノード構成の Cisco Unified CCX 7.0(1) クラスタの 1 ノードがクラッシュして修復できない」

（P.8-2）

（注） インストレーションおよびアップグレード中はウイルス スキャン（McAfee、Norton、Symantec など）

や Cisco Security Agent を停止してください。

2 ノード構成の Cisco Unified CCX 7.0(1) クラスタの 1 ノードがクラッ
シュして修復できない 

症状   運用している 2 ノードの Cisco Unified CCX 7.0(1) クラスタのうち 1 ノードがクラッシュして修

復できない。

エラー メッセージ   None

考えられる原因   原因は不明です。

推奨処置   インストール関係の説明は、『Cisco Unified Contact Center Express Installation Guide』
を参照してください。

次の手順に従ってください。

ステップ 1 必要に応じて DB Publisher をクラッシュしたノードから稼動中のノードに切り替えます。

ステップ 2 クラッシュしていない方のノードの、 [Cisco Unified CCX Application Administration] Web インター

フェイスの [Control Center Server Configuration] ページから [Remove] オプションを実行して、ク

ラッシュしたノードをクラスタから削除します。

ステップ 3 具体的な説明は、『Cisco Unified Contact Center Express Administration Guide』の「Removing a 
Server」を参照してください。

ステップ 4 クラッシュしたノードを再インストールします。
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ステップ 5 Cisco Unified CCX をクラッシュしたノードに再インストールして、Cisco Unified CCX 
Administration 設定で [Add To Cluster] を選択して実行します。

バックアップ、復元、およびアップデート問題
このセクションでは次にあげるバックアップ、復元、およびアップデート問題に関して、トラブル

シューティングのヒントを提供します。

 • 「クライアント デスクトップからバックアップ、復元、およびアップグレードが実行できない」

（P.8-3）

 • 「バックアップ、復元、またはアップグレード中に UI に例外が表示される」（P.8-4）

 • 「1 ノードあるいは 2 ノード システムでバックアップに失敗した」（P.8-4）

 • 「CRS 4.5 プロファイル名が指定されていない」（P.8-5）

 • 「復元またはアップグレード中にメッセージ [Page Not Found] が表示される」（P.8-5）

 • 「ファイルが見つからないために復元が失敗する」（P.8-6）

 • 「1 ノード システムで復元に失敗した」（P.8-6）

 • 「復元の前に稼動していた 2 ノード システムの復元が失敗した」（P.8-7）

 • 「再インストールした 2 ノードシステムで復元に失敗した」（P.8-8）

 • 「アップグレード後、RmCm 設定が部分的に失われた」（P.8-9）

 • 「バックアップ作業中にバックアップ ウィンドウが誤って閉じられた」（P.8-9）

 • 「HA 展開でテープ ドライブ移動したら復元エラーが発生した」（P.8-10）

 • 「HA 展開でバックアップと復元を異なるノードで実施したら復元 エラーが発生した」（P.8-10）

 • 「Outbound Subsystem の設定の更新に失敗した」（P.8-10）

クライアント デスクトップからバックアップ、復元、およびアップグレー
ドが実行できない

症状   クライアント デスクトップからバックアップ、復元、およびアップグレードが実行できない。

エラー メッセージ   Backup and Restore or Upgrade displays an exception or a 'Page Not 
Found' message.

考えられる原因   バックアップ、復元、またはアップグレードで例外が表示された時は、

c:¥program files¥wfavvid¥log¥MCVD フォルダのログをチェックしてキーワード 'backup_fail' で
サーチをかけてください。これで問題の原因が表示されます。表示されたメッセージが理解できな

い場合は、TAC に連絡してください。メッセージ　[Page Not Found] が表示された場合は、Cisco 
Unified CCX Node Manager が何かの理由で再始動しています。TAC に連絡してください。

推奨処置   Cisco Unified CCX サーバ デスクトップからバックアップ、復元、またはアップグレー

ドを開始してください。
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バックアップ、復元、およびアップデート問題
バックアップ、復元、またはアップグレード中に UI に例外が表示される 

症状   バックアップ、復元、またはアップグレード中に例外が表示される。

エラー メッセージ   To see the error message, open the C:¥Program 
Files¥wfavvid¥log¥MCVD¥MCVDXXX.log where the time of the failure occurred.Search 
for the keyword: 'BACKUP_FAILED', 'RESTORE_FAILED', or 'UPGRADE_FAILED' based on 
type of failure.An exception with stack trace will be shown next to this text.

エラー メッセージの中に表示された最後の例外から次のキーワードを探し、問題が発生したコンポー

ネントを特定してください。

 • com.cisco.archive.*：ArchiveManager の一般的な問題を示します。

 • com.cisco.archive.impl.component.config.*：プロパティ ファイルなど、設定の保存または復元の

問題を示します。

 • com.cisco.database.*：データベースの問題を示します。

 • com.cisco.wf.calabrioBackupRestore.*：Calabrio コンポーネントの問題を示します。

 • com.cisco.wf.jtapi.archive.*：JTAPI の設定問題を示します。

 • com.cisco.wf.cme.archive.*：CME の設定問題を示します。

 • com.cisco.restoreadmin.jtapiresyncwizard.*：JTAPI ウィザードでのルート ポイントや CTI ポート

の同期問題を示します。

 • com.cisco.restoreadmin.cmevalidate.*：[CME Validation] ウィザードの問題を示します。

推奨処置   適切な技術者を見つけられるように Cause に示される情報を確認したうえで、TAC に
連絡してください。

1 ノードあるいは 2 ノード システムでバックアップに失敗した

症状   1 ノードあるいは 2 ノード システムでバックアップに失敗した。

エラー メッセージ   Backup and Restore displays an exception or a 'Page Not Found' 
message.

考えられる原因   バックアップと復元で例外が表示された時は、c:¥program 
files¥wfavvid¥log¥MCVD フォルダのログをチェックしてキーワード 'backup_fail' でサーチをか

けてください。これで問題の原因が表示されます。表示されたメッセージが理解できない場合は、

TAC に連絡してください。メッセージ　[Page Not Found] が表示された場合は、Cisco Unified 
CCX Node Manager が何かの理由で再始動しています。TAC に連絡してください。

推奨処置   'Backup Storage Location' が正規の認定証で正しく設定されているか確認してください。
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CRS 4.5 プロファイル名が指定されていない

症状   4.5 から 7.0 へアップグレードする際に CRS 4.5 プロファイル名を選択する必要があるが、復元

時に表示されるプルダウン メニューに該当名が表示されない。

エラー メッセージ   None

考えられる原因   この現象は、最初に復元しようとしたときに、Cisco Unified CCX Node Manager 
が突然シャットダウンまたは再開始したために、失敗した場合に起こることがあります。復元しよ

うとしたときに CRS 4.5 プロファイル名が 7.0 cluster ID（つまり長整数型）に移行した可能性が

あります。ところが Cisco Unified CCX Node Manager が突然シャットダウンしたために、CCM 
テーブル上のプロファイル名が移行したままになったと考えられます。

推奨処置   CRS 4.5 プロファイル名を入力するようメッセージが表示されたら、プルダウン リスト

から長整数型を選択してください。

復元またはアップグレード中にメッセージ [Page Not Found] が表示され
る

症状   復元またはアップグレード中にメッセージ [Page Not Found] が表示される。

エラー メッセージ   Check the log in c:¥program files¥wfavvid¥log¥MCVD and search for 
keyword 'reboot_on' for the error message.

考えられる原因   復元またはアップグレード中に、異常なシャットダウンが原因で Cisco Unified 
CCX Node Manager が再開始した可能性が高いです。このことは復元中に新しい MCVD ログファ

イル（フォルダ c:¥program files¥wfavvid¥log¥MCVD）が作成されたこと、あるいは稼動してい

たCisco Unified CCX Node Manager Service が停止していることにより確認できます。

推奨処置   

ステップ 1 メッセージ [reboot_on] を解析してどのサービスが停止したかを確認します。これが一時的なものであ

る場合は、次の 2 つのステップを実施してから復元をやり直します。現象が一時的なものでない場合は 
TAC に連絡してください。

ステップ 2 Cisco Unified CCX Node Manager Service が実行中の場合は停止します。フォルダ c:¥program 
files¥wfavvid¥ClusterData を復元の前にコピーした元の ClusterData フォルダと入れ替えます。

ステップ 3 作業のやり直しに備えて、元のフォルダは削除しないでおいてください。

それでも復元に失敗する場合は TAC に連絡してください。
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バックアップ、復元、およびアップデート問題
ファイルが見つからないために復元が失敗する

症状   「<file-name> file is not found」により復元が失敗する。

エラー メッセージ   "<file-name> file is not found" message is displayed in the Restore 
Pop-up UI.

考えられる原因   復元プロセスがファイル <file-name> を見つけることができません。

推奨処置   次の手順に従ってください。

ステップ 1 ステージング ディレクトリ (C:¥STI) を削除します。

ステップ 2 [Start] > [Programs] > [Administrative Tools] > [Services] の順に選択してから 'Cisco Unified CCX 
Node Manager' サービスを停止することにより、Node Manager Service を手動で停止します。

ステップ 3 フォルダ C:¥Program Files¥wfavvid¥ClusterData を削除します。

ステップ 4 フォルダ C:¥BackupClusterData¥ClusterData （以前にバックアップしておいたもの）を 
C:¥Program Files¥wfavvid¥ へコピーします。

ステップ 5 マシンをリブートします。

ステップ 6 復元をやり直します。

1 ノード システムで復元に失敗した

症状   1 ノード システムで復元に失敗した。

エラー メッセージ   Backup and Restore displays an exception or a 'Page Not Found' 
message.

考えられる原因   バックアップと復元で例外が表示された時は、c:¥program 
files¥wfavvid¥log¥MCVD フォルダのログをチェックしてキーワード 'backup_fail' でサーチをか

けてください。これで問題の原因が表示されます。表示されたメッセージが理解できない場合は、

TAC に連絡してください。メッセージ　[Page Not Found] が表示された場合は、Cisco Unified 
CCX Node Manager が何かの理由で再始動しています。TAC に連絡してください。

推奨処置   障害の内容を確認してください。障害が解決できない場合は TAC に連絡してください。

一時的な問題が原因の場合は、次のいづれかを実行して復元をやり直してください。

元の ClusterData フォルダがある場合は次の手順に従ってください。

ステップ 1 Cisco Unified CCX Node Manager Service を停止します。

ステップ 2 フォルダ C:¥Program Files¥wfavvid¥ClusterData を削除します。

ステップ 3 元の ClusterData フォルダを C:¥Program Files¥wfavvid¥ フォルダにコピーします。

ステップ 4 Cisco Unified CCX Node Manager Service を起動します。
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バックアップ、復元、およびアップデート問題
ステップ 5 復元をやり直します。

元の ClusterData フォルダが無い場合は次の手順に従ってください。

ステップ 1 Win2K3 OS を使用して Cisco Unified CCX サーバを再インストールします。

ステップ 2 Cisco Unified CCX インストーラでサーバを新たにインストールし直します。

ステップ 3 復元をやり直します。

復元の前に稼動していた 2 ノード システムの復元が失敗した

症状   2 ノード システムで復元が失敗した。復元の前にはシステムはクラスタ構成で正常に稼動してい

た。

エラー メッセージ   Backup and Restore displays an exception or a 'Page Not Found' 
message.

考えられる原因   バックアップと復元で例外が表示されたときは、c:¥program 
files¥wfavvid¥log¥MCVD フォルダのログをチェックしてキーワード 'backup_fail' でサーチをか

けてください。これで問題の原因が表示されます。表示されたメッセージが理解できない場合は、

TAC に連絡してください。メッセージ　[Page Not Found] が表示された場合は、Cisco Unified 
CCX Node Manager が何かの理由で再始動しています。TAC に連絡してください。

推奨処置   障害の内容を確認してください。障害が解決できない場合は TAC に連絡してください。

一時的な問題が原因の場合は、次のステップに従って復元をやり直してください。

ステップ 1 Cisco Unified CCX Node Manager Service の両ノードをシャットダウンします。

ステップ 2 ClusterData のコピーを両ノードに保存しておく必要があります。

a. 両ノードで C:¥Program Files¥wfavvid¥ClusterData フォルダを削除します。

b. 元の ClusterData フォルダを C:¥Program Files¥wfavvid フォルダにコピーします。

ステップ 3 ClusterData のコピーが両ノードに保存されていない場合は次のようにします。

a. Win2K3 OS を使用して両方の Cisco Unified CCX サーバを再インストールします。

b. Cisco Unified CCX インストーラを使用して両サーバを新たにインストールし直します。

c. 復元をやり直します。

ステップ 4 両ノードで Cisco Unified CCX Node Manager を再起動します。

ステップ 5 もういちど復元をやり直します。
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バックアップ、復元、およびアップデート問題
再インストールした 2 ノードシステムで復元に失敗した

症状   2 ノード システムで復元が失敗した。システムは再インストールされたが、クラスタ構成で稼動

するように設定されていない。

エラー メッセージ   Backup and Restore displays an exception or a 'Page Not Found' 
message.

考えられる原因   バックアップと復元で例外が表示された時は、c:¥program 
files¥wfavvid¥log¥MCVD フォルダのログをチェックしてキーワード 'backup_fail' でサーチをか

けてください。これで問題の原因が表示されます。表示されたメッセージが理解できない場合は、

TAC に連絡してください。メッセージ　[Page Not Found] が表示された場合は、Cisco Unified 
CCX Node Manager が何かの理由で再始動しています。TAC に連絡してください。

推奨処置   障害の内容を確認してください。障害が解決できない場合は TAC に連絡してください。

一時的な問題が原因の場合は、次のステップに従って復元をやり直してください。

ステップ 1 Cisco Unified CCX Node Manager Service の両ノードをシャットダウンします。

ステップ 2 ClusterData が両ノードに複製保存されている場合は次のようにします。

a. 両ノードで C:¥Program Files¥wfavvid¥ClusterData フォルダを削除します。

b. 元の ClusterData フォルダを C:¥Program Files¥wfavvid フォルダにコピーします。

c. 第 2 ノードで regedit を使用して、次のレジストリで 'com.cisco.cluster.node.id' が 1 と設定されて

いることを確認します。

¥HKEY_LOCAL_MACHINE¥SOFTWARE¥Cisco Systems, 
Inc.¥CRS¥Properties¥application.MADM.properties

¥HKEY_LOCAL_MACHINE¥SOFTWARE¥Cisco Systems, 
Inc.¥CRS¥Properties¥application.MADM.properties

¥HKEY_LOCAL_MACHINE¥SOFTWARE¥Cisco Systems, 
Inc.¥CRS¥Properties¥application.MADM.properties

¥HKEY_LOCAL_MACHINE¥SOFTWARE¥Cisco Systems, 
Inc.¥CRS¥Properties¥application.MADM.properties

ステップ 3 ClusterData が両ノードに複製保存されていない場合は次のようにします。

a. Win2K3 OS を使用して両方の Cisco Unified CCX サーバを再インストールします。

b. Cisco Unified CCX インストーラを使用して両サーバを新たにインストールし直します。

c. 復元をやり直します。

ステップ 4 両ノードで Cisco Unified CCX Node Manager を再起動します。

ステップ 5 もういちど復元をやり直します。
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バックアップ、復元、およびアップデート問題
アップグレード後、RmCm 設定が部分的に失われた

症状    4.5 から 7.0 へのアップグレードの成功後に、システムの Resource Manager Contact Manager 
（RmCm） 設定（リソース スキル グループ、CSQ 設定など）が部分的に失われた。

エラー メッセージ   None

考えられる原因   この現象は、アップグレードが起動されたが Cisco Unified CCX Node Manager 
が復元中に再開始したため、アップグレードが失敗した場合に発生することがあります。復元の試

行に成功した場合、復元を最初に試行した段階で CRS 4.5 ユーザ プロファイル名は長整数型に変

換されています。

推奨処置   デフォルト プロファイル名を profileID = 1 にリセットするために次の手順に従ってく

ださい。

ステップ 1 SQL クエリ アナライザを開いて次のように入力します。

a. Run SELECT * FROM db_cra.dbo.profileIDMapping

2 つのレコードが表示されます（1 つは 4.5 のもの、もうひとつは 7.0 のデフォルト）。デフォルト

でない CRS4.5_profilename を書きとめておいてください。後に必要になります。

b. Run DELETE FROM db_cra.dbo.profileIDMapping where profileName='CRS4.5_profilename

このコマンドにより、リザルト ウィンドウの 1 行が変化することを確認してください。

c. Run UPDATE db_cra.dbo.profileIDMapping SET profileID =1

このコマンドにより、1 行が変化することを確認してください。

ステップ 2 SELECT * FROM db_cra.dbo.profileIDMapping

ステップ 3 プロファイル名が 'default' で profileID=1 の 1 行だけが表示されます。

バックアップ作業中にバックアップ ウィンドウが誤って閉じられた

症状   バックアップ作業中にバックアップ ウィンドウが誤って閉じられ、その結果バックアップ手順

が途中で中断された。

エラー メッセージ   Fail to release bootstrap mutex

推奨処置   バックアップが突然中断されると Cluster Mutex ロックが解除されません。ロックはしば

らくしてから自動的に解除されます。したがって、5 ～ 10 分待ってからバックアップ手順を再開し

てください。
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バックアップ、復元、およびアップデート問題
HA 展開でテープ ドライブ移動したら復元エラーが発生した

症状   HA 展開でテープ デバイスを使用し、[Restore Now] をクリックしたらエラー メッセージが表示

された。

エラー メッセージ   Unable to perform Restore, please check logs for more details.

考えられる原因   HA 展開では 1 ノードに接続されたテープにバックアップが行われます。そして

もうひとつのノードにテープを移動し、そのノードの復元が行われます。

推奨処置   バックアップをした方のノードで復元をしてください。

HA 展開でバックアップと復元を異なるノードで実施したら復元 エラーが
発生した

症状   テープ ドライブからのバックアップが 98% で失敗し、エラー メッセージが表示される。

エラー メッセージ   Please make sure that the Tape drive is connected to the machine 
and verify if the tape is properly inserted.

考えられる原因   テープ ドライブが接続されていない方のノードでバックアップが行われました。

推奨処置   テープ ドライブが接続されている方のノードでバックアップしてください。

Outbound Subsystem の設定の更新に失敗した

症状   5.0(1) SR1 からアップグレードされた 5.0(2) クラスタのノード 1 で、[CRS Administration] ペー

ジからの Outbound Subsystem またはその他の設定の更新に失敗した。

エラー メッセージ   ConfigException occurred

考えられる原因   この問題は 5.0(1)/5.0(1)SR1 HA クラスタからアップグレードされた 5.0(2) HA 
クラスタで発生します。原因は Config Datastore を 2 つのノードに複製するために使用される 
SQL Server Linked Server が、5.0(2) にアップグレードされるときにリセットされ、自身をポイン

トするようになるためです。つまり、ノード 1 の SQL Server LinkedServer はノード 2 を指さずに

自分自身を指すようになります。

推奨処置   Node 2 で CRS Administration の [Control Center] > [Component Activation] ページか

ら Config Datastore と Historical Datastore を無効化してから、有効化し直してください。これで

ノード 1 の SQL Server Linked Server が再びノード 2 を指すようになります。その後は設定の更

新が可能です。
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CME Telephony サブシステムの問題  
CME Telephony サブシステムの問題
このセクションでは次の CME Telephony 問題に関して、トラブルシューティングのヒントを提供しま

す。

 • 「機能ルーティング ポイント の稼動が止まった、あるいは CME Telephony が部分的にしか稼動し

ていない」（P.8-11）

機能ルーティング ポイント の稼動が止まった、あるいは CME Telephony 
が部分的にしか稼動していない

症状   機能ルーティング ポイント の稼動が止まった、あるいは CME Telephony が部分的にしか稼動し

ていない。

エラー メッセージ   None

考えられる原因   この現象はルータ側でルート ポイント DN を手動で削除した場合に発生します。

推奨処置   設定検証ツールを実行して、警告メッセージが表示されないか確認してください。レ

ポートに RP DN にミスマッチがあることが示されているはずです。ルータの設定をチェックして 
DN が存在するかどうか確認してください。確認できたら、[Trigger] ページを開き [Update] ボタ

ンをクリックして、ルータ側の DN を修正、再生成してください。

Cisco Unified Communications Manager Automated 
Attendant の問題

このセクションでは Cisco Unified Communications Manager（Cisco Unified CM）Automated 
Attendant（AA）の次の問題に関するトラブルシューティングのヒントを提供します。

 • 「名前でダイヤルしたが指定されたサーバが見つからない」（P.8-11）

 • 「Automated Attendant プロンプトが再生されない」（P.8-12）

名前でダイヤルしたが指定されたサーバが見つからない

症状   Cisco Unified CM AA が、発信者が名前でダイヤルして指定したユーザを見つけることができな

い。

エラー メッセージ   None.

考えられる原因   指定されたユーザのプライマリ内線が Cisco Unified CM に割り当てられていな

いためそのユーザの内線が無効になっている、あるいは ccndir.ini ファイルで情報が欠けています。
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Cisco Unified Communications Manager Express の問題
推奨処置   次の手順に従ってください。

ステップ 1 Cisco Unified CM User Information の Web ページで、該当ユーザに対して [AutoAttendant Dialing] に
情報が登録されていること、ユーザ レコードに対応電話が登録されていること、および [Primary 
Extension] オプション ボタンが選択されていることを確認します。

ステップ 2 On the Cisco Unified CCX サーバで ccndir.ini ファイルにユーザベース情報およびプロファイルベース

情報が正しく設定されていることを確認します。例：

# Base DN for CCN APPS 
CCNAPPSBASE "ou=CCN Apps, o=cisco.com" 
# CCN Cluster Profile name 
CCNCLUSTERPROFILE "johndoe_test" 
# Base DN for Users  
USERBASE "ou=Users, o=cisco.com"

Automated Attendant プロンプトが再生されない

症状   Cisco Unified CM AA プロンプトが再生されない。

エラー メッセージ   None.

考えられる原因   Cisco Script Application の Web ページの [welcomePrompt] フィールドに設定さ

れている Welcome プロンプトに誤りがある。

推奨処置   Cisco Unified CCX Administration の Web ページ から [Applications] > [Prompt 
Management] の順に選択してください。リンク [Upload New Prompts] をクリックして Welcome 
プロンプトをアップロードしてください。

Cisco Unified Communications Manager Express の問
題

このセクションでは Cisco Unified Communications Manager Express（Cisco Unified CME）の次の問

題に関するトラブルシューティングのヒントを提供します。

 • 「エージェントが共有回線にログインできない」（P.8-13）

 • 「エージェントが規制回線にログインできない」（P.8-13）

 • 「エージェントが会議から退席すると、すべての参加者が会議から退席してしまう」（P.8-13）

 • 「Cisco Unified CME が 2811/CME ルータから起動されない」（P.8-14）

 • 「'#' を押すとプロンプトが途切れ、その後のプロンプトも再生されなくなる」（P.8-14）
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Cisco Unified Communications Manager Express の問題     
エージェントが共有回線にログインできない

症状   エージェントが Cisco Agent Desktop（CAD）にログインできない。

エラー メッセージ   CAD displays Unable to login agent because line is shared.

考えられる原因   ログインで指定された内線が共有内線です。

推奨処置   指定する内線は 1 つのデバイスにだけ対応するようにしてください。

エージェントが規制回線にログインできない

症状   エージェントが CAD にログインできない。

エラー メッセージ   CAD displays The line is restricted.

考えられる原因   ログインで指定された内線がモニタできません。

推奨処置   エージェントの内線を Cisco Unified CME で "allow-watch" と設定するようにしてくだ

さい。

エージェントが会議から退席すると、すべての参加者が会議から退席して
しまう

症状   エージェントが会議から退席すると、参加者もすべて会議から退席してしまう。

エラー メッセージ   None.

考えられる原因   エージェントの設定が "keep-conference" となっていません。

推奨処置   エージェントのデバイスを Cisco Unified CME で "keep-conference" と設定するように

してください。
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Cisco Unified Communications Manager Express の問題
Cisco Unified CME が 2811/CME ルータから起動されない

症状   Cisco Unified CME が 2811/CME ルータから起動されない。Cisco Unified CME は Cisco 
Unified CCX と正しく統合されていて、SIP メッセージが Cisco Unified CCX と Cisco Unified CME 
のデバッグ ファイル に記録されている。コールは Cisco Unified CCX ルート ポイントまで届いている

が、Cisco Unified CCX アプリケーションが起動されない。

エラー メッセージ   None.

考えられる原因   発信者が電話機からトリガ電話番号をダイヤルすると、コールは届きますがアプ

リケーションが起動されず、そのコールは止まってしまいます。Cisco Unified CME の設定が次の

ようになっていることが原因である可能性があります。

voice service voip 

gcid

allow-connections sip to sip

Cisco Unified CME は Invite を送信しますが OfferedEvent を送信しません。したがって UCCX 
JASMIN は着信コールを SIP サブシステムに報告しません。これが原因でコールが停止してしまいま

す。

推奨処置   Cisco Unified CME の設定を次のように変更してください。

voice service voip 

gcid

callmonitor

allow-connections sip to sip

'#' を押すとプロンプトが途切れ、その後のプロンプトも再生されなくなる

症状   Cisco Unified CCX を Cisco Unified CMEと統合した場合、'#' を押すとプロンプトが途切れ、そ

の後のプロンプトも再生されなくなる。この現象は次の手順で発生する。

1. 発信者が ICD にコールを発信し、そのコールはエージェントにルーティングされる。

2. エージェントは [Transfer] を押し ICD ルート ポイントへダイヤルしてから、"#" を押す（"#" が 
Cisco Unified CME で数字の終わりを示すキーとして設定されている場合）。

3. エージェントに ICD プロンプトが聞こえるはずだが、プロンプトは聞こえないか、聞こえても部

分的にしか聞こえない。

4. エージェントが転送をコミットすると、その後発信者にプロンプトが聞こえない。

エラー メッセージ   None.

推奨処置   この問題を解決するには、Play Prompt ステップで、すべてのプロンプトに対して 
'Flush Input Buffer' を 'yes' と設定してください。
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Cisco Unified CCX の問題   
Cisco Unified CCX の問題
このセクションでは次の Cisco Unified CCX 問題に関して、トラブルシューティングのヒントを提供し

ます。

 • 「RmCm サブシステムがアウト オブ サービスになっている」（P.8-16）

 • 「RmCm サブシステムが [INITIALIZING] 状態になったままである」（P.8-16）

 • 「RmCm が [Initializing] 状態になったままである」（P.8-17）

 • 「エージェント、スーパーバイザ、またはチームの同期が失われている」（P.8-17）

 • 「CDA にエージェントまたは CSQ が表示されない」（P.8-17）

 • 「Cisco Unified CCX Configuration の Web ページの [Resources] エリアにエージェントが表示され

ない」（P.8-18）

 • 「エージェントの順番を選択できない」（P.8-18）

 • 「エージェントが、コールを処理したのちに [Work] 状態にならない」（P.8-18）

 • 「メディア ステップで 例外 [Could not create PlayPromptDialog Object] が発生する」（P.8-19）

 • 「Cisco Unified CCX の設定を変更できない」（P.8-19）

 • 「いくつかのリソース選択基準が欠落している」（P.8-20）

 • 「エージェントを記録できない」（P.8-20）

 • 「スーパーバイザがエージェントをモニタおよび記録できないことがある」（P.8-20）

 • 「Cisco Unified CCX ルート ポイントへのコールが切断される」（P.8-21）

 • 「コールがエージェントにルーティングされない」（P.8-21）

 • 「エージェントが CSQ に表示されない」（P.8-21）

 • 「Cisco Unified CCX エージェントがコールを保留したのちに、そのエージェントの内線を再呼び

出ししようとしたが、コールが切断された」（P.8-22）

 • 「NIC ドライバを更新するとサイレント モニタリングとレコーディングが無効化される」（P.8-22）

 • 「エージェントが [Reserved] 状態と [Ready] 状態に繰り返し変化する」（P.8-23）

 • 「エージェントが [Reserved] 状態だが、打診転送が繰り返し失敗する」（P.8-23）

 • 「最初の 2 回のリンギングでコールを取らないと、そのコールが破棄される」（P.8-23）
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Cisco Unified CCX の問題
RmCm サブシステムがアウト オブ サービスになっている

症状   RmCm サブシステムがアウト オブ サービスになっている。

エラー メッセージ   None.

考えられる原因   Cisco Unified CM の RM JTAPI ユーザが適切に設定されていません。

推奨処置   次の手順に従ってください。

ステップ 1 Cisco Unified CCX Administration の Web ページ から [Subsystems] > [RmCm] の順に選択します。

ステップ 2 ハイパーリンク [RM JTAPI Provider] をクリックします。

ステップ 3 [RM JTAPI User ID] と [Password] フィールドの内容が、Cisco Unified CM の RM JTAPI ユーザのも

のになっていることを確認します。

RmCm サブシステムが [INITIALIZING] 状態になったままである

症状   RmCm サブシステムが [INITIALIZING] 状態になったままである。

エラー メッセージ   None.

考えられる原因   デフォルト スクリプトの CM.aef と RM.aef がロードできなかったためです。

次の手順に従ってください。

ステップ 1 RM JTAPI プロバイダーの設定をチェックしてから、Cisco Unified CCX を停止して再起動します。

ステップ 2 Cisco Unified CCX Administration の [Script Management] ページにワークフロー スクリプトの 
CM.aef と RM.aef があることを確認します。これらは RmCm サブシステムが稼動するために必要で

す。これらスクリプトが削除、紛失、または破壊されていると、RmCm サブシステムは稼動しません。

復旧するには、これらスクリプトを C:¥Program Files¥wfavvid¥scripts¥system¥default¥rmcm からコ

ピーしてから、Cisco Unified CCX Engine を再起動してください。
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Cisco Unified CCX の問題   
RmCm が [Initializing] 状態になったままである

症状   Cisco Unified CCX Engine が起動されたのち、RmCm が [Initializing] 状態になったままになる。

エラー メッセージ   None.

考えられる原因   RmCm サブシステムが設定情報を読み込めません。

推奨処置   クラスタで少なくとも 1 つの "Cisco Unified CCX SQL Server - Config" が稼動している

ことを確認してください。稼動していない場合、起動してください。

エージェント、スーパーバイザ、またはチームの同期が失われている 

症状   Cisco Unified CCX と Cisco Desktop Administrator（CDA）との間で、エージェント、スーパー

バイザ、またはチームの同期が失われている。

エラー メッセージ   None.

考えられる原因   Cisco Unified CCX と CDA の間の自動同期が失敗しました。

推奨処置   Logical Call Center （通常は Cisco Unified CCX プロファイル名） を選択してから 
[Setup] > [Synchronize Directory Services] をクリックして、CDA から手動同期を起動してくださ

い。

CDA にエージェントまたは CSQ が表示されない

症状   Cisco Unified CCX Administration にエージェントまたは Contact Service Queue（CSQ）を追加

しても、これらが CDA に表示されない。

エラー メッセージ   None.

考えられる原因   RmCm サブシステムがエージェントの同期を取っていません。

推奨処置   [Subsystems] > [RmCm] の [Resources] リンクを開いてください。これにより RmCm 
はエージェントの同期をとります。
8-17
Cisco Unified Contact Center Express サービスおよびトラブルシューティング ガイド リリース 7.0(1)        

 



 

第 8 章      トラブルシューティングのヒント        

Cisco Unified CCX の問題
Cisco Unified CCX Configuration の Web ページの [Resources] エリ
アにエージェントが表示されない

症状   Cisco Unified CCX Configuration のWeb ページの [Resources] エリアにエージェントが表示さ

れない。

エラー メッセージ   None.

考えられる原因   ユーザがエージェントのエリアに表示されるには、Cisco Unified 
Communications Manager User Information の Web ページで Cisco Unified CCX エージェントと

して設定されている必要があります。

推奨処置   Cisco Unified CM の User Information Web ページ で設定情報を確認してください。

ユーザごとに、[Associated Devices] で電話が対応付けられていて、[Cisco Unified CCX 
extension] オプション ボタンが選択されていることを確認してください。

エージェントの順番を選択できない

症状   リソース グループを設定する際に、エージェントの順番を選択できない。

エラー メッセージ   None.

考えられる原因   エージェントの順番付けは CSQ レベルで行われます。

推奨処置   CSQ を設定するときに、目的のリソース グループを選択し、[Show Resources] をク

リックしてエージェントの順番を指定してください。

エージェントが、コールを処理したのちに [Work] 状態にならない

症状   CSQ の設定で [Auto Work] が有効になっているのにもかかわらず、エージェントが、コールを

処理したのちに [Work] 状態にならない。

エラー メッセージ   None.

考えられる原因   エージェントは [Talk] 状態で [Ready] ボタンを押さないと、コールを処理したの

ちに [Work] 状態になりません。また、エージェントが複数の CSQ に対応している場合、個々の 
CSQ の設定がすべて [Auto Work] になっているとは限りません。エージェントは、[Auto Work] 
が有効になっている CSQ からコールが到着した場合にだけ [Work] 状態になります。

推奨処置   なし。
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Cisco Unified CCX の問題   
メディア ステップで 例外 [Could not create PlayPromptDialog Object] 
が発生する

症状   SendDigitString 以外のすべてのメディア ステップで、Cisco Unified CCX トレース ファイルに

次の例外が発生する。

エラー メッセージ   Could not create PlayPromptDialog Object: 
Exception=com.cisco.channel.ChannelUnsupportedException: com.cisco.dialog.PlayPromptDialog is not 
supported.

考えられる原因   トリガーの定義に Primary Dialog Group が指定されていません。

推奨処置   Cisco Unified CCX Application Configuration の Web ページでアプリケーションを追加

したのちに、トリガーを定義する必要があります。アプリケーションにトリガーを定義する際、

Call Control Group と Primary Dialog Group の両方を [JTAPI Trigger Configuration] ウィンドウで

定義する必要があります。

Cisco Unified CCX の設定を変更できない

症状   Cisco Unified CCX 設定を保存しようとすると、Cisco Unified CCX Administration でエラー 
メッセージが表示される。

エラー メッセージ   There was an error reading/updating the database.Please contact your administrator.

考えられる原因   Cisco Unified CCX の設定を変更するためには、すべての "Cisco Unified CCX 
SQL Server - Config" がインサービスである必要があります。1 つでもダウンしていると、Cisco 
Unified CCX の設定変更はできません。

推奨処置   クラスタのすべての "Cisco Unified CCX SQL Server - Config" の状態を確認してくださ

い。稼動していないサービスがあったら、起動してください。"Cisco Unified CCX Config 
datastore" コンポーネントが有効になっていることを確認してください。
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Cisco Unified CCX の問題
いくつかのリソース選択基準が欠落している

症状   CSQ を設定しようとしている時、Cisco Unified CCX Administration でいくつかのリソース選択

基準が表示されない。

エラー メッセージ   None.

考えられる原因   CSQ がリソース グループに基づいています。リソース グループに基づいた CSQ 
には選択基準として、Longest Available、Most Handled Contact、Shortest Average Handle Time、
Linear、および Circular があります。スキルに基づいた CSQ には選択基準として、Longest 
Available、Most Handled Contact、Shortest Average Handle Time、Most Skilled、Least Skilled、
Most Skilled by weight、Least Skilled by Weight、Most Skilled by Order、および Least Skilled by 
Order があります。

推奨処置   目的とするリソース 選択基準によっては、スキル ベースの CSQ を使用することも考え

られます。

エージェントを記録できない

症状   スーパーバイザがエージェントのコールを記録できない。[Record] をクリックすると、メッセー

ジ ダイアログ ボックスが表示される。

エラー メッセージ   Unable to record agent.

考えられる原因   記録数が 0 に設定されています。

推奨処置   Cisco Unified CCX Administration を開いてください。[System] > [System Parameters] 
を選択して、記録数を適切に設定してください。

スーパーバイザがエージェントをモニタおよび記録できないことがある

症状   スーパーバイザがエージェントをモニタおよび記録できないことがある。

エラー メッセージ   None

考えられる原因   現在 CAD は G.711 と G.729 のコーデックしかサポートしていません。Cisco 
Unified CM のコーデック設定が、G.722 などの別のものである場合、このような問題が発生する

ことがあります。

推奨処置   エージェントの電話機の "Advertise G 722 codex" が無効化されていて、Cisco Unified 
CM の設定が G.711 または G.729 コーデックになっていることを確認してください。Cisco Unified 
CM 6.0 は G 722 コーデックをサポートしますが、CAD はサポートしません。
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Cisco Unified CCX の問題   
Cisco Unified CCX ルート ポイントへのコールが切断される

症状   Cisco Unified CCX ルート ポイントをコールするとそのコールが切断される。

エラー メッセージ   None.

考えられる原因   Cisco Script Application のWeb ページで CSQ パラメータが正しく定義されてい

ません。

推奨処置   Cisco Unified CCX Administration の Web ページから [Applications] > [Application 
Management] を選択し、Cisco Unified CCX に対応するスクリプトをクリックして、設定する 
CSQ 名を [CSQ] フィールドに入力してください。

コールがエージェントにルーティングされない

症状   エージェントに CSQ スキルが設定されているにもかかわらず、コールがエージェントにルー

ティングされない。

エラー メッセージ   None.

考えられる原因   エージェントのスキル レベルが CSQ のスキルレベルに達していません。

推奨処置   CSQ 設定 ページで [Show Resources] をクリックして、エージェントが CSQ に含まれ

ていることを確認してください。エージェントが表示されない場合は、エージェントのスキルレベ

ルが CSQ のスキル レベルに達しているか確認してください。

エージェントが CSQ に表示されない

症状   CSQ にスキル A とスキル B のエージェント グループが設定されているが、エージェントがCSQ 
に表示されない。

エラー メッセージ   None.

考えられる原因   エージェントが CSQ のスキル レベルを完全には備えていない、またはエージェ

ントのスキル レベルが CSQ のスキル レベルに達していません。

推奨処置   エージェントが CSQ のスキル レベルをすべて備えていて、かつエージェントのスキル 
レベルが CSQ のスキル レベルに達していることを確認してください。
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Cisco Unified CCX の問題
Cisco Unified CCX エージェントがコールを保留したのちに、そのエー
ジェントの内線を再呼び出ししようとしたが、コールが切断された

症状   エージェント A が Cisco Unified CCX コールを受けて、そのコールを保留する。保留コールが

タイムアウトすると、エージェント A の内線に再呼び出しがかかる（他のエージェントがそのコール

を取らなかった場合）。エージェント A が Cisco Unified CCX の内線で他のコールを扱っているとき

に、その前に保留していたコールがその内線にルーティングされると、発信者は切断される。

エラー メッセージ   None.

考えられる原因   保留コールが [Forward Busy] の設定がない使用中の回線に再呼び出しされると、

そのコールは切断されます。

推奨処置   エージェント A の Configure the Cisco Unified CCX の内線を [Forward Busy] と設定

し、同じ電話機の Cisco Unified CCX 以外の回線に転送するようにしてください。

同時にこの回線に対して [Forward Busy] と設定して、Cisco Unified CCX ルート ポイントに転送する

ようにしてください。エージェント A の Cisco Unified CCX 内線が使用中のときに再呼び出しされる

と、コールは Cisco Unified CCX でない方の回線に転送されます。転送先の非 Cisco Unified CCX 回
線が使用中のときは、コールは切断されず Cisco Unified CCX ルート ポイントに転送され再びキュー

イングされます。Cisco Unified CCX ルート ポイントのワークフローを設定して、この種のコールの優

先度を上げることもできます。

NIC ドライバを更新するとサイレント モニタリングとレコーディングが無
効化される

症状   Network Interface Card（NIC; ネットワーク インターフェイス カード）を更新すると、Cisco 
Supervisor Desktop と Cisco Agent Desktop のサイレント モニタリングとレコーディングが機能しなく

なる。

エラー メッセージ   None.

考えられる原因   この問題は、Cisco Unified CCX をインストールする際に [VoIP Monitor Server] 
チェック ボックスをチェックしたサーバで、NIC ドライバを更新すると起こることがあります。

推奨処置   Cisco Unified CCX を再インストールしてください。[Component Distribution] ペイン

の [VoIP Monitor Server] チェック ボックスをチェクするのを忘れないでください。
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Cisco Unified CCX の問題   
エージェントが [Reserved] 状態と [Ready] 状態に繰り返し変化する

症状   エージェントが [Reserved] 状態と [Ready] 状態に繰り返し変化する。[Busy] の理由で転送が失

敗する。

エラー メッセージ   None.

考えられる原因   デバイスの [Busy Trigger] フラグ が適切に設定されていません。

推奨処置   エージェントのデバイスの設定をチェックして、[Max Calls] を 2 に、[Busy Trigger] を 
1 にしてください。

エージェントが [Reserved] 状態だが、打診転送が繰り返し失敗する

症状   エージェントが [Reserved] 状態であるが、打診転送が繰り返し失敗する。

エラー メッセージ   None.

考えられる原因   エージェントの電話機と CTI ポートが異なる地域にある、または Cisco Unified 
CCX のコーデックと該当するデバイスの Cisco Unified CM のコーデックが異なります。

推奨処置   エージェントの電話機と CTI ポートが同じ地域にあることを確認してください。また、

その地域に対応するコーデックが Cisco Unified CCX に設定されているコーデックと同じであるこ

とを確認してください。

最初の 2 回のリンギングでコールを取らないと、そのコールが破棄される

症状   最初の 1 ～ 2 回のリンギングでコールを取らないと、そのコールが破棄される。

エラー メッセージ   None.

考えられる原因   打診転送が CTIERR_TIMEOUT=0x8ccc0001 により失敗しています。

推奨処置   CTI ポートの MOH を Multicast ではなく Unicast に設定してください。
8-23
Cisco Unified Contact Center Express サービスおよびトラブルシューティング ガイド リリース 7.0(1)        

 



 

第 8 章      トラブルシューティングのヒント        

Cisco Unified IP IVR の問題
Cisco Unified IP IVR の問題
このセクションでは次の Cisco Unified IP IVR 問題に関して、トラブルシューティングのヒントを提供

します。

 • 「Cisco Unified IP IVR がコールを内線に転送すると発信側が切断される」（P.8-24）

 • 「プロンプトが誤った言語で再生される」（P.8-24）

 • 「再生できないプロンプトがある」（P.8-25）

 • 「スクリプトのいくつかのプロンプトは指定された言語で再生され、他のプロンプトは英語で再生

される」（P.8-25）

 • 「プロンプトで再生されるフレーズの順番が誤っている」（P.8-26）

Cisco Unified IP IVR がコールを内線に転送すると発信側が切断される

症状   Cisco Unified IP IVR がコールを内線に転送した後に、着信側がそのコールを取るとビジー シグ

ナルが聞こえ、発信側が切断される。

エラー メッセージ   None.

考えられる原因   コールが切断される原因として考えられるのがエンドポイントと Cisco Unified 
CCX サーバでのコーデックのミスマッチです。Cisco Unified CCX サーバは G.729 または G.711 
プロトコルをサポートしますが、同時に 2 はサポートしません。これらをサポートするにはトラン

スコーダが必要です。

推奨処置   トランスコーダを Cisco Unified IP IVR にインストールしてください。

プロンプトが誤った言語で再生される

症状   ルート ポイントでスクリプトに言語が割り当てられているが、プロンプトを再生すると異なっ

た言語になる。

エラー メッセージ   None.

この問題は次の状況により発生した可能性があります。

 • システムのデフォルト言語が誤って設定されている。

 • Set Contact ステップに指定されている言語が誤っている。

 • Play Prompt ステップに指定されている言語が誤っている。

推奨処置   システムのデフォルト言語が正しく設定されていることを確認してください。Set 
Contact ステップまたは Play Prompt ステップが使用されている場合、これらに指定されている言

語が正しいことを確認してください。
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Cisco Unified IP IVR の問題    
再生できないプロンプトがある

症状   スクリプトのプロンプトが再生されない。スクリプトは継続して実行される場合とされない場合

がある。

エラー メッセージ   None.

考えられる原因   スクリプトが使用する言語の言語ディレクトリに、配置されていないプロンプト

があります。デフォルトでは Play Prompt ステップはエラーがあった場合にも継続するように設定

されていて、プロンプトが欠けていてもスクリプトは継続して実行されます。Play Prompt ステッ

プをエラーがあった場合に継続しないように変更すると、スクリプトは中断するようになります。

推奨処置   Cisco Unified CCX トレース ファイル を参照してプロンプトが抜けていないかチェック

してください。Cisco Unified CCX トレース ファイル に表示される言語フォルダに、抜けていた

プロンプトを追加してください。

スクリプトのいくつかのプロンプトは指定された言語で再生され、他のプ
ロンプトは英語で再生される

症状   スクリプトの言語が米国英語以外の言語になっているにもかかわらず、米国英語で再生されるプ

ロンプトがある。

エラー メッセージ   None.

考えられる原因   スクリプトが使用する言語の言語ディレクトリに、配置されていないプロンプト

があります。そのスクリプトのデフォルト言語が米国英語と同じルールを使用している場合、シス

テムは欠けているプロンプトを自動的に米国英語のプロンプトで補います。

推奨処置   [Cisco Unified CCX] トレースファイルを参照して欠けているプロンプトを見つけ出し、

[Cisco Unified CCX] トレースファイルに表示されている言語フォルダにそのプロンプトを追加し

てください。
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Cisco Unified CCX Administration の問題
プロンプトで再生されるフレーズの順番が誤っている

症状   Create Generated Prompt ステップで再生される言語は正しいが、フレーズの順番が誤っている。

たとえば、month、day、year の順に再生されるべきプロンプトが year、month、day の順で再生され

る。

エラー メッセージ   None.

考えられる原因   Create Generated Prompt ステップが、該当言語にそぐわないルールを使用してい

ます。

推奨処置   新たに言語を生成する場合、あるいは既にある言語を新たな地域に適用する場合は、

PromptGenerator プロパティ ファイルをチェックして該当する言語に対して適切なルールが使用さ

れるようにしてください。

Cisco Unified CCX Administration の問題
このセクションでは次の Cisco Unified CCX Administration 問題に関して、トラブルシューティングの

ヒントを提供します。

 • 「The Cisco Unified CCX Administration Authentication の Web ページが利用できない」（P.8-27）

 • 「ライセンス ファイルをアップロードすると警告メッセージが表示される」（P.8-28）

 • 「ユーザが Cisco Unified CCX の Web ページにログインできない」（P.8-28）

 • 「サブフロー スクリプトをリフレッシュしてもペアレント スクリプトが更新されない」（P.8-28）

 • 「Cisco Unified CM のユーザがランダムに表示される」（P.8-29）

 • 「Cisco Unified CCX Supervisor の Web ページが Cisco Unified CCX サーバから表示できない」

（P.8-29）

 • 「ウォールボードで使用するデータベースのテーブル フィールドのデータ単位がミリ秒になってい

る」（P.8-29）

 • 「管理ページを選択するとエラー メッセージが表示される」（P.8-30）

 • 「[Document Management] ページで zip ファイルが自動的に解凍されない」（P.8-31）

 • 「プロンプトの zip ファイルをアップロードしているときに [Invalid files] メッセージが表示され

る」（P.8-31）

 • 「zip ファイルをアップロードすると Component Manager が部分サービス状態になる」（P.8-32）

 • 「高負荷のときコール拒否率が高くなる」（P.8-32）

 • 「サイズの大きな prompt.wav ファイルをアップロードしようとすると Cisco Unified CCX 
Administration でエラーが発生する」（P.8-33）

 • 「発信者が JTAPI トリガーに電話をすると、ファースト ビジーが聞こえる」（P.8-33）
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Cisco Unified CCX Administration の問題    
The Cisco Unified CCX Administration Authentication の Web ペー
ジが利用できない

症状   Cisco Unified CCX Administration の URL が参照できず、エラー [Page Cannot be Displayed] が
表示される。

エラー メッセージ   None.

考えられる原因   システムが [Cisco Unified CCX Administration] のWeb ページにアクセスできま

せん。必要なサービスが実行されていない、あるいは必要なファイルがありません。

次のサービスが実行されていることを確認してください。

 • CiscoUnifiedCCXAdmin.exe が実行されていることを確認してください（Windows タスク マネー

ジャを使用）。

 • IIS Admin サービス

 • World Wide Web Publishing サービス

推奨処置   これらサービスが実行されている場合はディレクトリ 
install_directory¥tomcat_appadmin¥webapps¥appadmin¥ にファイルがあることを確認してくださ

い。install_directory は、Cisco Unified CCX システムがインストールされている ディレクトリで

す（デフォルトでは Cisco Unified CCX システムは c:¥Program Files¥wfavvid フォルダにインス

トールされます）。

このディレクトリにファイルが無い場合は、次の手順に従ってください。

ステップ 1 Cisco Unified CCX Node Manager Service を停止します。

ステップ 2 Cisco Unified CCX システムをインストールしたフォルダ内の tomcat_appadmin¥webapps フォルダか

ら appadmin フォルダを削除します（デフォルトでは Cisco Unified CCX システムは c:¥Program 
Files¥wfavvid フォルダにインストールされます）。

ステップ 3 Cisco Unified CCX Node Manager Service を起動します。

ステップ 4 数分待ってから URL にもう一度アクセスしてみてください。
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Cisco Unified CCX Administration の問題
ライセンス ファイルをアップロードすると警告メッセージが表示される

症状   Cisco Unified CCX Administration を使用してライセンス ファイルをアップロードすると、警告

メッセージが表示される。

エラー メッセージ    The license file, <filename>, if uploaded will change the package from <existing 
license package> to <new license package>.Please click OK to continue or CANCEL to abort.

考えられる原因   警告メッセージは、ユーザがアップロードしようとしているライセンスにより、

現在インストールされている Cisco Unified CCX クラスタのライセンス パッケージが別のものに

変更される場合にだけ表示されます。

推奨処置   ユーザは、警告メッセージで表示されているライセンス パッケージに本当に変更してよ

いのかを判断する必要があります。続行する場合は [OK] をクリックしてパッケージを変更しま

す。ユーザの間違いだった場合は、[CANCEL] をクリックしてパッケージの変更をやめます。

ユーザが Cisco Unified CCX の Web ページにログインできない

症状   Cisco Unified CCX Administration がタイムアウトした後、ユーザが Cisco Unified CCX の Web 
ページにログインできない。

エラー メッセージ   None.

考えられる原因   30 分間何もしないと、ユーザは Cisco Unified CCX から自動的にログアウトされ

ます。

推奨処置   もう一度ログインし直してください。

サブフロー スクリプトをリフレッシュしてもペアレント スクリプトが更新
されない

症状   サブフロー スクリプトをリフレッシュしてもペアレント スクリプトが更新されない。

エラー メッセージ   None.

考えられる原因   スクリプトが他のスクリプトから参照されている場合は、サブフロー スクリプト

をリフレッシュしてもペアレント スクリプトは更新されません。

推奨処置   手動でペアレント スクリプトをリフレッシュしてください。
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Cisco Unified CCX Administration の問題    
Cisco Unified CM のユーザがランダムに表示される 

症状   検索結果として表示されるユーザ数が 75 を超える場合、Cisco Unified CM ユーザが [On the 
Cisco Unified CCX User Maintenance] ウィンドウにランダムに表示される。

エラー メッセージ   None.

考えられる原因   Cisco Unified CCX の [User Maintenance] ウィンドウに表示される Cisco Unified 
CM ユーザの数は 75 に制限されています。この数を超えた場合、Cisco Unified CM ユーザはラン

ダムに表示されます。論理的には 39001、39002、39003、39004 の順番ですが、実際のリストに

は 39001 と 39003 が表示され、39002 と 39004 は表示されません。

推奨処置   サーチキーに文字を追加して、検索対象を狭めてください。

Cisco Unified CCX Supervisor の Web ページが Cisco Unified CCX 
サーバから表示できない

症状   Cisco Unified CCX Supervisor の Web ページが Cisco Unified CCX サーバから表示できない。

エラー メッセージ   None.

考えられる原因   Cisco Unified CCX Supervisor が、言語が [Simplified Chinese] に設定されている

コンピュータで稼動している場合、Cisco Unified CCX Supervisor の Web ページは Cisco Unified 
CCX サーバから表示できません。

推奨処置   クライアント コンピュータから Cisco Unified CCX Supervisor の Web ページを閲覧し

てください。

ウォールボードで使用するデータベースのテーブル フィールドのデータ単
位がミリ秒になっている

症状   ウォールボードで使用するデータベースのテーブル フィールドのデータが HH：MM：SS では

なく、ミリ秒単位になっている。

エラー メッセージ   None.

考えられる原因   RtCSQsSummary と RtICDStatistics データベース の avgTalkDuration、
avgWaitDuration、longestTalkDuration、longestWaitDuration、および oldestContact テーブル 
フィールドのデータがミリ秒単位になっています。
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Cisco Unified CCX Administration の問題
ウォールボードに関するこれらのフィールドと同等の情報を、次のフィールドを使用して設定してくだ

さい。同じ情報が HH：MM：SS のフォーマットで設定されます。

 • avgTalkDuration の代わりに convAvgTalkDuration を使用。

 • avgWaitDuration の代わりに convAvgWaitDuration を使用。

 • longestTalkDuration の代わりに convLongestTalkDuration を使用。

 • longestWaitDuration の代わりに convLongestWaitDuration を使用。

 • oldestContact の代わりに convOldestContact を使用。

管理ページを選択するとエラー メッセージが表示される

症状   [Prompt Management]、[Grammar Management]、または [Document Management] ページを選

択するとエラー メッセージが表示される。

エラー メッセージ   com.cisco.file.FileException: Unable to list files; Repository Data Store not initialized

考えられる原因   リポジトリ データストア コンポーネントに対してマスターが選択されていない

と、このエラーが発生します。これは次のいずれかが原因で起こりえます。

 • リポジトリ データストア コンポーネントがクラスタで起動されていない。

 • リポジトリ データストア コンポーネントが起動されているノードが立ち上がっていない、あるい

は SQL サービスがそのノードで稼動していない。

 • ハイ アベイラビリティの場合、リポジトリ データストア コンポーネントが起動されてはいるが、

Cisco Unified CCX Administration の [Datacontrol Center] ページからの Publisher 起動が完了して

いない。

推奨処置   この問題を解決するには、次のいずれかを実施してください。

 • Cisco Unified CCX Administration から [Control Center] > [Component Activation] ページを選択

して、リポジトリ データストア コンポーネントを起動します。リポジトリ データストア コンポー

ネントのノードが立ち上がっていて稼動していることを確認してください。ノードが立ち上がって

いる場合、Microsoft SQL Server や Microsoft SQL Agent などの SQL サービス が立ち上がって稼

動していることを確認してください。

 • ハイ アベイラビリティの場合、Cisco Unified CCX Administration から [Datacontrol Center] > 
[Publisher Activation] ページを開き、Publisher が起動されていることを確認します。起動されて

いる場合は、Publication Snapshot Agent は [STOPPED] 状態、Subscription Agent は [RUNNING] 
状態になっています。
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Cisco Unified CCX Administration の問題    
[Document Management] ページで zip ファイルが自動的に解凍されな
い

症状   [Document Management] ページで zip ファイルがアップロードされても、[Prompt 
Management] ページや [Grammar Management] ページのように自動的に解凍されない。

エラー メッセージ   None.

考えられる原因   [Document Management] ページで zip ファイルをアップロードした場合、zip 
ファイルのままで保存するか解凍してから保存するかの選択肢があります。

推奨処置   解凍したい場合は [Unzip after uploading] チェック ボックスをチェックしてください。

プロンプトの zip ファイルをアップロードしているときに [Invalid files] 
メッセージが表示される

症状   [Prompts Management]（または [Grammar Management]、[Document Management]）のルート 
レベルでプロンプト（または文法、ドキュメント）をアップロードすると、MADM ログ ファイルにエ

ラーメッセージが書き込まれる。

エラー メッセージ   Invalid files...

考えられる原因   これは次のいずれかが原因で起こりえます。

 • ルート レベルには言語フォルダしか配置できない。

 • [Prompt Management] と [Grammar Management] ページは有効な拡張子のファイルしか許容しな

い。

推奨処置   この問題を解決するには、次を実施してください。

 • ルート レベルでアップロードする際、zip ファイルがフォルダに属さないファイルを含まないこと

を確認します。

 • すべてのファイルの拡張子が有効なものであることを確認します。
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Cisco Unified CCX Administration の問題
zip ファイルをアップロードすると Component Manager が部分サービス
状態になる

症状   Cisco Unified CCX Administration の [Prompt Management]、[Grammar Management]、または 
[Document Management] からファイルまたは zip ファイルをアップロードすると Cisco Unified CCX 
Engine コンポーネントの [Prompt Manager]（または [Grammar Manager]、[Document Manager]） が 
[PARTIAL_SERVICE] 状態になる。

エラー メッセージ   PARTIAL_SERVICE

考えられる原因   [Prompt Manager]、[Grammar Manager]、または [Document Manager] は、File 
Manager がアップロードされたファイルをリポジトリ データストアからローカルディスクに同期

するときに、[PARTIAL_SERVICE] 状態にされます。同期が完了すると [INSERVICE] に戻され

ます。

推奨処置   なし。

高負荷のときコール拒否率が高くなる

症状   200 エージェントを超える高負荷のとき、コールの拒否率または途中放棄率が高くなる。

エラー メッセージ   None.

考えられる原因   Cisco Unified CM と CTI Manager のトレースがローカル ドライブに書き込まれ

るため、負荷が増加してコールの損失が発生します。

推奨処置   CTI Manager と Cisco Unified CM のトレースを他のハード ドライブに書き込むように

する必要があります。この設定をする手順例を次に示します。F:¥ ドライブで、次の例のように 
ディレクトリ構造を作成する必要があります。

Unified Communications Manager SDL Trace Directory Path = F:¥Program Files¥Cisco¥ 
¥Trace¥SDL¥ 

Unified Communications Manager SDI Trace output setting, File Name = F:¥Program 
Files¥Cisco¥Trace¥CCM¥ccm.txt 

CTIManager SDL Trace Directory Path = F:¥Program Files¥Cisco¥ Trace¥SDL¥ 

CTIManager SDI Trace output setting, File Name = F:¥Program Files¥Cisco¥Trace¥CCM¥cti.txt

AntiVirus が次のフォルダをスキャンしないように設定します。

C:¥Program Files¥Cisco¥Trace¥ F:¥Program Files¥Cisco¥Trace¥
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Cisco Unified CCX Admin Utility の問題     
サイズの大きな prompt.wav ファイルをアップロードしようとすると 
Cisco Unified CCX Administration でエラーが発生する

症状   サイズの大きな prompt.wav ファイルをアップロードしようとすると Cisco Unified CCX 
Administration でエラーが発生する。

エラー メッセージ   The page cannot be displayed.

考えられる原因   wav ファイルのサイズが大きいです。

推奨処置   問題を回避するには、このファイルを手動でリポジトリに移動してください。

発信者が JTAPI トリガーに電話をすると、ファースト ビジーが聞こえる

症状   発信者が JTAPI トリガーに電話をすると、ファースト ビジーが聞こえる。

エラー メッセージ   The following message appears in the MIVR log:

%MIVR-SS_TEL-7-UNK:Call.rejected(TRIGGER_MAX_SESSION)

推奨処置   次の手順に従ってください。

ステップ 1 トリガーを削除してから追加し直します。

ステップ 2 Cisco Unified CCX Node Manager を再起動します。

Cisco Unified CCX Admin Utility の問題
このセクションでは次の Cisco Unified CCX Admin Utility 問題に関して、トラブルシューティングの

ヒントを提供します。

 • 「クラスタの同期が取れていない」（P.8-34）

 • 「Cisco Unified CCX Admin Utility が終了してしまう、またはログインしても開始しない」

（P.8-34）

 • 「データ破損のため Cisco Unified CCX Admin Utility に障害が発生する」（P.8-35）

 • 「Cisco Unified CCX Admin Utility がブートストラップ ノード以外のノードで実行できない」

（P.8-35）

 • 「Node Manager が ハングアップしているため、Cisco Unified CCX Admin Utility を実行できない」

（P.8-36）
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Cisco Unified CCX Admin Utility の問題
クラスタの同期が取れていない

症状   クラスタの同期が取れていない。

エラー メッセージ   Rerun the Cisco Unified CCX Admin Utility again to bring the 
cluster back into synchronization.

考えられる原因   この現象は次のようなさまざまな理由で発生します。パスワード設定や同期が途

中で失敗した。ブートストラップ データ ストアは更新されたが、Windows データベースが更新さ

れなかった。1 つのノードは更新されたが、もう片方のノードが更新されなかった。

推奨処置   Cisco Unified CCX Admin Utility を再起動してクラスタの同期を取りなおしてくださ

い。

Cisco Unified CCX Admin Utility が終了してしまう、またはログインし
ても開始しない

症状   Cisco Unified CCX Admin Utility が終了してしまう、またはログインしても開始しない。

エラー メッセージ   None

考えられる原因   次の事項を確認してください。

 • The Cisco Unified CCX Admin Utility が稼動しているシステムに Cisco Unified CCX が正しくイ

ンストールされ、設定されている。

 • Cisco Unified CCX Cluster View Daemon サービスの Configuration Manager（2 ノードシステム

の場合、両ノードの Bootstrap Manager も）の状態をCisco Unified CCX Admin コントロール セ
ンターから確認。

 • Cisco Unified CCX Admin Utility は、Cisco Unified CCX Cluster View Daemon プロセスの 
Configuration Manager が [IN_SERVICE]、あるいは複数ノードシステムの場合、Configuration 
Manager と Bootstrap Manager が [IN_SERVICE] であることが必要。

推奨処置   Cisco Unified CCX システムを正しくインストールして設定してください。
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Cisco Unified CCX Admin Utility の問題     
データ破損のため Cisco Unified CCX Admin Utility に障害が発生する

症状   データ破損のため Cisco Unified CCX Admin Utility に障害が発生する。

エラー メッセージ   None

考えられる原因   ブートストラップ データが破損していると Cisco Unified CCX Admin Utility に
障害が発生します。Admin Utility が稼動しているノードで実行中のプロセスは、ブートストラッ

プにアクセス可能であればどれでもデータ破損を起こす可能性があります。たとえば、Admin 
Utility、Cisco Unified CCX エンジン、CONFING API などがデータ破損を起こすことが考えられ

ます。

推奨処置   データ破損が原因で Admin Utility に障害が発生したら、他のブートストラップ サーバ 
ノードで実行してみてください。もしそれでも Admin Utility に障害が発生するようなら、サポー

ト プロバイダーに連絡してください。

Cisco Unified CCX Admin Utility がブートストラップ ノード以外のノー
ドで実行できない

症状   Cisco Unified CCX Admin Utility がブートストラップ ノード以外のノードで実行できない。

エラー メッセージ   Local system is not a Bootstrap Server Node.Please run Cisco 
Unified CCX Admin Utility on a Bootstrap Server Node.

考えられる原因   Cisco Unified CCX Admin Utility をブートストラップ サーバ ノード以外のノー

ドで実行しようとしました。Cisco Unified CCX 7.0(1) の 2 ノードシステムでは、両ノードどちら

もブートストラップ サーバです。ブートストラップ サーバでない場合、それは DB ノードまたは

VoIP ノードです。

推奨処置   Cisco Unified CCX Admin Utility はブートストラップ ノードで実行する必要がありま

す。必要となるブートストラップ データ ストレージは、ブートストラップ サーバにしかインス

トールされていません。
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Cisco Unified CCX Database の問題
Node Manager が ハングアップしているため、Cisco Unified CCX 
Admin Utility を実行できない

症状   Node Manager が ハングアップしているため、Cisco Unified CCX Admin Utility を実行できな

い。

エラー メッセージ   Failed to shut down remote bootstrap server Node Manager on 
<server_name>.Please shut it down manually and try again.

考えられる原因   システムで実行中の何かが Node Manager をハングアップし、スムースにシャッ

トダウンできなかった、あるいは ウィンドウ サービスが Node Manager のシャットダウンに失敗

した可能性があります。

推奨処置   ウィンドウ サービスから Node Manager を手動でシャットダウン、またはシステムをリ

ブート、あるいはシステムの電源を一旦落としてからリブートしてください。

Cisco Unified CCX Database の問題
このセクションでは次の Cisco Unified CCX Database 問題に関して、トラブルシューティングのヒン

トを提供します。

 • 「Cisco Unified CCX Administration の [Application] または [System] のパラメータをそれぞれの

ページで設定できない」（P.8-37）

 • 「HR クライアントのログイン エラー」（P.8-37）

 • 「HA ノードで DB コンポーネントを起動できない」（P.8-37）

 • 「Cisco Unified CCX のデータベースが期待どおりに消去されない」（P.8-38）

 • 「ヒストリ データベース db_cra が満杯になった」（P.8-38）

 • 「データベース消去に関する E メール通知が送信されない」（P.8-39）

 • 「データベース消去に関する Syslog または SNMP トラップ通知が送信されない」（P.8-39）
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Cisco Unified CCX Database の問題    
Cisco Unified CCX Administration の [Application] または [System] 
のパラメータをそれぞれのページで設定できない

症状   Cisco Unified CCX Administration の [Application] または [System] のパラメータをそれぞれの

ページで設定できない。

エラー メッセージ   "ConfigException* occurred" 

考えられる原因   この現象は SQL サービスまたは MSDTC が実行されていないときに Cisco 
Unified CCX Config データストア サービスが OOS の場合に発生する可能性があります。

推奨処置   コントロール センターで Microsoft Distributed Transaction コーディネータと Microsoft 
SQL Agent サービスが実行されていて、Cisco Unified CCX Config データストアが INSERVICE 
であることを確認してください。HA 構成の場合は、両ノードでこれらサービスが実行されている

ことを確認してください。

HR クライアントのログイン エラー 

症状   HR クライアントのログイン エラー。

エラー メッセージ   An Error occurred while attempting to communicate to Web 
Server.Check your userid and pwd and try again 
(NO_HISTORICAL_REPORTING_CAPABILITY) 

考えられる原因   Cisco Unified CCX Administration User Management の Web ページ で、ユーザ 
ID にレポーティング機能が割り当てられていない。

推奨処置   User Management の Web ページでユーザ ID にレポーティング機能と権限を割り当てて

から、HR クライアントにログインしてください。

HA ノードで DB コンポーネントを起動できない 

症状   HA ノードで DB コンポーネントを起動できない。

エラー メッセージ   Error related to DB Engine Version or DB Engine Edition mimatch 
during activation of DB components.

考えられる原因   HA の両ノードに SQL 2K をインストールする必要があり、しかも両ノードの 
SQL 2K は同じバージョンである必要があります。

推奨処置   両ノードに同じバージョンの SQL 2K をインストールするようにしてください。
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Cisco Unified CCX Database の問題
Cisco Unified CCX のデータベースが期待どおりに消去されない

症状   Cisco Unified CCX のデータベースが期待どおりに自動的に消去されない。

考えられる原因   これは次のいずれかが原因で起こりえます。

 • 自動消去が正しく設定されていない。

 • Cisco Unified CCX サーバのシステム クロックを変更した。Cisco Unified CCX のデータベースの

サイズを変更した。

推奨処置   問題の原因に応じて、次のいずれかを実行してください。

 • Cisco Unified CCX Administration の Web ページから [Tools] > [Historical Reporting] を選択して

自動消去を設定する。

 • Cisco Unified CCX データベースのサイズを変更する場合は、Cisco Unified CCX データベースの

サイズが最大サイズになっていることを確認する。

ヒストリ データベース db_cra が満杯になった 

症状   ヒストリ データが データベース db_cra に書き込まれない。

エラー メッセージ   Could not allocate space for object in database db_cra because the 
PRIMARY file group is full in the SQL log file, MIVR log file.

考えられる原因   データベース db_cra が満杯です。

推奨処置   次のいずれかを実施してください。

ステップ 1 Cisco Unified CCX Administration の Web ページからデータ消去を試みます。[Tools] > [Historical 
Reporting] > [Purge Now] の順に選択してください。

ステップ 2 db_cra のデータ サイズをチェックして、生成されるコール量に対して適切なサイズであることを確認

してください。
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Cisco Unified CCX Database の問題    
データベース消去に関する E メール通知が送信されない

症状   Cisco Unified CCX からデータベース消去に関する E メールが送信されない。

エラー メッセージ   None.

考えられる原因   E メール サブシステムが構築されていない、あるいは E メール 通知が Cisco 
Unified CCX Administration で適切に設定されていません。

次の手順に従ってください。

ステップ 1 Cisco Unified CCX Administration の Web ページから [Subsystems] > [eMail] を選択して、[Mail 
Server] フィールドと [eMail Address] フィールドに正しい情報が設定されていることを確認します。

ステップ 2 Cisco Unified CCX Administration の Web ページから [Tools] > [Historical Reporting] を選択して 
[Purge Schedule Configuration] ハイパーリンクをクリックします。

ステップ 3 [Send Email Notifications To] フィールドに複数の E メール アドレスが指定されている場合は、それぞ

れのアドレスがセミコロン（;）、カンマ（,）、またはスペースで区切られていることを確認します。

ステップ 4 [Send Email Notifications To] フィールドの文字数が 255 以下であることを確認します。

データベース消去に関する Syslog または SNMP トラップ通知が送信され
ない

症状   Cisco Unified CCX からデータベース消去に関する Syslog または SNMP トラップ通知が送信さ

れない。

エラー メッセージ   None.

考えられる原因   Cisco Unified CCX Alarm Service が実行されていない、Syslog が設定されてい

ない、あるいは SNMP サービスが設定されていません。

次の手順に従ってください。

ステップ 1 Cisco Unified CCX Alarm Service が実行されていることを確認します。

ステップ 2 Syslog が適切に設定されていることを確認します。

ステップ 3 Cisco Unified CCX サーバで SNMP サービスが適切に設定されていることを確認します。
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Cisco Unified CCX Editor の問題
Cisco Unified CCX Editor の問題
このセクションでは次の Cisco Unified CCX Editor 問題に関して、トラブルシューティングのヒントを

提供します。

 • 「文字列変数を整数に変更する」（P.8-40）

 • 「アクティブ デバッグ中に Accept ステップでエラーが発生する」（P.8-40）

 • 「Reactive Debugging Tool でエラーが発生する」（P.8-41）

 • 「エージェントが自動的に [Ready] 状態になる」（P.8-41）

文字列変数を整数に変更する

症状   文字列変数を整数に変更したい。

エラー メッセージ   None.

考えられる原因   なし。

推奨処置   Set ステップで文字列から任意の数字型に変更できるため、これを利用してください。

アクティブ デバッグ中に Accept ステップでエラーが発生する

症状   アプリケーションのデバッグ中に、次のメッセージが表示される（メッセージの中の n はタスク 
ID）。

エラー メッセージ   Task: nAccept Step: Trigger is not a Contact Application trigger.

考えられる原因   デバッガがアプリケーション内で Accept ステップに遭遇したが、応答するコー

ルがありません。

推奨処置   アプリケーションを Reactive Application としてデバッグして、Reactive Application が
タイムアウトする前にコールを発信してください。
8-40
Cisco Unified Contact Center Express サービスおよびトラブルシューティング ガイド リリース 7.0(1)



 

第 8 章      トラブルシューティングのヒント

Cisco Unified CCX Editor の問題    
Reactive Debugging Tool でエラーが発生する

症状   Reactive Debugging Tool の使用中にエラーが発生する。

エラー メッセージ   Not defined.

考えられる原因   トランスレーション ルーティング コールに対して Cisco Unified CCX Editor 
Reactive Debugging ツールを使用するとエラーが発生することがあります。

推奨処置   ICM Configuration Manager から [Tools] > [List Tools] > [Network VRU Script List] の
順に選択して、[Timeout] フィールドの値をスクリプト用に一時的に大きくしてください。

エージェントが自動的に [Ready] 状態になる

症状   Select Resource ステップで、スクリプトの RNA タイムアウト値が 1 分を超える場合、対応する

エージェントは自動的に [Ready] 状態になり、その後のコールを CAD で応答できなくなる。

エラー メッセージ   None.

考えられる原因   エージェントがインバウンドの ICD コールを受けると [Reserved] 状態になり、

RNA タイムアウトにより、エージェントが応答しなかった場合にどの時点でそのコールがキュー

に戻されるかがコントロールされます。RNA に到達すると、対応するエージェントは [Not 
Ready] 状態になります。

推奨処置   RNA タイムアウト値が 1 分を超える場合、次の Reserved しきい値のレジストリ値を大

きくして RNA タイムアウト値と同じにしてください。

HKEY_LOCAL_MACHINE¥SOFTWARE¥Cisco systems, 
Inc.¥CRS¥Properties¥SubsystemRmCm.properties¥com.cisco.wf.subsystems.rmcm.reservedDurationT
hreshold
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Cisco Unified CCX Engine の問題
エージェント が [Reserved] から [Available to Talking] への異常な状態
遷移をする

症状   エージェント が [Reserved] から [Available to Talking] への異常な状態遷移をする。

エラー メッセージ   None.

考えられる原因   スクリプト フローが Call Redirect ステップを伴うスクリプトを含み、このス

テップでコールがトランスレーション パターンにリダイレクトされ、そこから他の Cisco Unified 
CCX ルート ポイントにマッピングされています。この Cisco Unified CCX ルート ポイントがコー

ルをキューイングしてからエージェントにルーティングします。

推奨処置   スクリプトを変更して、Cisco Unified CCX ルート ポイントにコールを転送するトラン

スレーション パターンや他のデバイスへでなく、コールを直接 Cisco Unified CCX ルート ポイン

トにリダイレクトするようにしてください。

Cisco Unified CCX Engine の問題
次にあげる CRS サブシステムが構築されていなければ、当然これらは [Partial Service] や [Out of 
Service] になります。これらが使用可能になるようにサーバを構築して初めて [In Service] となりま

す。

 • Database サブシステム：コールが入ってきた場合のデータベース参照などのために、外部データ

ベースを構築した場合にだけ [In Service] となります。

 • MRCP ASR サブシステム：Cisco CRS 用に Automatic Speech Recognition（ASR; 自動音声認識）

システムを構築した場合にだけ [In Service] となります。

 • MRCP TTS サブシステム：Cisco CRS 用に Text to Speech（TTS; テキスト音声変換）システムを

構築した場合にだけ [In Service] となります。

 • VOIP Monitor サブシステム：エージェントをモニタリング、レコーディングするためにサーバを

構築した場合にだけ [In Service] となります。

このセクションでは次の Cisco Unified CCX Engine 問題に関して、トラブルシューティングのヒント

を提供します。

 • 「エージェントがログイン後に [Ready] にならない」（P.8-43）

 • 「Voice Browser ステップで例外が発生する」（P.8-44）

 • 「Cisco Unified CCX Engine が起動されず、エラー [RMI port in use] が発生する」（P.8-44）

 • 「Cisco Unified CCX Node Manager サービスを起動しようとするとエラー 1067 が発生する」

（P.8-45）

 • 「Cisco Unified CCX Node Manager サービスを起動しようとするとエラー 1069 が発生する」

（P.8-45）

 • 「Application サブシステムが [Partial Service] になっている」（P.8-46）

 • 「Cisco Unified CCX Engine は稼動しているがコールが応答されない」（P.8-46）

 • 「Cisco Unified CCX マシンの時間を変更するとエージェントがログオフされる」（P.8-47）

 • 「CTI ルート ポイントに電話をかけるとエラー メッセージが流れる」（P.8-47）
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Cisco Unified CCX Engine の問題    
 • 「アプリケーションへの変更が現象に現れない」（P.8-48）

 • 「コールをゲートウェイをまたがって転送しているときに切断される」（P.8-48）

 • 「H.323 クライアントの DTMF 数字が検出されない」（P.8-49）

 • 「リダイレクトされたコールが切断される」（P.8-49）

 • 「Cisco Unified CCX サーバのディスク スペースがなくなった」（P.8-50）

 • 「Cisco Unified CCX サーバの CPU 使用率が 100% になる、または非常に遅い」（P.8-51）

 • 「Database サブシステムがパーシャル サービスになる」（P.8-52）

 • 「JTAPI サブシステムが [Partial Service] になっている」（P.8-52）

 • 「JTAPI プロバイダーに接続できない」（P.8-53）

 • 「Simple Recognition ステップで失敗の方へ分岐してしまう」（P.8-53）

 • 「発信側と Cisco Unified CCX のコーデックが異なる」（P.8-54）

 • 「プロンプトが正しくないコーデックで再生される」（P.8-54）

 • 「Cisco Unified CCX Engine ログ ファイルにプロンプト例外がある」（P.8-54）

 • 「Cisco Unified CCX Engine が起動しない」（P.8-55）

 • 「Application サブシステムがパーシャル サービスになっていて、予想外に長時間実行され続けて

いる」（P.8-55）

 • 「Cisco Unified CCX サーバと Active Directory を統合すると、いくつかのサービスが登録されて

いない状態になる」（P.8-56）

エージェントがログイン後に [Ready] にならない 

症状   エージェントがログイン後に [Ready] にならない。

エラー メッセージ   The Cisco Agent Desktop says that the resource's device is off and 
the agent extension is out of service.

考えられる原因   エージェントの電話機にセッション サーバが設定されていません。

推奨処置   エージェントの電話機のセッション サーバが Cisco Unified CCX セッション サーバと

設定されていることを確認してください。
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Cisco Unified CCX Engine の問題
Voice Browser ステップで例外が発生する

症状   Voice Browser ステップで指定されている URL に IP アドレスの代わりに "ServerName" が使用

されていると、例外 [UnknownHostException] が発生する。

エラー メッセージ   None.

考えられる原因   以前に Java Virtual Machine（JVM）がキャッシュしたアドレス解決結果が古く

なっていて、JVM を再起動しないと修正されません。

推奨処置   Cisco Unified CCX Node Manager を再起動してください。

Cisco Unified CCX Engine が起動されず、エラー [RMI port in use] が
発生する

症状   The Cisco Unified CCX Engine が起動されず、Remote Method Invocation（RMI）ポート使用中

のエラーが Cisco Unified CCX トレース ファイルに書き込まれている。

エラー メッセージ   RMI port in use.

考えられる原因   Cisco Unified CCX Engine が使用しようとしているポートを他のプロセスが使用

しています。

Cisco Unified CCX Administration の Web ページから次の手順を実施してください。

ステップ 1 [System] > [System Parameters] の順に選択します。

ステップ 2 [RMI Port Number] フィールドに他のポートを入力します。

ステップ 3 Cisco Unified CCX Engine を停止してから再起動します。

ステップ 4 Cisco Unified CCX Administration で Cisco Unified CCX Engine が [Invalid] と表示される場合、トラ

ブルシューティングのヒント「サービスが常に [Invalid] と表示される」を参照してください。
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Cisco Unified CCX Node Manager サービスを起動しようとするとエ
ラー 1067 が発生する

症状   [Windows Services] ウィンドウから Cisco Unified CCX Node Manager サービスを起動しようと

すると次のメッセージが表示される。

エラー メッセージ   Could not start the Cisco Unified CCX Node Manager service on local computer.Error 
1067: The process terminated unexpectedly.

考えられる原因   Cisco Unified CCX Node Manager に内部エラーが発生しています。

推奨処置   『Cisco Unified Contact Center Express Administration Guide』を参照するか、オンライ

ンヘルプ情報の [Administration] から Cisco Unified CCX Node Manager サービスを適切に設定す

る方法を参照してください。

Cisco Unified CCX Node Manager サービスを起動しようとするとエ
ラー 1069 が発生する

症状   [Windows Services] ウィンドウから Cisco Unified CCX Node Manager サービスを起動しようと

すると次のメッセージが表示される。

エラー メッセージ   Could not start the Cisco Unified CCX Node Manager service on local 
computer.Error 1069: The service did not start due to a logon failure.

考えられる原因   Cisco Unified CM または Cisco Unified CCX をインストールするときに入力する 
Windows 2003 の管理者パスワードにより、それまでの Windows 2003 管理者パスワードが上書き

されます。また、入力したパスワードにスペースが含まれていると、正確に記録されないことがあ

ります。

次の手順に従って、Cisco Unified CCX Node Manager サービスのパスワードを変更してください。

ステップ 1 Cisco Unified CCX サーバで [Start] > [Settings] > [Control Panel] > [Administrative Tools] > [Services] 
の順に選択します。

ステップ 2 [Cisco Unified CCX Node Manager] をダブルクリックします。

ステップ 3 [Log On] タブを選択します。

ステップ 4 Windows 2003 の管理者パスワードを入力し確認してから、[Apply] をクリックします。パスワードに

はスペースを含めないでください。
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Cisco Unified CCX Engine の問題
Application サブシステムが [Partial Service] になっている

症状   [Engine] Web ページ の [Engine Status] エリアで Application サブシステムが [Partial Service] に
なっている。

エラー メッセージ   None

考えられる原因   無効になっているアプリケーションがあります。

次の手順に従ってください。

ステップ 1 Cisco Unified CCX トレース ファイル を参照してどのアプリケーションが無効になっているかを確認

します。

ステップ 2 Cisco Unified CCX Editor を使用して対応するスクリプトを検証します。

Cisco Unified CCX Engine は稼動しているがコールが応答されない

症状   The Cisco Unified CCX Engine は稼動しているが Cisco Unified CCX システムがコールに応答し

ない。

エラー メッセージ   None.

考えられる原因   JTAPI サブシステムがアウト オブ サービスになっている、トリガーが無効化され

ている、アプリケーションが無効化されている、セッションまたはタスクが最大数を超えた、ある

いはトリガーに利用できる CTI ポート またはメディア チャネルがなくなっています。

次の手順に従ってください。

ステップ 1 Cisco Unified CCX Administration の Web ページから、[System] > [Control Center] を選択し、左のパ

ネルから該当するサーバを選択し、Cisco Unified CCX Engine を展開して JTAPI サブシステムが稼動

中であることを確認します。

JTAPI が [Partial Service] の場合、このガイドのトラブルシューティングのヒントの「JTAPI サブシス

テムが [Partial Service] になっている」を参照してください。

JTAPI サブシステムが [Out of Service] の場合、『Cisco Unified Contact Center Express Administration 
Guide』のセクション「Cisco Unified CCX Provisioning for Cisco Unified Communications Manager」
で設定方法について確認してください。

ステップ 2 Cisco Unified CCX Administration の Web ページから [Subsystems] > [JTPI] を選択して [JTAPI 
Triggers] ハイパーリンクをクリックします。該当トリガーに対する [Enabled] カラムが [False] になっ

ていたら、そのトリガーをダブルクリックして、[Enabled Yes] オプション ボタンをクリックして、

[Update] をクリックします。

ステップ 3 Cisco Unified CCX Administration の Web ページ から [Applications] > [Configure Applications] の順

に選択します。該当アプリケーションに対する [Enabled] カラムが [No] になっていたら、そのアプリ

ケーションをダブルクリックして、[Enabled Yes] オプション ボタンをクリックして、[Update] をク

リックします。
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Cisco Unified CCX Engine の問題    
ステップ 4 Cisco Unified CCX トレース ファイルで、コールが最大許容セッション数を超過していないことを確認

します。

ステップ 5 Cisco Unified CCX トレース ファイルで、コールが最大許容タスク数を超過していないことを確認しま

す。

ステップ 6 Cisco Unified CCX トレース ファイルに CTI ポートやメディア ポートが不足していることを示すメッ

セージがないことを確認します。

Cisco Unified CCX マシンの時間を変更するとエージェントがログオフさ
れる

症状   Cisco Unified CCX の時間を変更したら、エージェントがログオフされ、Cisco Agent Desktop 
のアウトオブサービスとラップアップ タイマーがタイムアウトした。

エラー メッセージ   None.

考えられる原因   Cisco Agent Desktops でラップアップ タイマーが使用されている場合、Cisco 
Unified CCX の時間を変更すると誤ってタイムアウトする可能性があります。

推奨処置   Cisco Unified CCX マシンのシステム時間を変更しないでください。

CTI ルート ポイントに電話をかけるとエラー メッセージが流れる

症状   CTI ルート ポイントに電話をかけるとエラー メッセージが流れる。CTI ルート ポイントが関連

するアプリケーション スクリプトをロードできないため、JTAPI サブシステムも パーシャル サービス 
になっている可能性がある。

エラー メッセージ   I'm sorry, we are currently experiencing system problems.

考えられる原因   CTI ルート ポイントに関連するアプリケーション スクリプトを正しくロードでき

ませんでした。

推奨処置   Cisco Unified CCX Editor のアプリケーション スクリプトを次の手順で検証してくださ

い。

ステップ 1 Cisco Unified CCX Administration の Web ページ から [Applications] > [Script Management] の順に選

択します。

ステップ 2 該当するスクリプトをクリックして Repository からダウンロードします。

ステップ 3 Cisco Unified CCX Editor 内のスクリプトを開きます。

ステップ 4 スクリプトを検証してから保存します。

ステップ 5 [Applications] > [Script Management] を選択して Repository にアップロードします。
8-47
Cisco Unified Contact Center Express サービスおよびトラブルシューティング ガイド リリース 7.0(1)        

 



 

第 8 章      トラブルシューティングのヒント        

Cisco Unified CCX Engine の問題
ステップ 6 判断を求めるメッセージが表示されるので、[Yes] をクリックしてスクリプトとアプリケーションをリ

フレッシュします。

ステップ 7 Cisco Unified CCX トレース ファイルを参照してアプリケーション スクリプトのアップロードに成功

していることを確認します。

ステップ 8 スクリプトを検証し、保存し、リポジトリにアップロードしてもなおロードできなかったら、他に満た

していない条件がないかを確認します。たとえば、スクリプトがカスタム クラスを参照している場合、

そのクラスが Cisco Unified CCX Engine で利用可能であることを確認してください。

アプリケーションへの変更が現象に現れない

症状   アプリケーション スクリプトに変更を加えてもその変更が発信者から見えない。

エラー メッセージ   None.

考えられる原因   アプリケーション スクリプトがリポジトリへアップロード、リフレッシュされて

いません。

推奨処置   アプリケーション スクリプトに変更を加えたら、次のステップに従ってください。

ステップ 1 アプリケーション スクリプトを保存します。

ステップ 2 Cisco Unified CCX Administration の Web ページ から [Applications] > [Script Management] の順に選

択して、アプリケーション スクリプトをリポジトリにアップロードします。

ステップ 3 判断を求めるメッセージが表示されるので、[Yes] をクリックしてスクリプトとアプリケーションをリ

フレッシュします。

コールをゲートウェイをまたがって転送しているときに切断される

症状   Cisco Unified CCX がゲートウェイをまたがってコールを受信したとき、そのコールを転送する

と Cisco Unified CCX システムによりそのコールが切断される。

エラー メッセージ   None.

考えられる原因   H.323 クライアントが Empty Capability Service をサポートせず、Cisco Unified 
CM の H.323 ポートが Media Termination Point（MTP） を使用するように設定されていません。

推奨処置   Cisco Unified CM の H.323 ポートの設定を MTP を使用するように変更して、H.323 
ポートをリセットしてください。
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H.323 クライアントの DTMF 数字が検出されない

症状   H.323 クライアントからコールを発信するとき、DTMF 数字が読み取られない。

エラー メッセージ   None.

考えられる原因   H.323 はインバンドの DTMF 信号しか発信しません。Cisco Unified CM はイン

バンドの DTMF 信号を検出できません。

推奨処置   なし。

リダイレクトされたコールが切断される

症状   リダイレクトされたコールが切断される、あるいは IP 電話にコールがリダイレクトされてもそ

の IP 電話を呼び出さない。

エラー メッセージ   None.

考えられる原因   ゲートウェイのなかにはリングバックをサポートしないものがあります。

推奨処置   リングバックをサポートするようにゲートウェイとプロトコルを設定し直してくださ

い。

次にゲートウェイとそれぞれのゲートウェイのプロトコルを列挙します（プロトコルはカッコ内に記載

します）。

 • 26XX FXO (Media Gateway Control)

 • 36XX FXO (36XX FXO Media Gateway Control)

 • VG200 FXO (Media Gateway Control)

 • DT-24+ (Skinny)

 • WS-6608-T1—[Cat6K 8-port T1 PRI] (Skinny) 

 • WS-6608-E1 [Cat6K 8-port E1 PRI] (Skinny)

 • DE-30+ (Skinny)

 • AT-2, 4, 8 (AT-2, 4, 8 —)
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Cisco Unified CCX Engine の問題
Cisco Unified CCX サーバのディスク スペースがなくなった

次のような現象が起こりえます。

 • Cisco Unified CCX サーバでメモリ不足エラーが発生する。

 • Administration UI で消去や同期のページにアクセスしようとするとエラーが返る。

 • ヒストリ レポートを実行すると SQL エラー 5048 が返る。

エラー メッセージ   SQL error 5048.

考えられる原因   Cisco Unified CCX データベース ログ ファイル、tempdb データベース、または 
tempdb ログ ファイルが大きくなっている。

推奨処置   2 つの対処方法があります。

ステップ 1 Cisco Unified CCX データベース ログ ファイルを手動で縮小するには、Cisco Unified CCX サーバで

コマンド ウィンドウを開いて次のコマンドを入力します。

osql -Usa -Ppassword -ddb_cra。ここで password は Cisco Unified CCX データベースに管理者とし

てログインするためのパスワードです。

USE database_name（ここで database_name は db_cra です）

GO

DBCC SHRINKFILE (database_name_log.mdf)（ここで database_name は db_cra です）

GO

ステップ 2 また、wfavvid ディレクトリの下に格納されている バッチファイル TruncateHistDBLogs.bat を実行し

てログ ファイルを縮小することもできます。引数に基づいて db_cra または tempdb のログファイルを

縮小します。

例：

 • db_cra のログファイルを 10MB に縮小します。

 •  runTruncatedHistDBLogs "sa" "sa_password" "db_cra_all" 10 

 • tempdb のトランザクション ログを縮小します。 
 • runTruncateHistDBLogs "sa" "sa_password" "tempdb"

ログ ファイル縮小の詳細に関しては 『Cisco Unified CCX Administration Guide』の「Managing 
Historical Reporting Databases」セクションを参照してください。

（注） このトラブルシューティングのヒントは「Cisco Unified CCX Database の問題」セクションと「Cisco 
Unified CCX Historical Reporting の問題」セクションにもあてはまります。
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Cisco Unified CCX Engine の問題    
Cisco Unified CCX サーバの CPU 使用率が 100% になる、または非常に
遅い

症状   The Cisco Unified CCX サーバの CPU 使用率が 100% またはそれに近くになる。DTMF 数字が

遅れる。

エラー メッセージ   None.

次の設定のいづれかが問題の原因となっている可能性があります。

 • トレース設定にデバッグが含まれている。

 • Cisco Unified CM ポーリングが有効になっている（ポーリングはデフォルトで有効ですが、サー

バのリソースを消費します）。

 • 小型システムで多くのアプリケーションを同時に実行している。たとえば、Cisco Unified CM と 
Cisco Unified CCX サーバをともにローエンド MCS で実行している。

推奨処置   次の手順に従ってください。

ステップ 1 トレース レベル オプションでデバッグを無効にします。デバッグはかなりの量のサーバ リソースを消

費します。Cisco Unified CCX を積極的にデバッグするときだけトレース レベル オプションをデバッ

グにしてください。

ステップ 2  システムの BHCC が 4500 を超える場合は、Cisco Unified CCX のデバッグを無効にします。

ステップ 3 300 のエージェントで非常に高い負荷をかける場合は、すべてのログとトレースを無効にします。

ステップ 4 300 のエージェントで非常に高い負荷をかける場合は、ログ（例：Cisco Unified CM ログ）を Cisco 
Unified CCX と SQL がインストールされている別のドライブにリダイレクトします。

ステップ 5 Cisco Unified CM ポーリングを無効にします。ポーリングにより JTAPI （そして Cisco Unified CCX 
などの、JTAPI を使用するテレフォニー アプリケーション）がアプリケーションまたはユーザの制御

リストにデバイスが追加されるのを検出できるようになります。たとえば、エージェントがコール セ
ンターに追加されたこと、あるいは CTI ポートが Cisco Unified CCX Engine に追加されたことがポー

リングにより検出されます。ポーリングを無効にすると、Cisco Unified CM は新しいデバイスの追加

による更新を自動的には行いません。たとえば、Cisco Unified CM に新しい CTI ポートやルート ポイ

ントを追加した後には、Cisco Unified CCX サーバを再起動する必要があります。

ステップ 6 小型システムで多くのアプリケーションを同時に実行させる場合は、アプリケーションを複数のサーバ

に分けてインストールするか、MCS-7835 を使用します。

ステップ 7 負荷が非常に高い場合は、Cisco Unified CCX マシンのハードディスクを定期的にデフラグします。
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Cisco Unified CCX Engine の問題
Database サブシステムがパーシャル サービスになる

症状   Cisco Unified CCX システムで Sybase データベースを使用するようにすると、Database サブシ

ステムがパーシャル サービスになる。

エラー メッセージ   None.

考えられる原因   Cisco Unified CCX Administration Enterprise Database Subsystem Configuration 
の Web ページで入力した Sybase データソース名と、Windows ODBC DSN の設定ウィンドウで入

力したデータソース名が正確に一致しないと、データベース接続が失敗してデータベースがパー

シャル サービスになります。

推奨処置   Administration Enterprise Database Subsystem Configuration の Web ページで入力した 
Sybase データソース名と、Windows ODBC のデータソース名が一致するようにしてください。

JTAPI サブシステムが [Partial Service] になっている

症状   [Engine] Web ページ の [Engine Status] エリアで JTAPI サブシステムが [Partial Service] になっ

ている。

エラー メッセージ   None.

考えられる原因   JTAPI クライアントが正しく設定されていません。すべてではないですが少なく

とも 1 つの CTI ポート、ルート ポイント、またはダイアログ チャンネル（CMT または MRCP）
が初期化できていません。

次の手順に従ってください。

ステップ 1 Cisco Unified CCX トレース ファイル を参照して、何が初期化できなかったかを確認します。

ステップ 2 すべての CTI ポートとルート ポイントが Cisco Unified CM の JTAPI ユーザ に関連付けられているこ

とを確認します。

ステップ 3 Cisco Unified CM と JTAPI の 設定 IP アドレスが一致することを確認します。

ステップ 4 Cisco Unified CM JTAPI ユーザがすべての CTI ポートと CTI ルート ポイントを制御していることを確

認します。

ステップ 5 Repository Manager によりアプリケーション ファイルがリポジトリにアップロードされていることを

確認します。
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Cisco Unified CCX Engine の問題    
JTAPI プロバイダーに接続できない

症状   JTAPI が利用可能になっていない。

エラー メッセージ   None.

考えられる原因   この問題は次のいずれかが原因で起っている可能性があります。

 • Cisco Unified CM が稼動していない。

 • Cisco Unified CCX サーバにインストールされている JTAPI クライアントのバージョンが正しくない。

 • JTAPI ユーザが正しく設定されていない。

 • JTAPI クライアントが Csco Unified CM と通信できない。

推奨処置   原因によって、次のいずれかを実施してください。

 • Cisco Unified CM のトラブルシューティングをする（『Cisco Unified Communications Manager 
Administration Guide』を参照してください）。

 • Cisco Unified CCX サーバで [Start] > [Programs] > [Cisco JTAPI] > [Readme] の順に選択して 
JTAPI のバージョンを確認する。

 • Cisco Unified CCX Administration の Web ページから [Subsystems] > [JTAPI] を選択後、ハイパー

リンク [JTAPI Provider] をクリックして、[User ID] フィールドの内容が Cisco Unified CM の有効

なユーザ名のいずれかと一致することを確認する。[Password] フィールドの内容が正しいことを

確認する。

 • Cisco Unified CM が稼動していることを確認する。Cisco Unified CM を DNS 名ではなく、IP ア
ドレスを使って設定する。

Simple Recognition ステップで失敗の方へ分岐してしまう

症状   話すフレーズや DTMF キーが文法に沿って定義されているにもかかわらず、スクリプト内の 
Simple Recognition ステップで失敗の方へ分岐してしまう。

エラー メッセージ   None.

考えられる原因   Simple Recognition はタグと出力ポイントで構成されています。ステップで使用

されているタグ名がステップで使用する文法で定義されているタグ名と正確に一致していない可能

性が高いです。文法でタグ名が定義されている場合に、このようなミスマッチが起こりえます。

推奨処置   次の手順に従ってください。

ステップ 1 文法で定義されている タグ名すべてが Simple Recognition ステップで使用されていて、スペルと大文

字 /小文字の区別まで文法どおりに記述されていることを確認します。

ステップ 2 文法に Simple Recognition ステップで設定されていないタグ名がある場合、Simple Recognition ス
テップにそのタグ名を設定するか、文法からそのタグ名を削除します。
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Cisco Unified CCX Engine の問題
発信側と Cisco Unified CCX のコーデックが異なる

症状   発信側が Cisco Unified CCX アプリケーションに電話をかけるとファースト ビジーが聞こえる。

エラー メッセージ   The Cisco Unified CCX log shows  
CTIERR_REDIRECT_CALL_PROTOCOL_ERROR or 
CTIERR_REDIRECT_CALL_MEDIA_CONNECTION_FAILED=0x8ccc0036

考えられる原因   発信側デバイスのコーデックが Cisco Unified CCX に適合していない可能性があ

ります。

推奨処置   Cisco Unified CM のトランスコーディング サービスを使用するか、発信側が Cisco 
Unified CCX サーバの設定に従って、G.711 または G729 を使用するようにしてください。

プロンプトが正しくないコーデックで再生される

症状   発信側にプロンプトが聞こえない。

エラー メッセージ   None.

考えられる原因   再生されるプロンプトがシステムのコーデックと整合していません。

推奨処置   正しいバージョンのプロンプトを使用してください。

Cisco Unified CCX Engine ログ ファイルにプロンプト例外がある

症状   Cisco Unified CCX Engine ログ ファイルにプロンプト例外がある。

エラー メッセージ   The exception contains the words open port failed.

考えられる原因   一般的にこのようなエラーは Cisco Unified CCX Engine でRTP ポートが使用中

に、たとえば、Windows タスク マネージャ によってシャットダウンされたときに発生します。

推奨処置   このようなプロンプト例外が発生したら Cisco Unified CCX サーバをリブートしてくだ

さい。この問題を回避するために Cisco Unified CCX Engine を停止しください。Cisco Unified 
CCX Administration メニュー バーから [System] > [Engine] を選択してから、[Stop Engine] をク

リックします。他の方法としては、Windows のサービス コンソールから Cisco Unified CCX 
Engine を停止することもできます。
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Cisco Unified CCX Engine の問題    
Cisco Unified CCX Engine が起動しない

症状   Cisco Unified CCX Engine が起動せず、トレース ファイルに次のメッセージが書き込まれてい

る。

エラー メッセージ   Port already in use.

考えられる原因   他のプロセスが Cisco Unified CCX Engine のデフォルト ポートである ポート 
1099 を使用していると、Unified CCX Engine は起動しません。

Cisco Unified CCX Administration の Web ページから次の手順を実施してください。

ステップ 1 [System] > [System Parameters] の順に選択します。

ステップ 2 [RMI Port Number] フィールドに他のポートを入力します。

ステップ 3 Cisco Unified CCX Engine を停止してから再起動します。

Application サブシステムがパーシャル サービスになっていて、予想外に
長時間実行され続けている

症状   Application サブシステムがパーシャル サービスになっていて、Application Tasks リアルタイム 
レポートによると予想外に長時間実行され続けている。

エラー メッセージ   None.

考えられる原因   アプリケーションがコールを終わっても切断信号を受信せず、コールが終了した

ことを検出するエラー対処の仕組みを持っていない場合、Application サブシステムがパーシャル 
サービスになる可能性があります。また、Application Tasks リアルタイム レポートで、アプリ

ケーションが予想外に長時間実行され続けていることが示されている可能性があります。

推奨処置   コールが終わった後に無限に再試行しないようなエラー対処の仕組みを、アプリケー

ション スクリプトに盛り込むようにしてください。
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Cisco Unified CCX Real-Time Reporting の問題
Cisco Unified CCX サーバと Active Directory を統合すると、いくつか
のサービスが登録されていない状態になる

症状   Cisco Unified CCX サーバで個別にログオン アカウントやパーミッションを作成する代わりに、

Cisco Unified CCX サーバを社内の Active Directory に組み込んでシングル ログオンで 
DESKTOP_CFG share にアクセスできるようにすると、いくつかのサービスが登録されていない状態

になる。たとえば MRCP TTS や VoIP Monitor Server などの新しい製品機能をインストールしても、

いくつかのサービスが登録されない。

エラー メッセージ   None.

考えられる原因   ドメイン セキュリティ ポリシーがインストールに影響して、いくつかのサービス

が登録されなかった可能性があります。インストールは一見問題なく終了したように見えます。

この問題を修復するには、次の手順に従ってください。

ステップ 1 Cisco Unified CCX サーバを Active Directory から個別のワークグループに戻してリブートします。

ステップ 2 個別の管理者としてログオンして、必要なインストーラ CD を実行します。

ステップ 3 リブートしてから、新たなセットアップや設定があればそれらを行います。

ステップ 4 再度 Cisco Unified CCX サーバを Active Directory に追加します。

Cisco Unified CCX Real-Time Reporting の問題
このセクションでは次の Cisco Unified CCX Real-Time Reporting 問題に関して、トラブルシューティ

ングのヒントを提供します。

 • 「Real-Time Reporting を実行しようとするとエラーが発生する」（P.8-56）

 • 「JRE をインストールした後に、Real-Time Reporting から JRE をインストールすべき旨のメッ

セージが表示される」（P.8-57）

 • 「Real-Time Reporting で Contact エントリがスタックする」（P.8-57）

Real-Time Reporting を実行しようとするとエラーが発生する

症状   Cisco Unified CCX Administration の Web ページから Real-Time Reporting を実行しようとする

と、次のメッセージが表示される。

エラー メッセージ   Unable to connect to the server.

考えられる原因   ブラウザでのプロキシの設定により RMI 通信が妨げられている、または RTR サ
ブシステムが実行されていません。
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次の手順に従ってください。

ステップ 1 Internet Explorer で [Tools] > [Internet Options] > [Connections] > [LAN settings] の順に選択して、

[Use a proxy server] チェック ボックスのチェックをはずします。

ステップ 2 RTR サブシステム が実行されていることを確認します。

JRE をインストールした後に、Real-Time Reporting から JRE をインス
トールすべき旨のメッセージが表示される

症状    Real-Time Reporting のアプレットを開くと、実行中の JRE バージョンとインストールすべき 
JRE バージョンを示すメッセージ ボックスが表示される。インストールすべきバージョンの JRE をイン

ストールしてからReal-Time Reporting のアプレットを開くと、やはり同じメッセージが表示される。

エラー メッセージ   Message contains the JRE version.

考えられる原因   このメッセージは、他のバージョンの JRE がデフォルトとしてマシンにインス

トールされていて、これが実行されたときに表示されます。

推奨処置   コントロール パネルからこのバージョンの JRE をアンインストールして、インストー

ルされるべき JRE を再インストールしてください。

Real-Time Reporting で Contact エントリがスタックする

症状   Real-Time Reporting で Contact エントリがスタックする。

エラー メッセージ   None.

推奨処置   次に掲載する状況に応じて手順を実行してください。

CSQ Stats の CSQ で Contact がスタックする 

ステップ 1 [CSQ Stats] を開きます。

ステップ 2 Contact がスタックしている CSQ を選択します。

ステップ 3 [View] > [CSQ Waiting Contacts Info] を選択します。

ステップ 4 スタックしている Contact を選択します。

ステップ 5 スタックしている Contact に関する情報（ImplID）を書きとめます。

ステップ 6 Contact を選択し、[Tools] > [Clear Contact] をクリックして削除します。

ステップ 7 削除した Contact に関する情報をサポート プロバイダーに送って原因を解析してもらってください。
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[Overall Stats] で待機中に Contact がスタックする 

ステップ 1 [Overall Stats] を開きます。

ステップ 2 [View] > [Overall Waiting Contacts Info] を選択します。

ステップ 3 スタックしている Contact を選択します。

ステップ 4 スタックしている Contact に関する情報（ImplID）を書きとめます。

ステップ 5 Contact を選択し、[Tools] > [Clear Contact] をクリックして削除します。

ステップ 6 削除した Contact に関する情報をサポート プロバイダーに送って原因を解析してもらってください。

Contact Report で Contact がスタックする

ステップ 1 [Contacts Report] を開きます。

ステップ 2 スタックしている Contact を選択します。

ステップ 3 スタックしている Contact に関する情報（ImplID）を書きとめます。

ステップ 4 Contact を選択し、[Tools] > [Clear Contact] をクリックして削除します。

ステップ 5 削除した Contact に関する情報をサポート プロバイダーに送って原因を解析してもらってください。

（注） • これら手順により正当で有効な Contact も削除される可能性があるため、表示される「注意」に気

をつけてください。

 • レポート 内の [Active] カラムで、有効な Contact と、スタックの疑いが高い Contact を見分けてく

ださい。

 • 有効な Contact を誤って削除したときは、Historical Reporting を disposition = 99 でサーチすれば

見つけることができます。
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Cisco Unified CCX Historical Reporting の問題
このセクションでは次の Cisco Unified CCX Historical Reporting 問題に関して、トラブルシューティ

ングのヒントを提供します。

 • 「エクスポート した PDF レポートを横方向に印刷できない」（P.8-60）

 • 「HR クライアントのインストール後、ユーザ ログインが見当たらない」（P.8-60）

 • 「クライアント と サーバのセキュリティ ポリシーが一致しない」（P.8-61）

 • 「チャートが MS Excel フォーマットで正しく表示されない」（P.8-61）

 • 「MS Excel フォーマットでエクスポートしたレポートの中に表示されないデータ カラムがある」

（P.8-61）

 • 「MS Excel フォーマットのレポート内のレコードが短縮されている」（P.8-62）

 • 「チャート内のエージェント名が上書きされる」（P.8-62）

 • 「チャートを含む RTF レポート内に表形式のレポート タイトルが表示される」（P.8-62）

 • 「Terminal Services クライアントに [Scheduler] アイコンが表示されない」（P.8-63）

 • 「レポートがスケジュールされた時間に実行されない」（P.8-63）

 • 「地域が [German] に設定されているにもかかわらず、Windows システムで [Search] ダイアログ 
ボックスと [Preview] タブが英語で表示される」（P.8-63）

 • 「レポートをエクスポートするときに、表示されるべきダイアログ ボックスが表示されない」

（P.8-64）

 • 「Historical Reporting の Web ページのオプションを選択するとエラーが発生する」（P.8-64）

 • 「Historical Reports クライアントのレポートが短縮されている」（P.8-65）

 • 「Scheduled Historical Reports を実行できない」（P.8-65）

 • 「ヒストリ レポートを生成しようとすると [SQL Command Failed] ダイアログ ボックスが表示され

る」（P.8-66）

 • 「ドイツ語のシステムで、一部の情報が英語で表示される」（P.8-66）

 • 「Historical Reports クライアント コンピュータが Cisco Unified CCX サーバに接続できない」

（P.8-66）

 • 「エラー [Database Connection Error 5051] が表示される」（P.8-67）

 • 「[Export] ダイアログ ボックスにエクスポートするファイル名が表示されない」（P.8-68）

 • 「[Database Server Configuration] ページからマシン上のアプリケーションをポイントできない」

（P.8-68）

 • 「Historical Reporting クライアントから Cisco Unified CCX サーバにログインしようとすると、失

敗してエラーメッセージが返る」（P.8-68）

 • 「Cisco Unified CCX Standard のテンプレートが 3 つしか利用できない」（P.8-69）

 • 「カスタム レポートに表示される ACD コール数に食い違いがある」（P.8-69）

 • 「Priority Summary Activity Report チャートの印刷が部分的にしかカラー印刷にならない」

（P.8-70）

 • 「Scheduled Historical Reports が実行されず、CiscoSch.log ファイルにメッセージが書き込まれ

る」（P.8-70）

 • 「[Historical Reporting Client] ウィンドウのドロップダウン メニューに何も表示されない」

（P.8-71）
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 • 「Historical Reporting Client が動作しなくなり、再度ログインしようとするとエラー メッセージが

表示される」（P.8-71）

 • 「カスタム レポートの実行中に Scheduler DOS の例外エラーが発生する」（P.8-72）

 • 「レポートをエクスポートすると、Excel シートのカラムが除去される」（P.8-72）

 • 「Windows のステータスバーに [Scheduler] アイコンが表示されない」（P.8-72）

 • 「データベース接続が切断されたことを示すエラー メッセージが表示される」（P.8-73）

エクスポート した PDF レポートを横方向に印刷できない

症状   エクスポートした Portable Document Format（PDF）レポートを横方向に印刷できない。

エラー メッセージ   None.

考えられる原因   PDF ビューアの制限によります。

推奨処置   縦方向に印刷してください。

HR クライアントのインストール後、ユーザ ログインが見当たらない

症状   Historical Report クライアントのインストール後、ユーザ ログインが見当たらない。

エラー メッセージ   None.

考えられる原因   Windows XP システムでは、システムに他のユーザ アカウントがない場合、 
Administrator ユーザ アイコン が表示されません。

推奨処置   次のいずれかを実施してください。

 • マシンを再起動します。Windows XP のログイン画面が表示されたら（ユーザ アイコンが表示さ

れています）、[Ctrl-Alt-Del] を 2 回押して Administrator ユーザ ID を選択します。

 • XP システムに Administrator でないユーザ アカウントを新たに作成します。
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クライアント と サーバのセキュリティ ポリシーが一致しない

症状   クライアントとサーバのポリシーが一致しない場合、Cisco Unified CCX サーバ が Windows 
2003 上で稼動していると Cisco Unified CCX Historical Reports クライアントが Windows 2000 
Professional で稼動しない。

エラー メッセージ   None.

考えられる原因   クライアント と サーバのセキュリティ ポリシーが一致していません。

次の手順に従ってセキュリティ ポリシーが一致していることを確認してください。

ステップ 1 [Start] > [Programs] > [Control Panel] > [Administrative Tools] > [Local Security Policy] の順に選択し

て、ネットワーク セキュリティである LAN Manager Authentication の設定を書きとめます。

ステップ 2 次に Historical Reports クライアント PC で [Local Security Settings] ウィンドウを開き、セキュリティ

（LAN Manager Authentication） 設定が Cisco Unified CCX サーバと一致していることを確認します。

チャートが MS Excel フォーマットで正しく表示されない

症状   Microsoft Excel フォーマットでエクスポートしたレポートのチャートが正しく表示されない。

エラー メッセージ   None.

考えられる原因   エクスポート機能の制限です。

推奨処置   Microsoft Excel フォーマットでエクスポートするレポートにチャートを含めないように

してください。

MS Excel フォーマットでエクスポートしたレポートの中に表示されない
データ カラムがある

症状   Microsoft Excel フォーマットでエクスポートしたレポートのデータ カラムが正しく表示されな

い。

エラー メッセージ   None.

考えられる原因   エクスポート機能の制限です。

推奨処置   エクスポートを実行するコンピュータに Excel 7.0 の拡張版がインストールされている

ことを確認してください。
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MS Excel フォーマットのレポート内のレコードが短縮されている

症状   Microsoft Excel フォーマットでエクスポートしたレポートに短縮されたレコードがある。

エラー メッセージ   None.

考えられる原因   Microsoft Excel の制限です。Excel 7.0（95） のレポートでは 16,384 レコードに

制限されています。Excel 8.0（97）と Excel 2000 のレポートでは 65,536 レコードに制限されてい

ます。Excel ファイル内のこれら制限を超えた分のレコードは短縮されます。

推奨処置   Microsoft Excel フォーマットにエクスポートするときは、レポートのサイズに気を付け

てください。

チャート内のエージェント名が上書きされる

症状    Agent Detail Report、Agent Login Logout Activity Report、または Agent Summary Report 内に

表示されるチャートでエージェント名が互いに上書きされる。

エラー メッセージ   None.

考えられる原因   レポート内のエージェント数が 70 を超えています。

推奨処置   70 を超えるエージェントの情報を含むレポートには、チャートを含めない、あるいは

フィルタ パラメータを使用してレポート内容を制限するようにしてください。

チャートを含む RTF レポート内に表形式のレポート タイトルが表示される

症状   Rich Text Format（RTF）にエクスポートされたレポート内のチャートを含むページに、表形式

のレポート タイトルが表示される。

エラー メッセージ   None.

考えられる原因   エクスポート機能の制限です。

推奨処置   レポートを RTF にエクスポートするときは、この制限事項に注意してください。
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Terminal Services クライアントに [Scheduler] アイコンが表示されない

症状   Terminal Services セッションのもとで Cisco Unified CCX Historical Reports を実行すると、

Terminal Services クライアントに [Scheduler] アイコンが表示されない。

エラー メッセージ   None.

考えられる原因   Cisco Unified CCX Historical Reports クライアント システムでは、設計上 
Scheduler は 1 インスタンスしか実行できなくなっています。

推奨処置   なし。

レポートがスケジュールされた時間に実行されない

症状   レポート生成のスケジュールが予定どおりに実行されない。

エラー メッセージ   None.

考えられる原因   Cisco Unified CCX Historical Reports クライアント システムのクロックが変更さ

れたにもかかわらず、スケジュールが再起動されていません。

推奨処置   Scheduler を停止して再起動してください。詳細については『Cisco Unified CCX 
Historical Reports User Guide』を参照してください。

地域が [German] に設定されているにもかかわらず、Windows システム
で [Search] ダイアログ ボックスと [Preview] タブが英語で表示される

症状   Cisco Unified CCX Historical Reports クライアントを、英語版の Windows でシステムの地域設

定を [German] にしたうえで実行しても、Report Viewer での [Search] ダイアログ ボックス と 
[Previews] が英語で表示される。

エラー メッセージ   None.

考えられる原因   Report Viewer の制限です。

推奨処置   ドイツ語版のオペレーティング システムをインストールしてください。
8-63
Cisco Unified Contact Center Express サービスおよびトラブルシューティング ガイド リリース 7.0(1)        

 



 

第 8 章      トラブルシューティングのヒント        

Cisco Unified CCX Historical Reporting の問題
レポートをエクスポートするときに、表示されるべきダイアログ ボックス
が表示されない

症状   レポートをエクスポートするときに、表示されるべきダイアログ ボックスが表示されない。

エラー メッセージ   If the report is being exported, the following message will appear 
at or near the end of the file:Note: Getting report contents may take considerable amount of 
time based on the size of the contents...Pls wait...

考えられる原因   このダイアログ ボックスは、クライアント システムが必要なデータベース レ
コードを読みだした後に初めて表示されます。レポートが大きい場合、レコードを読みだすのに長

時間を要します。

推奨処置   エクスポートが完了するまで待ってください。または CiscoSChPrintExport.log を
チェックしてください。

Historical Reporting の Web ページのオプションを選択するとエラーが
発生する

症状   Cisco Historical Reporting の Web ページのオプションを選択するとエラー メッセージが表示さ

れる。

エラー メッセージ   Not defined.

考えられる原因   Cisco Unified CCX Node Manager service または MSSQLServer が稼動していな

い、あるいは Cisco Unified CCX データベースへの接続に問題がある可能性があります。

推奨処置   次の手順に従ってください。

ステップ 1 Cisco Unified CCX サーバで Cisco Unified CCX Node Manager サービスが稼動していることを確認し

ます。

ステップ 2 Cisco Unified CCX サーバで MSSQLServer サービスが稼動していることを確認します。

ステップ 3 Cisco Unified CCX サーバで [Start] > [Settings] > [Control Panel] > [Administrative Tools] > [Data 
Sources（ODBC）] の順に選択し、ODBC System DSNs の dsn_cra と DSN_SCH_DB が適切に設定さ

れていることを確認します。
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Historical Reports クライアントのレポートが短縮されている

症状   ローカライズされた Historical Report （スペイン語など）で、Historical Reports クライアント

のユーザ インターフェイスに表示されるレポート記述が短縮されている。

エラー メッセージ   None.

考えられる原因   Historical Reports クライアントのユーザ インターフェイスでは、説明ボックス

に表示されるレポート記述が途切れているように見えます。

推奨処置    Historical Reports クライアントのユーザ インターフェイスの説明ボックスをクリック

してスクロールすると、ローカライズされた記述の全体を参照できます。

Scheduled Historical Reports を実行できない

症状   Historical Reports クライアントでスケジュールした Historical Reports が実行されない。

エラー メッセージ   None.

考えられる原因   この問題は Historical Reports クライアント スケジュールの設定、または 
Historical Reports Scheduler の接続上の不具合が原因で発生している可能性があります。

次の手順に従ってください。

ステップ 1  Historical Reports にスケジュールが登録されているかを確認します。これを行うには、Historical 
Reports を起動して [Settings] > [Scheduler] を開きます。[Scheduled Reports] ダイアログ ボックスに

「Daily」スケジュールが登録されていないかを確認します。

ステップ 2 デフォルトでは「Daily」スケジュールは 1 回実行されるとその後は実行されません。これらを実行し

続けるようにするには、[Schedule Configuration] ダイアログ ボックスで [No end date] を選択します。

ステップ 3 ブラウザのプロキシ サーバの設定をチェックします。Internet Explorer を開いて [Internet Options] > 
[Connections] > [LAN settings] の順に選択します。[Use a proxy server] チェック ボックスが選択され

ていることを確認します。選択されている場合は [Advanced] をクリックして、Cisco Unified CCX 
サーバを例外として追加します。
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ヒストリ レポートを生成しようとすると [SQL Command Failed] ダイア
ログ ボックスが表示される

症状   Cisco Unified CCX Historical Reports クライアント コンピュータでヒストリ レポートを生成し

ようとすると [SQL Command Failed] ダイアログ ボックスが表示される。このダイアログボックスに

はエラー番号 n が表示される。

エラー メッセージ   Error:<number>

考えられる原因   このエラーはさまざまな状況で発生します。

推奨処置   [SQL Command Failed] ダイアログ ボックスが表示されたコンピュータで、最新の 
Historical Reports ログ ファイルを開きます。エラー番号を検索します。エラー番号の付近にエ

ラーの原因が記載されています。この情報から問題を解決してください。

ドイツ語のシステムで、一部の情報が英語で表示される

症状   Cisco Unified CCX Historical Reports クライアントの英語版 Windowsコンピュータで、システ

ムの地域設定を [German] にしても、Report Viewer での [Search] ダイアログ ボックス と [Previews] 
タブが英語で表示される。

エラー メッセージ   None.

考えられる原因   Report Viewer の制限です。

推奨処置   ドイツ語版のオペレーティング システムをインストールしてください。

Historical Reports クライアント コンピュータが Cisco Unified CCX 
サーバに接続できない

症状   Cisco Unified CCX Historical Reports クライアント コンピュータが Cisco Unified CCX サーバ

に接続できない。Historical Reports クライアント ログ ファイルに次のメッセージが書き込まれてい

る。

エラー メッセージ   Not associated with a trusted connection.

考えられる原因   SQL サーバが正しい認証でアクセスされていません。
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推奨処置   Cisco Unified CCX Historical Reporting クライアント コンピュータで次の手順を実行し

てください。

ステップ 1 [Start] > [Programs] > [Microsoft SQL Server n] > [Enterprise Manager] の順に選択します。ここで n 
はバージョン番号です。

ステップ 2 [Microsoft SQL Servers] をダブルクリックします。

ステップ 3 [SQL Server Group] をダブルクリックします。

ステップ 4 [SQL Server group] で Cisco Unified CCX データベースが搭載されているサーバ名を右クリックしま

す。

ステップ 5 [Properties] を選択します。

ステップ 6 [Security] タブを選択します。

ステップ 7 [Windows only] オプション ボタンをクリックします。

ステップ 8 [OK] をクリックします。

エラー [Database Connection Error 5051] が表示される

症状   クライアント コンピュータで Cisco Unified CCX Historical Reporting クライアント ソフトウェ

アにログインしようとすると [Database Connection Error 5051] が表示される。

エラー メッセージ   Error 5051

考えられる原因   ネットワーク接続がダウンしている、あるいはクライアントの接続設定に誤りが

あります。

推奨処置   次の手順に従ってください。

ステップ 1 Cisco Unified CCX Historical Reports クライアント コンピュータの Windows コントロールパネルか

ら、[Data Sources（ODBC）] を選択します。

ステップ 2 クライアント コンピュータから接続しようとしている Cisco Unified CCX サーバの db_cra データベー

スに DSN を作成します。クライアント コンピュータと Cisco Unified CCX の管理者パスワードが同じ

であることを確認します。ODBC データ ソースから Cisco Unified CCX サーバをポイントする際、

<crsServerNameOrIP>¥CRSSQL を使用します。ここで crsServerNameOrIP は 名前付きインスタンス

です。たとえば、Cisco Unified CCX のサーバ名が CiscoUCCXserver1 の場合、Server input box に 
CiscoUCCXserver1¥CRSSQL と入力します。Cisco Unified CCX は NT 認証を使用するので、

[Windows NT authentication] オプション ボタンを選択します。

ステップ 3 DSN を作成できない場合は、Cisco Unified CCX Historical Reports クライアント コンピュータと 
Cisco Unified CCX サーバがネットワーク上で接続されているかを確認してください。

ステップ 4 DSN を使用して接続できない場合は、クライアント コンピュータの hrcConfig.ini ファイルを適切な

ネットワーク ライブラリで更新してください。
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[Export] ダイアログ ボックスにエクスポートするファイル名が表示されな
い

症状   [Export] ダイアログ ボックスにエクスポートするデフォルト ファイル名が表示されない。

エラー メッセージ   None.

考えられる原因   言語が [Simplified Chinese] と設定された Cisco Unified CCX Historical Reports 
クライアント コンピュータ上で、Report Viewer の [Export Report] ツールをクリックしても、

[Export] ダイアログ ボックスにデフォルトのエクスポート ファイル名が表示されない。

推奨処置   レポート名は Report Viewer のレポートのヘッダーに表示されます。[Export] ダイアロ

グボックスで、レポート名を使ってエクスポートされるレポートの名前を指定してください。たと

えば、PDF レポート名を <ReportName>_<startdatetime>_<enddatetime>.pdf と指定します。

[Database Server Configuration] ページからマシン上のアプリケーショ
ンをポイントできない

症状   Historical Reports Database Server がインストールされていると、[Database Server 
Configuration] ページから Cisco Unified CCX のローカル データベースをポイントできない。

エラー メッセージ   None.

考えられる原因    一旦 Cisco Unified CCX から Historical Reports Database Server（遠隔データ

ベース）が設定されると、Cisco Unified CCX へポイントし直すことはできません。

推奨処置   なし。これは設計どおりの動作です。1 マシン ソリューションに戻すには（Cisco 
Unified CCX の Historical Reports Database Server 設定が失われます）、Cisco Unified CCX をア

ンインストールしてからインストールし直します （Cisco Unified CCX のデータベースを消去して

もいいかを確認するメッセージが表示されるので許容してください）。

Historical Reporting クライアントから Cisco Unified CCX サーバにロ
グインしようとすると、失敗してエラーメッセージが返る

症状   クライアントマシンから Cisco Unified CCX のサーブレット サービスまたは Web サーバにアク

セスできない。

エラー メッセージ   Request timed out.

考えられる原因   認証要求タイムアウトが発生しました。クライアント ログにリクエスト タイムア

ウト エラーが書き込まれています。
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推奨処置   次の手順に従ってください。

ステップ 1 Cisco Unified CCX 上でサーブレット サービスと Web サーバが稼動していることを確認します。クラ

イアント上でブラウザのインターネット オプションの接続設定を確認します。

ステップ 2 クライアント マシンから Cisco Unified CCX Administration の Web ページに接続できることを確認し

ます。ページがキャッシュされていないことを確認するためにページを再読み込みしてください。

ステップ 3 それでも問題が解決しない場合は、hrcConfig.ini ファイルの AuthReqTimeOut を現在より大きい値に

更新します（デフォルトは 15 秒）。

ステップ 4 クライアントを再起動して再度ログインしてみます。

Cisco Unified CCX Standard のテンプレートが 3 つしか利用できない

症状   Cisco Unified CCX Standard でヒストリ レポートの設定をする際、レポート テンプレートとし

て次の 3 つ（IVR Application Performance Analysis、IVR Traffic Analysis、および Detailed Call by 
Call CCDR）しか利用できない。

エラー メッセージ   None.

考えられる原因   リストリ レポート クライアントに Cisco Unified CCX Standard レポートを参照

する権限が割れ当てられていない可能性があります。

推奨処置   Cisco Unified CCX Administration メニューから、[Tools] > [Historical Reporting] を選

択して、ライセンスで 8 つの Cisco Unified CCX レポートと 2 つの IVR レポートが提供されてい

ることを確認してください。

カスタム レポートに表示される ACD コール数に食い違いがある

症状   ユーザ生成のカスタム レポートを実行すると、1 つのレポートは時間毎のコール数を合計 244 と
表示する。他のレポートではレポート対象時間帯の ACD コール数を合計 243 と表示する。他の日でも

このような食い違いがあり、差は 4 コールにも及ぶ。

エラー メッセージ   None.

考えられる原因   ACD コールが転送されると、2 つまたはそれ以上あるコール レッグが別々の 1 
時間に別れることがあります。その場合、コールは第 1 のレポートでは 1 回だけカウントされます

が、第 2 のレポートでは 2 回カウントされます。

推奨処置   これはソフトウェアの設計どおりの動作です。これを回避したい場合、コールをカウン

トする代わりにコール レッグをカウントすることができます。このようにすると第 1 のレポート

と第 2 のレポートでの合計数が一致します。この場合、"select count distinct sessionID" が "select 
count distinct（sessionID、sessionSeqNum）pairs" になります。ただし、このようにするとコー

ル センター全体のコール カウントの定義が変更されることに留意してください。
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Priority Summary Activity Report チャートの印刷が部分的にしかカラー
印刷にならない

症状   Priority Summary Activity Report パイ チャートの縁はカラー印刷になるが中心付近はそうなら

ない。

エラー メッセージ   None.

考えられる原因   この問題は Cisco Unified CCX Historical Report Client Viewer から直接印刷する

と発生し、Crystal Decisions のサード パーティ印刷ドライバに関連しています。

推奨処置   レポートを PDF その他のサポートされているフォーマットのファイルにエクスポート

してから、そのファイルを印刷してください。

Scheduled Historical Reports が実行されず、CiscoSch.log ファイル
にメッセージが書き込まれる

症状   Cisco Unified CCX Historical Reports クライアント システムで Internet Explorer のプロキシ 
サービスを使用している場合、Scheduled Historical Reports が実行されず、CiscoSch.log ファイルに

メッセージが書き込まれる可能性がある。

エラー メッセージ   [CRS_DATABASE] entry not found in the properties file.Failed to validate user or get 
MaxConnections of database value.

考えられる原因   プロキシ サービスからレポートを実行しようとしています。

このようなことが起こったが、Cisco Unified CCX Historical Reports クライアント システム から直接

レポートを実行できる場合は、次の手順に従ってください。

ステップ 1 Historical Reports クライアント システムの Explorer から、[Tools] > [Internet Options] を選択します。

ステップ 2 [Connections] を選択します。

ステップ 3 [LAN Settings] をクリックします。

ステップ 4 プロキシ サーバを使用している場合、[Proxy Service] チェック ボックスにチェックが入っています。

ステップ 5 [Advanced] をクリックします。

ステップ 6 [Do not use proxy server for addresses beginning with] フィールドに Historical Reports クライアント 
システムがログインしている Cisco Unified CCX サーバの IP アドレスを入力します。

ステップ 7 必要に応じて [OK] をクリックして設定を保存します。
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[Historical Reporting Client] ウィンドウのドロップダウン メニューに何
も表示されない

症状   Cisco Unified CCX Administration メニューで [Tools] > [Historical Reporting] を選択しても、ド

ロップダウン メニューに何も表示されない。

エラー メッセージ   None.

考えられる原因   Cisco Unified CM ユーザに権限が与えられていません。

ヒストリ レポートの権限が必要な Cisco Unified CM ユーザに権限を与えてください。

ステップ 1 Cisco Unified CM ユーザのユーザ名で Historical Reporting クライアントにログインします。Cisco 
Unified CCX Administration の該当ユーザに権限を与えるかを確認するメッセージのダイアログ ボッ

クスが表示されます。

ステップ 2 [Yes] をクリックします。[Historical Reporting Privileges] ページが表示されます。

ステップ 3 該当ユーザにヒストリ レポート権限を与えます。適切な logLevel （3）が必要です。

（注） [User Maintenance] ページと [Historical Users] ページは同一のディレクトリ API を基盤として

使用しています。

Historical Reporting Client が動作しなくなり、再度ログインしようとす
るとエラー メッセージが表示される

症状   サーバやネットワークを変更していないにもかかわらず、Cisco Unified CCX Historical 
Reporting クライアントが突然停止する。再度ログインしようとすると、エラー メッセージが連続して

表示される。

エラー メッセージ   A series of messages appear.

考えられる原因   クライアント認証要求タイムアウトが発生しています。

次の手順に従ってください。

ステップ 1 Cisco Unified CCX サーバ上で Web サーバとサーブレット サービスとが稼動していることを確認しま

す。クライアント上でブラウザのインターネット オプションの接続設定を確認します。

ステップ 2 クライアント マシンから Cisco Unified CCX Administration の Web ページに接続できることを確認し

ます。ページがキャッシュされていないことを確認するためにページを再読み込みしてください。

ステップ 3 Cisco Unified CCX Administration Web ページ への接続に成功した後にもクライアント エラーが続く

ようなら、クライアントの hrcConfig.ini ファイルの General セクションの AuthReqTimeOut の値を現

在よりも大きくしてください（デフォルトは 15 秒）。
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ステップ 4 Cisco Unified CCX Historical Reports クライアントを再起動して再度ログインしてみます。

カスタム レポートの実行中に Scheduler DOS の例外エラーが発生する

症状   カスタム レポートの実行中に次のエラー メッセージが CiscoSchPrintExport.log ファイルに書き

込まれる。

エラー メッセージ   ERROR Descripton=Dos error, thread in Export method=Exception.

考えられる原因   レポートが予定された時間に、クライアント マシンからデータベースにアクセス

できない場合にこの DOS エラーが発生することがあります。

推奨処置   CSV 以外のエクスポート フォーマットでレポートをスケジューリングしたうえで、同

じレポートで結果を見てください。

レポートをエクスポートすると、Excel シートのカラムが除去される

症状   Agent Summary Report（エージェント毎）を Microsoft Excel シートにエクスポートすると Avg 
と Max 統計カラムが除去される。

エラー メッセージ   None.

考えられる原因   拡張 Excel フォーマットを使用すると情報が除去されることがあります。

推奨処置   レポートを Excel で報告するときは、[Export] ダイアログで Microsoft Excel 7.(XLS) 拡
張フォーマットを使用してください。すると別のダイアログ ボックスが表示されます。デフォル

ト設定を使用してください。

Windows のステータスバーに [Scheduler] アイコンが表示されない

症状   ターミナル サービス セッション中に、Windows のステータスバーに [Scheduler] アイコンが表

示されない。

エラー メッセージ   None.

考えられる原因   このシステム動作はターミナル サービスから使用した場合の設計どおりのもので

す。

推奨処置   [Scheduler] アイコンから各種機能にアクセスする必要がある場合は、Scheduler がイン

ストールされているコンピュータから行う必要があります。
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データベース接続が切断されたことを示すエラー メッセージが表示される

症状   Agent Detail Report または Abandoned Call Detail Activity Report を生成しているとき、データ

ベース接続が切断されたことを示すエラー メッセージが表示される可能性がある。

エラー メッセージ   Connection with database is broken.

考えられる原因   このメッセージは、システムに高負荷がかかっているときにこれらレポートを生

成すると表示されることがあります。高負荷としては、レポート期間中の数万にも及ぶコール、ま

たはシステムに最大数のスキルを設定することがあげられます。

推奨処置   この問題を回避するには、レポート期間を短縮する、あるいは CSQ を再設定してスキ

ル数の少ない CSQ を増やしてください。

Automatic Speech Recognition の問題
このセクションでは Media Resource Control Protocol（MRCP）Automatic Speech Recognition

（ASR） の次の問題に関して、トラブルシューティングのヒントを提供します。

 • 「名前が認識されない」（P.8-73）

 • 「音声認識がタイムアウトしない」（P.8-74）

 • 「変更された発音やニックネームが認識されない」（P.8-74）

 • 「高負荷のもとで MRCP ASR Group を使用するとコール完了率が低下する」（P.8-75）

 • 「MRCP ASR サブシステムがアウト オブ サービスになっている」（P.8-75）

 • 「MRCP ASR Provider、MRCP Server、または Group への変更、追加、削除が反映されない」

（P.8-76）

 • 「MRCP ASR Dialog Group からルート ポイントに電話をかけるとデフォルト動作で扱われる」

（P.8-76）

名前が認識されない

症状   MRCP ASR Dialog Control Group からチャネルを割り当てられたコールに関して、Name to 
User ステップにおいて安定して名前が認識されない。

エラー メッセージ   None.

考えられる原因   新しい Cisco Unified CCX をインストールした、あるいは名前の追加または既存

の名前を変更した後に、Name Grammar Generator が実行されていません。

推奨処置   Name Grammar Generator を実行してください。
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次の手順に従ってください。

ステップ 1 [Tools] > [User Management] > [Name Grammar Generation] の順に選択します（Name Grammar 
Generator はコールの量の少ない時間帯に実行してください） 。

ステップ 2 正しい Grammar Variant を選択したことを確認してください。Nuance を使用する場合は [Nuance] を
選択します。他のベンダーを使用する場合は [Standard] を選択します。混在する環境の場合は [Both] 
を選択します。

音声認識がタイムアウトしない

症状   音声認識のために音声入力をいつまでも待ち続ける。

エラー メッセージ   None.

考えられる原因   この問題はタイムアウトの初期値を 0 （ゼロ）と設定すると発生します。この問

題は ASR プロバイダーが Nuance の場合にだけ発生します。Nuance の定義では初期タイムアウト

値 0 はタイムアウトしないことを意味します。他のベンダーではこの値は即座にタイムアウトする

ことを意味します。

推奨処置   即座にタイムアウトさせる必要がある場合は次のようにします。ASR ソフトウェア プ
ロバイダーとして Nuance を使用する場合、初期タイムアウト値を 0 （ゼロ）より大きい最小の値

に設定します。他の ASR ベンダーに対しては、初期タイムアウト値を単に 0 （ゼロ）と設定しま

す。

変更された発音やニックネームが認識されない

症状   [Name to User] ステップを ASR モードで使用した場合、変更された発音やニックネームが認識

されない。

エラー メッセージ   None.

考えられる原因   新しい Cisco Unified CCX をインストールした、あるいはニックネームまたは発

音を [User Administration] ページで変更または追加した後に、Name Grammar Generator が実行さ

れていません。

推奨処置   Name Grammar Generator を実行してください。

次の手順に従ってください。

ステップ 1 [Tools] > [User Management] > [Name Grammar Generation] の順に選択します（Name Grammar 
Generator はコールの量の少ない時間帯に実行してください） 。

ステップ 2 正しい Grammar Variant を選択したことを確認してください。Nuance を使用する場合は [Nuance] を
選択します。他のベンダーを使用する場合は [Standard] を選択します。混在する環境の場合は [Both] 
を選択します。
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Automatic Speech Recognition の問題   
高負荷のもとで MRCP ASR Group を使用するとコール完了率が低下する

症状   高負荷のもとでは、MRCP ASR Dialog Control Group のチャネルを使用するコールの完了率が

低くなることがある。

エラー メッセージ   None.

考えられる原因   MRCP チャネルがコールに使用されると、MRCP リソースを使ってセットアッ

プされたセッションを解放するのに余計に時間がかかることがあります。

推奨処置   MRCP ASR Dialog Control Group を 1.2 倍（20%増）実装してください。たとえばア

プリケーションが 100 の MRCP ASR チャネルを必要とする場合、120 のMRCP ASR チャネルを

実装してください。次の手順に従ってください。

ステップ 1 [Subsystems] > [MRCP ASR] > [MRCP ASR Provider Configuration] の順に選択します。

ステップ 2 左側のパネルの [MRCP ASR Dialog Groups] リンクをクリックします。

ステップ 3 [Add MRCP ASR Dialog Control Group] リンクをクリックするか、既存のグループを選択します。

ステップ 4 [Max.Number of Sessions] の値を上記に従って変更します。この値 を 1.2 倍（20% 増）に設定してく

ださい。

ステップ 5 以上の操作に応じて [Update] または [Add] をクリックしてください。

MRCP ASR サブシステムがアウト オブ サービスになっている

症状   [Engine] Web ページ の [Engine Status] エリアで MRCP ASR サブシステムが アウト オブ サー

ビス になっている。

エラー メッセージ   None.

これは次のいずれかが原因で起こりえます。

 • MRCP Provider と Server が MRCP ASR Configuration の Web ページから設定されていない。

 • MRCP ASR Server がダウンしているか到達不能である。

 • Speech Server が MRCP ASR Configuration の Web ページから設定されていない。

推奨処置   次の手順に従ってください。

ステップ 1 MRCP Provider と Server が MRCP ASR Configuration の Web ページから設定されていることを確認

する。

ステップ 2 MRCP ASR Server が稼動していて到達可能であることを確認する。
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Automatic Speech Recognition の問題
MRCP ASR Provider、MRCP Server、または Group への変更、追加、
削除が反映されない

症状   Cisco Unified CCX Administration から行った MRCP ASR Provider、MRCP Server、または 
Group への変更が反映されないように見える。

エラー メッセージ   None.

考えられる原因   Cisco Unified CCX Administration から MRCP ASR Provider、MRCP Server、ま
たはGroup そして地域への変更（追加、削除も含める）を行うと、これらの変更内容は Config 
データベースには反映されますが、既にエンジンにロードされたデータには反映されません。これ

ら変更をエンジンの再起動なしで即座に有効にするには、直接 MRCP ASR サブシステムに変更を

再ロードする必要があります。

推奨処置   エンジンを再起動しないでこれら変更を即座に有効にするには、次の手順に従ってくだ

さい。

ステップ 1 MRCP Provider、Server、または Group のいずれか 1 つに関係するデータを再ロードするには、

[Subsystems] > [MRCP ASR] から [MRCP ASR Configuration] ページを開き、対応するプロバイダー

の再読み込みアイコンをクリックします。この手順で新しく作成された MRCP ASR Provider をロード

することもできます。

ステップ 2 すべてのプロバイダーを再ロードするには、[Subsystems] > [MRCP ASR] から [MRCP ASR 
Configuration] ページを開き、[Refresh All] をクリックします。

MRCP ASR Dialog Group からルート ポイントに電話をかけるとデフォ
ルト動作で扱われる

症状   カスタマーが MRCP ASR Dialog Group からルート ポイントに電話をかけるとデフォルト動作

で扱われる。

エラー メッセージ   None.

これは次のいずれかが原因で起こりえます。

 • 該当の Dialog Group 用にサーバが設定されていない。MRCP ASR Dialog Group が特定の MRCP 
ASR Provider を参照している。それぞれの MRCP ASR Provider は、IN_SERVICE となるには、

少なくとも 1 つの到達可能なサーバが設定されている必要があります。

 • MRCP ASR Provider のどのサーバも MRCP Dialog Group に必要なすべての言語を提供できない。

推奨処置   原因によって、次のいずれかを実施してください。

 • MRCP ASR Dialog Group が使用する MRCP ASR Provider に対して、到達可能なサーバが設定さ

れていることを確認してください。
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Outbound の問題 
 • MRCP ASR Provider を設定する際、複数の MRCP ASR Server をその Provider に対応付けること

ができます。それぞれのサーバに異なる言語をサポートさせることができます。たとえば、サーバ 
A に en_US、サーバ B に es_ES をサポートさせます。これらサーバ を持つ Provider で MRCP 
Dialog Group を設定すると、有効言語のリストができます。この例では、指定されたProvider に
対応する Server がサポートする言語から、リストに en_US と es_US が含まれます。

 • 通常 Group に対してユーザ インターフェイスで en_US と es_ES の両方は選択できません。なぜな

らどちらのサーバもこれら言語の両方はサポートしないからです。ところがサーバのうち少なくと

も 1 つが、インストールされている言語のすべてをサポートする場合には例外的状況を作り出すこ

とができます。この場合少なくとも 1 つのサーバがすべての言語をサポートするため、UI で 
Group に対してすべての言語を選択することが許可されます。上記サーバでサポートする言語を 1 
つ削除することができます。そうすると、Group は変更されていないため、どのサーバもサポート

できない言語組み合わせが必要になってきます。

 • このようなことが起こっていないかを確認するためには、問題となる Group の Cisco Unified CCX 
Administration の Web ページにアクセスします。[Update] をクリックします。[There are no 
servers to satisfy this selection of languages] というメッセージが表示されたら、言語リストを 
Provider の少なくとも 1 つのサーバがすべてサポートするように変更する必要があります。

Outbound の問題
このセクションでは次の Outbound 問題に関して、トラブルシューティングのヒントを提供します。

 • 「エージェントがスキップまたはスキップクローズするが予約状態に留まらない」（P.8-78）

 • 「エージェントにコールバックされない」（P.8-78）

 • 「エージェントは受信可能状態だが最大 2 分間アウトバウンド コールを受けない」（P.8-78）

 • 「アウトバウンド コールの発信でエラーになる」（P.8-79）

 • 「連絡先をすべてはインポートできない」（P.8-79）

 • 「RmCm サブシステムに CSQ が設定されているのにもかかわらず、Campaigns Configuration の
Web ページの利用可能 CSQ リストが空になっている」（P.8-79）

 • 「CAD に [Outbound] ボタンが表示されない」（P.8-80）

 • 「CAD に [Outbound] ボタンが表示されるが無効化されている」（P.8-80）

 • 「アウトバウンド コールがダイヤルできない」（P.8-80）

 • 「アウトバウンド コール量が少ない」（P.8-81）

 • 「Outbound System Service が稼動していない」（P.8-81）

 • 「RTR Outbound レポートに一部の再分類が表示されない」（P.8-82）
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Outbound の問題
エージェントがスキップまたはスキップクローズするが予約状態に留まら
ない

症状   エージェントがスキップまたはスキップクローズするが予約状態に留まらない。

エラー メッセージ   None.

考えられる原因   Outbound のメモリに連絡先がない場合、エージェントはアウトバウンド コール

に予約されず、エージェントの auto-available の設定に応じてその後コールに対応できたりできな

かったりする。

推奨処置   Outbound サブシステムのメモリに連絡先があること、およびエージェントの設定が 
auto-available になっていることを確認してください。

エージェントにコールバックされない 

症状   エージェントにコールバックされない。

エラー メッセージ   None.

考えられる原因   CAD のシステム時刻が正しくない可能性があります。

推奨処置   CAD のシステム時刻が正しいことを確認してください。

エージェントは受信可能状態だが最大 2 分間アウトバウンド コールを受け
ない

症状   エージェントは受信可能状態だが最大 2 分間アウトバウンド コールを受けない。

エラー メッセージ   None.

考えられる原因   これは設計どおりです。Outbound サブシステムが受信可能なエージェントを検

出し、データベースから Outbound 連絡先を取得してエージェントに提示するのに最大 2 分間かか

ります。

推奨処置   対策を取る必要はありません。
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Outbound の問題 
アウトバウンド コールの発信でエラーになる

症状   アウトバウンド コールの発信でエラーになる。

エラー メッセージ   The error message depends on the error.

考えられる原因   General Configuration Web ページのダイヤル プレフィックスが不正確である可

能性があります。

推奨処置   General Configuration Web ページのダイヤル プレフィックスをチェックしてください。

連絡先をすべてはインポートできない

症状   連絡先をすべてはインポートできない。

エラー メッセージ   None

考えられる原因   インポートする連絡先に同じ電話番号のものが含まれているとこのような重複が

上書きされ、その結果、サブシステムにインポートされる連絡先の数が少なくなります。

推奨処置   インポートする連絡先に番号の重複がないことを確認してください。

RmCm サブシステムに CSQ が設定されているのにもかかわらず、

Campaigns Configuration のWeb ページの利用可能 CSQ リストが空に
なっている

症状   RmCm サブシステムに CSQ が設定されているのにもかかわらず、Campaigns Configuration の
Web ページで表示される CSQ リストが空になっている。

エラー メッセージ   None

考えられる原因   General Configuration Web ページの割り当て済み CSQ リストが空です。

推奨処置   General Configuration Web ページの割り当て済み CSQ リストが空でないようにしてく

ださい。General Configuration Web ページの割り当て済み CSQ だけが Campaign Web ページの利

用可能 CSQ リストに入ります。
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Outbound の問題
CAD に [Outbound] ボタンが表示されない

症状   CAD に [Outbound] ボタンが表示されない。

エラー メッセージ   None

考えられる原因   CAD の Direct Preview チェックボックスがチェックされていない。

推奨処置   CAD の Direct Preview チェックボックスをチェックするようにしてください。

推奨処置   CAD で Outbound 機能の追加ボタンを表示するには、CDA で Direct Preview オプショ

ンを有効にする必要があります。『Cisco Desktop Administrator’s User Guide』 および 『Cisco 
Agent User Guide, Release 6.4 for Cisco Unified CCX』のリリース 7.0（1） を参照してください。

CAD に [Outbound] ボタンが表示されるが無効化されている

症状   CAD に [Outbound] ボタンが表示されるが無効化されている。

エラー メッセージ   None

考えられる原因   サーバの Enterprise Data Service がダウンしています。

推奨処置   Cisco Unified CCX サーバで Enterprise Data Service を稼動させてください。

アウトバウンド コールがダイヤルできない

症状   アウトバウンド コールがダイヤルできない。

エラー メッセージ   None

考えられる原因   Outbound サブシステムがダウンしている、キャンペーンが有効になっていない、

キャンペーンの開始時間か終了時間が正しくない、カスタマーのダイヤル時間が正しくない、イン

バウンド コールが優先的に処理されている、キャンペーン用に連絡先がインポートされていない、

などが原因になっている可能性があります。

推奨処置   次の事項を確認してください。

 • キャンペーンに割り当てられた CSQ にエージェントが対応可能になっている。

 • Outbound System Service が稼動している。2 ノードクラスタの場合、両ノードで Config Data 
Store が稼動している。

 • キャンペーンが有効になっている。

 • キャンペーンの開始時刻と終了時刻が正しい。

 • カスタマー ダイヤル時間が正しい。
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Outbound の問題 
 • Non-Cisco IP Phone Agent（non-IPPA）エージェントが対応可能になっている（インバウンド 
コールが優先）。

 • キャンペーン用に連絡先がインポートされている。

 • Cisco Unified CCX Administration の [System Parameters Configuration] ページで Outbound Seat 
数が 0 より大になっている。

アウトバウンド コール量が少ない

症状   アウトバウンド コールの数が少ない。

エラー メッセージ   None

考えられる原因   General Configuration Web ページで、アウトバウンド コールに対する CSQ の割

合（パーセント）が少なくなっています。

推奨処置   General Configuration Web ページで、アウトバウンド コールに対する CSQ の割合

（パーセント）を確認して、必要ならば増やしてください。

Outbound System Service が稼動していない

症状   Outbound System Service が稼動していない。

エラー メッセージ   None

考えられる原因   Outbound のライセンスがアップロードされていない、Config Data Store がすべ

て稼動していなく MSSQL サービスが 2 つとも稼動していない、RmCm サブシステムが稼動して

いない、などが原因として考えられます。

推奨処置   次の事項を確認してください。

 • Control Center で Outbound サブシステムが [IN SERVICE] であり、[Parameters Configuration] 
ページで Outbound seats 数が 0 より大になっている。

（注）  デフォルトとして、Outbound seats 数は MCS ハードウェアの種類に応じて設定されます。

 • すべての Config Data Stores が稼動していて、MSSQL が 2 つとも稼動している。

 • RmCm サブシステムが稼動中になっている。
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Text-to-Speech の問題
RTR Outbound レポートに一部の再分類が表示されない

症状   RTR Outbound レポートに一部の再分類が表示されない。

エラー メッセージ   None

考えられる原因   これは設計どおりです。すべての再分類カテゴリーが表示されるわけではありま

せん。

推奨処置   レポートの完全なリストは Cisco Unified CCX Historical Reports から取得できます。

『Cisco Unified Contact Center Express Historical Reports User Guide』および『Cisco Unified 
Contact Center Express Administration Guide』の「Managing Cisco Unified CCX Historical 
Reporting」の章を参照してください。

Text-to-Speech の問題
このセクションでは次の MRCP Text-to-Speech（TTS） 問題に関して、トラブルシューティングのヒン

トを提供します。

 • 「プロバイダーが即座に IN_SERVICE になる」（P.8-82）

 • 「TTS プロンプトが再生されない」（P.8-83）

 • 「TTS プロンプトが聞こえない」（P.8-84）

 • 「MRCP TTS サブシステムがアウト オブ サービスになっている」（P.8-84）

 • 「Long TTS プロンプトが Cisco Unified CCX サーバのかなりの量のメモリを消費する」（P.8-85）

 • 「UTF-8 以外の文字が必要な言語がある」（P.8-85）

 • 「wav ファイルのプロンプトが TTS サーバで再生するときに乱れる」（P.8-86）

 • 「MRCP TTS Provider、MRCP Server、地域、または 性別への変更、追加、削除が反映されない」

（P.8-86）

プロバイダーが即座に IN_SERVICE になる

症状   ASR/TTS プロバイダーを作成すると、それが即座に IN_SERVICE になる。プロバイダー用に

サービスを作成する前にこのようになる。

エラー メッセージ   The ASR/TTS provider status incorrectly shows IN_SERVICE.

考えられる原因   プロバイダーをサーバとともに削除した後に新たなプロバイダーを作成すると、

新しいプロバイダーは以前の設定を引き継いで使用し、リフレッシュされません。

推奨処置   そのプロバイダーに対して [Refresh] または [Refresh All] をクリックしてください。す

るとプロバイダーの状態は期待どおりに OUT_OF_SERVICE になります。
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Text-to-Speech の問題 
TTS プロンプトが再生されない

症状   発信者に TTS プロンプトが聞こえるべきときに聞こえない。

エラー メッセージ   None.

考えられる原因   これは次のいずれかが原因で起こりえます。

 • TTS Prompt ステップの [Override Language] フィールドで指定されている言語が利用可能になっ

ていない。

 • Text Input 表現で参照されているテキストが 20 KB 以上である。

 • 使用されている MRCP TTS Provider のための十分な MRCP TTS ライセンスがない。MRCP TTS 
ベンダー毎にライセンスが異なる方法で実装されている可能性がある。ベンダーのライセンス ス
キーム上、使用されている言語に対して十分な MRCP TTS ライセンスが設定されていない可能性

がある。

 • それぞれ異なる言語セットをサポートする複数の TTS プロバイダーを採用しているが、適切な 
TTS プロバイダー（目的の言語をサポートする方）が使用されていない可能性がある。該当する

プロバイダーが デフォルト TTS プロバイダーとして選択されていないため、他のプロバイダーが

使用されている可能性がある。

推奨処置   原因によって、次のいずれかを実施してください。

 • Cisco Unified CCX Administration の Web ページから指定された言語が利用できない場合、

[Subsystems] > [MRCP TTS] を選択して [Override Language] で指定された MRCP TTS サーバが

設定されていることを確認してください。設定されていない場合、目的の言語の MRCP TTS サー

バを新たに設定してから、対応する MRCP Provider を再ロードしてください。

 • 20 KB を超えるテキストは許可されていません。20 KB 以下のテキストを使用するようにしてくだ

さい。

 • 必要であれば、MRCP TTS ベンダーから MRCP TTS ポートを追加するためのライセンスを取得し

てください。

 • デフォルト TTS プロバイダーが使用されていない場合、Cisco Unified CCX Administration から 
[Default TTS Provider] フィールドを設定してください。[System] > [System Parameters] を開いて

目的の TTS プロバイダーを選択します。または Cisco Unified CCX Editor Create TTS Prompt ス
テップで、[Overrride TTS Provider] フィールドに個別に TTS プロバイダーを指定します。VXML 
スクリプトを使用している場合は、Nuance Vocalizer 3.0 に対する TTS プロバイダーを指定して、

これを次のように設定してください。

 • <property name="com.cisco.tts.provider" value="Nuance Vocalizer 3.0"/>
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Text-to-Speech の問題
TTS プロンプトが聞こえない

症状   TTS プロンプトが発信者に聞こえない。

エラー メッセージ   None.

考えられる原因   該当テキストの言語が、TTS Prompt ステップの [Override Language] フィールド

で指定されているものと一致していません。たとえば、テキストは英語ですが、Override 
Language はスペイン語です。

推奨処置   該当の TTS Prompt ステップで、[Input Text] が [Override Language Selection] と一致

することを確認してください。

MRCP TTS サブシステムがアウト オブ サービスになっている

症状   [Engine] Web ページ の [Engine Status] エリアで MRCP TTS サブシステムが アウト オブ サー

ビス になっている。

エラー メッセージ   None.

これは次のいずれかが原因で起こりえます。

 • MRCP Provider と Server が MRCP TTS Configuration の Web ページから設定されていない。

 • MRCP TTS Server がダウンしているか到達不能である。

次の手順に従ってください。

ステップ 1 MRCP Provider と Server が MRCP TTS Configuration の Web ページから設定されていることを確認

します。

ステップ 2 MRCP TTS Server が稼動していて到達可能であることを確認します。
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Long TTS プロンプトが Cisco Unified CCX サーバのかなりの量のメモリ
を消費する

症状   Long TTS プロンプトが Cisco Unified CCX サーバのかなりの量のメモリを消費する。

エラー メッセージ   None.

考えられる原因   長いテキストファイルは Cisco Unified CCX サーバのメモリ使用を増加させま

す。たとえば、5 KB テキストファイルには 2.5 MB の音声ファイルが必要です。40 TTS ポートを

持つシステムでは、シナリオにより約 120 MB のメモリが消費されます。

推奨処置   長いテキストファイルを使用する場合はシステムを適切に構築するようにしてくださ

い。

UTF-8 以外の文字が必要な言語がある

症状   フランス語やスペイン語などの言語に TTS を使用する場合、UTF-8 文字セットに無い文字が必

要になる。たとえば、ç、é または ñ が正しく処理されないと、TTS サーバはエラー メッセージを発し、

プロンプトが再生されない。

エラー メッセージ   None.

考えられる原因   デフォルトでは、ほとんどの TTS エンジンは UTF-8 文字セットだけに対応し、

一般的には ASCII 文字セットだけです。フランス語やスペイン語の文字には、ç、é または ñ など、

これに属さないものがあります。このような文字がスクリプトに必要な場合は、エンコード ポリ

シーを指定する必要があります。ほとんどの言語に対しては他の指定がない限り ISO-8859-1 エン

コードを使用してください。TTS ベンダーのマニュアルに TTS エンジンと言語に応じて必要とな

る ISO エンコーディングが記載されています。

推奨処置   このようなエンコーディングを指定するには SSML マークアップを使用する必要があ

り、純粋な文字列は使用できません。次の例で文字コーディングをどのように指定するかを示しま

す。

<?xml version="1.0" encoding="ISO-8859-1"?>
<speak>
Buonas tardes.Le estoy hablando en español.
</speak>

これはファイルで提供するか、または Workflow ステップで TTS テキスト表現として指定できます。

Workflow Editor の Expression Editor を使用する場合、いくつかの文字は正しく認識されるために「エ

スケープ」する必要があります。TTS テキスト表現で明示的に指定する場合は、同じテキストを次の

ように入力してください。

u"<?xml version=¥"1.0¥" encoding=¥"ISO-8859-1¥"?>
<speak>
Buonas tardes.Le estoy hablando en español.
</speak>
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Text-to-Speech の問題
推奨処置    u"<text string>" の形式が使用されていることに注意してください。これによって "¥" 
エスケープ文字により、引用符 （"）をエスケープすることができます。非UTF-8 文字（ñ など）

はエスケープする必要はありません。

wav ファイルのプロンプトが TTS サーバで再生するときに乱れる

症状   wav ファイルのプロンプトが TTS サーバで再生するときに乱れる。

（注） VXML スクリプトで指定されたプロンプトや CreateTTSPromptStep ワークフローを使用して作成され

たプロンプトは TTS で再生されます。このようなプロンプトではテキストと音声ファイルを合成でき

ます。Cisco Unified CCX はRIFF ヘッダーの wav ファイル フォーマットをサポートします。プロンプ

トが再生される箇所については、『Cisco Unified CCX Administration Guide』を参照してください。

エラー メッセージ   None.

考えられる原因   Nuance TTS がシステムのデフォルト TTS プロバイダーとして設定されている可

能性があります。この場合、wave ファイルのプロンプトが Nuance TTS で再生されます。Nuance 
TTS は RIFF ヘッダーの wave ファイルをサポートしません。

推奨処置   Nuance が提供するユーティリティを使用して、RIFF ヘッダーの wave ファイルを 
Sphere ヘッダーの wave ファイルに変換してください。ユーティリティは次の Nuance インストー

ルフォルダにあります。

<$Nuance>V8.5.0¥bin¥win32¥wavconvert.exe

MRCP TTS Provider、MRCP Server、地域、または 性別への変更、追
加、削除が反映されない

症状   Cisco Unified CCX Administration から行った MRCP TTS Provider、MRCP Server、地域、ま

たは 性別への変更が反映されないように見える。

エラー メッセージ   None.

考えられる原因   Cisco Unified CCX Administration から MRCP TTS Provider、MRCP Server、地
域、または性別への変更（追加、削除も含める）を行うと、これら変更は Config データベースに

は反映されますが、既にエンジンにロードされたデータには反映されません。これら変更をエンジ

ンの再起動なしで即座に有効にするには、直接 MRCP TTS サブシステムに変更を再ロードする必

要があります。

推奨処置   エンジンを再起動しないでこれら変更を即座に有効にするには、次の手順に従ってくだ

さい。
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ステップ 1 MRCP Provider、Server、または関連する地域と性別のいずれか 1 つに関係するデータを再ロードする

には、[Subsystems] > [MRCP TTS] から [MRCP TTS Configuration] Web ページを開き、対応するプ

ロバイダーの再読み込みアイコンをクリックします。この手順で新しく作成された MRCP TTS 
Provider をロードすることもできます。

ステップ 2 すべてのプロバイダーを再ロードするには、[Subsystems] > [MRCP TTS] から [MRCP TTS 
Configuration] Web ページを開き、[Refresh All] をクリックします。

Serviceability の問題
このセクションでは次の Serviceability 問題に関して、トラブルシューティングのヒントを提供しま

す。

 • 「SNMP ベースのネットワーク管理ツールが Csco Unified CCX コンポーネントをモニタできない」

（P.8-87）

 • 「ファイル マネージャがパーシャル サービスになっている」（P.8-88）

 • 「SNMP トラップが受信システムに届かない」（P.8-88）

 • 「Syslog メッセージが受信システムで受信されない」（P.8-89）

 • 「Alarm Service が起動しない」（P.8-90）

 • 「Serviceability を完全にはアンインストールできない」（P.8-90）

 • 「1 つのノードで Serviceability Tool を使用してデータを更新しても他方のノードで更新されない」

（P.8-91）

 • 「ウイルス スキャン ソフトウェアでコールの完了率が下がる」（P.8-91）

SNMP ベースのネットワーク管理ツールが Csco Unified CCX コンポーネ
ントをモニタできない

症状   Cisco Unified CCX コンポーネントを CiscoWorks などの SNMP ベースのネットワーク管理ツー

ルでモニタできない。

エラー メッセージ   None.

考えられる原因   Cisco Unified CCX コンポーネントをモニタする SNMP サブエージェントがロー

ドされていない、または正しく設定されていない、あるいは SNMP サービスが稼動していません。

推奨処置   次の手順に従ってください。

ステップ 1 それぞれのサブエージェントが次の SNMP サービス レジストリの下にキーを持っていることを確認し

ます。

HKEY_LOCAL_MACHINE¥SYSTEM¥CurrentControlSet¥Services¥SNMP¥Parameters¥ExtensionAgents
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Serviceability の問題
ステップ 2 レジストリで指定されるディレクトリの下にサブエージェントDLL が存在することを確認します。た

とえば、サブエージェント SnmpSysAppAgent が HKEY_LOCAL_MACHINE¥SOFTWARE¥Cisco 
Systems, Inc.¥SnmpSysAppAgent¥CurrentVersion の下にレジストリを持ち、SnmpSysApp サブ

エージェントの SnmpSysAppImpl.dll を指すパスネームを持ちます。

ステップ 3 Cisco Unified CCX サーバで SNMP サービスが稼動していることを確認します。SNMP サービスが稼

動していなければ起動します。

ファイル マネージャがパーシャル サービスになっている

症状   ファイル マネージャが [PARTIAL_SERVICE] になっている。MIVR/MADM ログ メッセージの

中に次のようなものがある。

エラー メッセージ   Class=class.com.cisco.doc.UserDocument.Synchronization status=2005-8-7 
14:02:05.36:Synching 1173: Aug 07 14:02:05.797 EDT 
%MADM-FILE_MGR-6-RECOVERY_DETECTED:THREAD:EventQueue.DispatchThread-0-1: 
Synchronization from Repository to local disk not performed.

考えられる原因   ノードの [RECOVERY] が実行中です。ファイル マネージャはリカバリ中に 
RDS（DB） からのファイルの同期を行わず、[RECOVERY] 状態の完了が通知されるまで自身の

状態を [PARTIAL_SERVICE] と提示します。

推奨処置   なし。これは設計どおりの動作です。

SNMP トラップが受信システムに届かない

症状   ネットワーク管理システム（NMS）が SNMP トラップを受信しない。

エラー メッセージ   None.

考えられる原因   SNMP サービス属性に設定ミスがあります。

推奨処置   次の手順に従ってください。

ステップ 1 Cisco Unified CCX サーバで [Start] > [Settings] > [Control Panel] > [Administrative Tools] > [Services] 
の順に選択します。

ステップ 2 [Name] フィールドの [SNMP Services] をダブルクリックします。

ステップ 3 [SNMP Service Properties] ウィンドウで [Traps] タブをダブルクリックして、コミュニティ名が大文字

小文字も含めて正しいことを確認します。また、トラップの宛先の IP アドレスあるいはホスト名が正

しいことを確認します。
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ステップ 4 [SNMP Service Properties] ウィンドウで [Security] タブをクリックして、少なくとも 1 つのコミュニ

ティ名が定義されていて、その権限が [READ ONLY] または [READ WRITE] となっていることを確

認します。セキュリティ ホールの原因になる可能性があるので、「パブリック」コミュニティ名を使用

しないでください。SNMP セキュリティの詳細については、Microsoft Windows のマニュアルを参照

してください。コミュニティ名の大文字小文字が正しいことを確認してください。

ステップ 5 Cisco Unified CCX サーバで [Start] > [Settings] > [Control Panel] > [Administrative Tools] > [Services] 
の順に選択して、SNMP サービスと Cisco Unified CCX Alarm Service が稼動していることを確認しま

す。

ステップ 6 Cisco Unified CCX サーバ上で Cisco Unified CCX Alarm Service がメッセージを受信していることを

確認します。

AlarmService.ini ファイルを開いて正しいポート番号が記載されていることを確認します。デフォルト 
ポート番号は 1444 です。

Alarm Service エラー ログ AlarmTracen.log（n はログ番号）を開きます（たとえば AlarmTrace11.log 
は 11 番目のログです）。デフォルトでエラー ログは次のフォルダにあります。 

C:¥Program Files¥Cisco¥AlarmService¥ AlarmServiceLog。

ステップ 7 トラップ受信システム（NMS システム）において、SNMP サービス属性で、ステップ 4 で 使用したコ

ミュニティ名と同じコミュニティ名が定義されていることを確認します。ciscoVoiceAppsMIB の
cvaNotificationEnable テーブルが true と設定されていることで、トラップが有効になっていることを

確認します。

Syslog メッセージが受信システムで受信されない

症状   NMS が Syslog メッセージを受信しない。

エラー メッセージ   None.

考えられる原因   サービス属性に設定ミスがあります。更に詳しくは「パート I: Serviceability」の

「Syslog のサポート」セクションを参照してください。

推奨処置   Cisco Unified CCX サーバで次の手順を実行してください。

ステップ 1 [Start] > [Settings] > [Control Panel] > [Administrative Tools] > [Services] の順に選択し、Cisco Unified 
CCX Alarm Service が稼動していることを確認します。

ステップ 2 Cisco Unified CCX Alarm Service がメッセージを受信していることを確認します。

AlarmService.ini ファイルを開いて正しいポート番号が記載されていることを確認します。デフォルト 
ポート番号は 1444 です。

Alarm Service エラー ログ AlarmTracen.log（n はログ番号）を開きます（たとえば AlarmTrace11.log 
は 11 番目のログです）。

ステップ 3 Syslog 受信システム（NMS システム）の設定を確認します。
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Serviceability の問題
Alarm Service が起動しない

症状   Cisco Unified Alarm Service が起動しない。

エラー メッセージ   None.

考えられる原因   AlarmNTService.exe が存在しない、またはアラーム サービスが登録されていま

せん。

推奨処置   次の手順に従ってください。

ステップ 1 AlarmNTService.exe が C:¥program files¥cisco¥AlarmService ディレクトリに存在することを確認しま

す。存在しない場合は Cisco Unified CCX システムを再インストールします。インストレーションに関

する説明は、『Cisco Unified CCX Installation Guide』を参照してください。

ステップ 2 Cisco Unified CCX Alarm Service が実行されていることを確認します。このサービスが稼動していな

い場合は、これを登録するために次のコマンドをコマンド ウィンドウで入力します。

C:¥Program Files¥Cisco¥AlarmService¥AlarmNTService -Service

Serviceability を完全にはアンインストールできない

症状   Serviceability をアンインストールしても、サービサビリティ コンポーネントを完全には削除で

きない。

エラー メッセージ   None.

考えられる原因   Cisco Unified CCX と Cisco Unified CM の両方がインストールされているサーバ

では、Serviceability ファイルのいくつかがこれら Cisco アプリケーションで共有されています。

Serviceability をアンインストールするとき、共有されているファイルを削除するかどうかを確認

するメッセージが表示されます。削除しなかった場合、これらファイルはシステムに残ります。

推奨処置   なし。
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1 つのノードで Serviceability Tool を使用してデータを更新しても他方の
ノードで更新されない

症状   1 つのノードで IP アドレスなどのデータを Serviceability Tool を使用して更新しても、他方の

ノードのデータは更新されない。

エラー メッセージ   None

考えられる原因   Serviceability Tool は一度に 1 つのノードでしか作用しません。

推奨処置   Serviceability Tool を使用して複数のノードのデータを更新する場合、それぞれのノー

ドで個別にServiceability Tool で更新を行わないと、クラスタ全体のノードは変更されません。

ウイルス スキャン ソフトウェアでコールの完了率が下がる

症状   Cisco Unified CCX システムに負荷がかかっているとき、ログ ファイルへの更新や書き込みをよ

り頻繁に行われる。このため、ウイルス スキャン ソフトウェアがより頻繁に動作するようになる。こ

れがシステム パフォーマンスに影響を及ぼす。

エラー メッセージ   None.

考えられる原因   ログ ファイルが変更されると、ウイルス スキャン ソフトウェアがそのファイル

を読み込みます。

推奨処置   システムの高負荷のもとでのコールの完了率を改善するために、いくつかのディレクト

リをウイルス スキャン ソフトウェアのスキャン対象から除外することができます。

次のディレクトリを除外してください。

 • C:¥Program Files¥wfavvid¥log

 • C:¥Program Files¥Cisco¥Desktop¥log

 • C:¥Program Files¥Cisco¥Desktop_Audio

 • C:¥Program Files¥Microsoft SQL Server¥MSSQL$CRSSQL
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Cisco Unified CCX の国際化の問題
Cisco Unified CCX の国際化の問題
このセクションでは次の国際化の問題に関して、トラブルシューティングのヒントを提供します。

 • 「中国語、日本語、韓国語で名前と名字が期待どおりにならない」（P.8-92）

 • 「指定した言語が許容されない、あるいは再生に使用されない」（P.8-92）

中国語、日本語、韓国語で名前と名字が期待どおりにならない

症状   名前と名字が中国語、日本語、韓国語で期待どおりの結果にならない。

エラー メッセージ   None.

考えられる原因   中国語、日本語、韓国語の場合は、Cisco Unified CCX User Options Alternate 
Pronunciations のページで [First Name] と [Last Name] フィールドに入力した情報は期待した結果

となって現れません。

推奨処置   この問題を回避するには、[First Name] フィールドに名前を、[Last Name] フィールド

に名字を入力してください。

指定した言語が許容されない、あるいは再生に使用されない

症状   ユーザが言語を指定してもソフトウェアがそれを許容しない、あるいはその言語を再生に使用し

ない。

エラー メッセージ   None.

考えられる原因   プロンプトや認識文法を使用しようとした時にこの問題が起こる場合は、その言

語をインストールしていないのが原因の可能性があります。標準化文書の ISO 639 と ISO 3166 で
言語と対応する地域を確認してください。Voice Browser でこの問題が起こる場合は、VXML 標準

により言語は xml:lang="<ISO 639>-<ISO 3166>" （例：en-US、fr-CA）の形式で入力すること

になっているため注意してください。VXML の区切り文字はハイフン（-）ですが、Cisco Unified 
CCX Editor、Application Administration、地域設定、インストール、およびプロンプトでは区切

り文字はアンダースコア（_）です。

推奨処置   言語のインストール状況を確認してください。次の ISO 文書で言語と地域の正しい表記

を確認してください。

 • ISO 639 は次の URL で参照できます。

 • http://www.ics.uci.edu/pub/ietf/http/related/iso639.txt

 • ISO 3166 は次の URL で参照できます。

 • http://www.chemie.fu-berlin.de/diverse/doc/ISO_3166.html

区切り文字として VXML にはハイフン（-）、その他にはアンダースコア（_）を使用するようにして

ください。
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VXML の問題
このセクションでは次の Voice XML 問題に関して、トラブルシューティングのヒントを提供します。

 • 「Voice Browser ステップのトラブルシューティングの手順」（P.8-93）

 • 「入力がない場合のタイムアウト アトリビュートが機能しない」（P.8-94）

 • 「メニュー選択の DTMF が機能しない」（P.8-94）

Voice Browser ステップのトラブルシューティングの手順

症状   Voice Browser ステップの使用上の問題を回避するためにいくつかのガイドラインに従う必要が

ある。

エラー メッセージ   None.

考えられる原因   この項目には該当しません。

推奨処置   問題を回避するために、次の手順に従ってください。

ステップ 1 Cisco Unified CCX Administration で、CMT、JTAPI、MRCP ASR、MRCP TTS、Voice Browser な
どのサブシステムが稼動中であることを確認します。

ステップ 2 ブラウザで Universal Resource Identifier（URI）が到達可能であることを確認します。

ステップ 3 プロバイダーが正しく選択されていることを確認します。

ステップ 4 VXML スクリプトを使用する際は目的の TTS プロバイダーを選択します。たとえば、Nuance 
Vocalizer 3.0の場合、設定は <property name="com.cisco.tts.provider"value="Nuance Vocalizer 
3.0"/> のようになります。

ステップ 5 VXML、文法、および音声ファイルを組み合わせる前に、各々が正しいことを個別に確認します。

ステップ 6 Voice Browser ステップをデバッグするのに役立つツールとして SS_VB、SS_MRCP_TTS、
SS_MRCP_ASR、および SS_CMT があります。詳細については、本書の「トレース」の章を参照して

ください。

ステップ 7 ファイル入手先 URL が到達可能で正しいことを確認します。

ステップ 8 Cisco Unified CCX に付属する VoiceXML DTD を使用してアプリケーション形式が正しいことを確認

します。
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入力がない場合のタイムアウト アトリビュートが機能しない

症状   Nuance の場合、タイムアウト アトリビュートを 0 と設定して VXML スクリプトを実行すると

いつまでも待ち続ける。Nuance ではタイムアウト値 0 は永久に待つことを意味するが、これは VXML 
の定義にそぐわない。

エラー メッセージ   None.

考えられる原因   次の例のように timeout=0 が指定されています。

<form id="form1"><property name="timeout" value="0s"/> <field name="myField"> <prompt 
count="1"> No input expected.Say nothing </prompt>

推奨処置   タイムアウト値を 1 ms と設定すると、実質期待どおりの動作になります。次のように

します。

<property name="timeout" value="1ms"/>

メニュー選択の DTMF が機能しない

症状   DTMF アトリビュートを True と設定して Voice XML 2.0 のメニュー要素を使用するとエラー 
error.badfetch がでる。

エラー メッセージ   error.badfetch

考えられる原因   メニュー要素を true、つまり <menu dtmf="true"> と設定した場合、DTMF 値の

選択肢として *、#、または 0 しか許容されません。たとえば、次の VXML コードが許容されませ

ん。

<menu id="aa" dtmf="true"> 

<prompt> Welcome to the automated attendant.To enter the phone number of the person you 
are trying to reach, press 1.To enter the name of the person you are trying to reach, 
press 2.To transfer to the operator, press 0.</prompt>

<choice dtmf="1" next="#dial_by_extn">1</choice>

<choice dtmf="2" next="#dial_by_name">2</choice>

<choice detm="0" next="#operator">0,/choice> </menu>

推奨処置   次の例に従えば許容されます。

<menu id="aa" dtmf="true"> <prompt> Welcome to the automated attendant.To enter the phone 
number of the person you are trying to reach, press 1.To enter the name of the person you 
are trying to reach, press 2.To transfer to the operator, press 0.</prompt>

<choice next="#dial_by_extn">1</choice>

<choice next="#dial_by_name">2</choice>

<choice dtmf="0" next="#operator">0 </choice> </menu>
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ハイ アベイラビリティとブートストラップ
このセクションでは Cisco Unified CCX 7.0（1）のハイ アベイラビリティとブートストラップの次の

問題に関して、トラブルシューティングのヒントを提供します。

 • 「Transaction Manager を起動できない」（P.8-95）

 • 「再起動時に "unable to recover transaction" などのメッセージ、あるいは Tx.per ファイルの読み込

みや変更に関するエラー メッセージが表示される」（P.8-95）

Transaction Manager を起動できない 

症状   Transaction Manager の起動に失敗したため Cisco Unified CCX も起動できない。

エラー メッセージ   The "BOOTSTRAP_START_ERROR" and "transaction manager is not 
started" error messages are in the same log statement.

考えられる原因   サードパーティの Transaction Manager（Mahalo）ログ 
wfavvid¥TxnMgrPersistence¥ が破損している可能性があります。

推奨処置   TxnMgrPersistence? ディレクトリを 手動でクリアしてください。

ステップ 1 Node Manager をシャットダウンします。

ステップ 2 wfavvid¥TxnMgrPersistence¥ ディレクトリを別のディレクトリにバックアップします。

wfavvid¥TxnMgrPersistence¥ ディレクトリ内のすべてのファイルを削除します。

ステップ 3 Node Manager を再起動します。

再起動時に "unable to recover transaction" などのメッセージ、あるい
は Tx.per ファイルの読み込みや変更に関するエラー メッセージが表示さ
れる 

症状   現象 #1：ログ内に TxLoggerException?、TxLoggerIOException?、
TxLoggerClassNotFoundException?、TxLoggerFileNotFoundException?、などの Tx......Exception の
形式の例外がある。

現象 #2：bootstrap_mgr デバッグ ログを有効にすると、"Recovery.recover" と "about to recover." は表

示される。しかし、"Recovery.recover(): total pending tx" や "Recovery.recover(): no pending tx" は表

示されない。

現象 #3: Tx.per ファイルに関するメッセージが表示される。
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エラー メッセージ   See the previous symptoms topic for the message.

考えられる原因   ファイル BSTxState? が 破損している可能性があります。

推奨処置   BSTxState? ディレクトリを手動でクリアしてください。

ステップ 1 Node Manager をシャットダウンします。

ステップ 2 wfavvid¥BSTxState¥ ディレクトリを別のディレクトリにバックアップします。wfavvid¥BSTxState¥ 
内のすべてのファイルを削除します。

ステップ 3 Node Manager を再起動します。

ハイ アベイラビリティとフェールオーバー
このセクションでは Unified CCX 7.0（1）のハイ アベイラビリティとフェールオーバーの次の問題に

関して、トラブルシューティングのヒントを提供します。

 • 「Datastore Control Center の履歴に競合がある」（P.8-97）

 • 「HA クラスタの構成変更ができない」（P.8-97）

 • 「RmCm サブシステムの構成変更ができない」（P.8-98）

 • 「サービス状態が無効のままである」（P.8-98）

 • 「Cisco Unified CCX Node Manager の障害のため、Cisco Unified CCX がリブートし続ける」

（P.8-99）

 • 「クラスタがパーシャル サービスになっている」（P.8-99）

 • 「サーバがパーシャル サービスになっている」（P.8-100）

 • 「Cisco Unified CCX が適切にコールや機能を受け付けない」（P.8-100）

 • 「Cisco Unified CCX Administration Control Center でサービスのマスター /スレーブ状態が表示さ

れない」（P.8-101）

 • 「クラスタの時刻同期がはずれる」（P.8-101）

 • 「Cisco Unified CCX サーバが HA 環境で反応が遅い」（P.8-102）

 • 「CPU 使用率が高いと複数のフェールオーバーが発生する」（P.8-102）
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Datastore Control Center の履歴に競合がある

症状   ハイ アベイラビリティ構成において、サブスクリプション エージェント履歴のコメント カラム

にメッセージが表示される。Cisco Unified CCX Administration からメッセージを参照するには、サブ

スクリプション エージェントに関して [Datastore Control Center] > [History] を選択する。

エラー メッセージ   A message similar to Downloaded 111 data changes (0 inserts, 111 updates, 0 
deletes, 111 conflicts) appears.

考えられる原因   ハイ アベイラビリティ構成では SQL マージ レプリケーションによりサブスクラ

イバ ノードからパブリッシャ ノードにデータが複製されます。このとき SQL はサブスクリプショ

ン エージェント履歴にこれらメッセージを残します。

推奨処置   対処は必要ありません。

HA クラスタの構成変更ができない

症状   1 つのノードがダウンしているときにハイ アベイラビリティ クラスタの構成変更ができない。

エラー メッセージ   None.

考えられる原因   構成変更が同時に両ノードの構成データストアに記録されるため、1 つのノード

がダウンしている時は構成変更ができません。

推奨処置   次の手順に従ってください。

ステップ 1 パブリッシャがアクティブ ノードであることを確認します。そうでない場合、Cisco Unified CCX 
Administration を使用してパブリッシャをすべてのデータストアに対するアクティブ ノードに設定し

ます。

ステップ 2 Component Activation のリンクからCDS と HDS を非アクティブ ノードに対して無効にします。
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RmCm サブシステムの構成変更ができない

症状    ハイ アベイラビリティ展開では、追加 /削除スキルやチームなど、RmCm サブシステムの設定

変更をユーザから行うことはできない。

エラー メッセージ   There was an error reading/updating the database.Please contact your administrator.

考えられる原因   Cisco Unified CCX では設定データは Configuration データストアに格納されてい

て、Microsoft SQL データベースで管理されています。ハイ アベイラビリティ データベースでは

通信に Microsoft Distributed Transaction Coordinator（MS DTC）サービスを使用していて、MS 
DTC サービスは NetBIOS 名で他の MS DTC サービスと通信します。この問題はデータベース 
ノードの名前解決に失敗して、MS DTC が通信できなかった場合に発生します。

推奨処置   データベース ノード相互の通信を確認してください。その際に IP アドレスだけで確認

しても十分ではありません。DTC では NetBIOS や DNS でコンピュータ名をアドレス解決するか

らです。ping を使用して NetBIOS がサーバ名からアドレス解決できるかを確認できます。クライ

アント コンピュータはサーバ名のアドレス解決ができる必要があり、サーバはクライアントのア

ドレス解決ができる必要があります。NetBIOS が名前からアドレス解決をできない場合は、コン

ピュータ上の LMHOSTS ファイルにエントリを追加してください。

MS DTC の問題を解決するために、Microsoft から DTCPing.exe をダウンロードすることができます。

次の URL にアクセスしてください： http://support.microsoft.com/default.aspx?scid=kb;en-us;250367。

サービス状態が無効のままである

症状   Cisco Unified CCX Node Manager がサービスを開始できず、Cisco Unified CCX Administration 
で状態が [Invalid] と表示されている。

エラー メッセージ   A red X mark displays beside the service in Cisco Unified CCX 
Administration.

考えられる原因   指定したサービスに問題が多く発生し過ぎていることが原因である可能性があり

ます。

推奨処置   『Cisco Unified CCX Installation Guide』 を参照して、障害が発生しているサービスを修

復してください。
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Cisco Unified CCX Node Manager の障害のため、Cisco Unified CCX 
がリブートし続ける

症状   Cisco Unified CCX Node Manager の障害のため、Cisco Unified CCX がリブートし続ける。

エラー メッセージ   A Microsoft Windows message shows a server reboot in 60 seconds 
due to the service failure.

考えられる原因   Cisco Unified CCX Engine、Cisco Unified CCX Administration、データストア、

およびデスクトップ サービスなど、さまざまなコンポーネントの障害がこの問題の原因として考

えられます。

推奨処置   次の手順に従ってください。

ステップ 1 Windows Services コントロール パネルを開きます。[Recovery] タブで 1 回目 /2 回目 /その後の障害に

対するアクションを [Take No Action] と設定します。

ステップ 2 まず Cisco MCVD ログで障害が発生したサービスを特定し、次にそのサービスのログから原因を見つ

けます。

ステップ 3 障害を修復したら、障害に対するアクションを次のように元に戻します。1 回目の障害：サービスを再

起動、2 回目障害：コンピュータをリブート、その後の障害：コンピュータをリブート。

クラスタがパーシャル サービスになっている

症状   Cisco Unified CCX Administration Control Center で Cisco Unified CCX のクラスタ状態が 
[PARTIAL_SERVICE] になっている。

エラー メッセージ   PARTIAL_SERVICE on Cisco Unified CCX Administration Control Center 
web page under a specific server link.

考えられる原因   少なくとも 1 つのサーバの状態が [IN_SERVICE] 以外になっています。

推奨処置   問題のサーバにログインして、Cisco Node Manager がそのサーバで実行されているか

を確認してください。参考になる情報がないか MCVD ログを見てください。
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サーバがパーシャル サービスになっている

症状   Cisco Unified CCX Administration Control Center で Cisco Unified CCX のサーバの状態が 
[PARTIAL_SERVICE] になっている。

エラー メッセージ   PARTIAL_SERVICE on the Cisco Unified CCX Administration Control 
Center web page under a specific server link.

考えられる原因   少なくとも 1 つのサービスの状態が [IN_SERVICE] 以外になっています。

推奨処置   Cisco Unified CCX Administration Control Center の Web ページから次の手順を実施し

てください。

ステップ 1 [IN_SERVICE] でないサービスがあったら、そのサービスのログから原因を見つけます。

ステップ 2 [Invalid] となっているサービスがあったら、ヒント「Service constantly shows Invalid」を参照してく

ださい。

Cisco Unified CCX が適切にコールや機能を受け付けない

症状   Cisco Unified CCX システムが適切にコールや機能を受け付けない。

エラー メッセージ   From the Cisco Unified CCX Administration Control Center, under a 
specific server link, there is neither Cisco Unified CCX Engine nor Cisco Unified 
CCX SQL Server (Config/Historical/Repository/Agent).

考えられる原因   ひとつの原因として、該当コンポーネントが起動されていないことが考えられま

す。

推奨処置   Cisco Unified CCX Administration の Web ページから該当コンポーネントを起動してく

ださい。
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Cisco Unified CCX Administration Control Center でサービスのマス
ター /スレーブ状態が表示されない

症状   Cisco Unified CCX Administration Control Center の Web ページにサービスのマスター/スレー

ブ状態が表示されない。

エラー メッセージ   There is no Master or Slave icon next to a service.

考えられる原因   この問題は次のいずれかが原因で起っている可能性があります。

 • そのサービスが起動されていない。

 • そのサービスが依存するサービスが起動されていない。たとえば、Cisco Desktop Service は Cisco 
Unified CCX Engine が稼動していないとマスター /スレーブ状態が表示されません。また、Cisco 
SQL Server （Config/Historical/Repository/Agent）は Microsoft Distributed Transaction 
Coordinator または Microsoft SQL Agent が稼動していないとマスター /スレーブ状態が表示され

ません。

推奨処置   依存するサービスを起動してください。

クラスタの時刻同期がはずれる 

症状   Cisco Unified CCX マシン上のクラスタ 時刻が Cisco Unified CM と同期されていない。

エラー メッセージ   The Network Time Protocol Service on the Cisco Unified CCX machine 
exits with a message in the event log stating that the time difference is greater 
than the threshold.

考えられる原因   NTP サービスには 1000 秒のしきい値が組み込まれています。NTP クライアント

（Cisco Unified CCX マシン）と サーバ（Cisco Unified CM）との間でこのしきい値を超える時間

差があると、NTP サービスによる時間補正が行われません。

推奨処置   次の手順に従ってください。

 • クラスタの Cisco Unified CCX マシンのクロックを手動で設定します。Cisco Unified CCX マシン

の 時刻が Cisco Unified CM マシンの時刻とほぼ同じであるようにします。

 • Service Control Manager から Cisco Unified CCX マシンの Network Time Protocol サービスを再

起動します。
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Cisco Unified CCX サーバが HA 環境で反応が遅い

症状   Cisco Unified CCX サーバがハイ アベイラビリティ（HA） 環境で反応が非常に遅い。応答に時

間がかかるため Cisco Unified CCX システムが使用に堪えない。コールがまったくエージェントに届か

ない。

エラー メッセージ   LDAP error 51 in MADM logs.SDL and SQL errors on the Subscriber.

考えられる原因   パブリッシャとサブスクライバのデータベースの同期が取れていません。

推奨処置   パブリッシャとサブスクライバのデータベースの同期を取ってください。

CPU 使用率が高いと複数のフェールオーバーが発生する

症状   ハイ アベイラビリティ環境において両サーバの CPU 使用率が高くなると複数のフェールオー

バーが発生する。Cisco Unified CCX サーバを起動すると、プライマリ サーバの CPU 使用率が上が

り、その結果使用できなくなってセカンダリ サーバにフェールオーバーする。セカンダリ サーバにも

同じことが起こり、その結果 プライマリ サーバにフェールオーバーする。

エラー メッセージ   None.

考えられる原因   この問題はカスタマー Java ステップが原因で発生している可能性があります。

推奨処置   スクリプトの中のカスタマー Java ステップを探して削除してください。
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VoIP Monitor の問題
このセクションでは次の VoIP Monitor 問題に関して、トラブルシューティングのヒントを提供します。

 • 「VoIP Monitor が正しく機能しない」（P.8-103）

 • 「Cisco Unified CCX が起動に失敗する」（P.8-103）

 • 「CDA の [VoIP Monitor] タブでエラーが発生する」（P.8-104）

VoIP Monitor が正しく機能しない

症状   VoIP Monitor が正しく機能しない。

エラー メッセージ   None

考えられる原因   VoIP Monitor がエージェント電話機のボイス LAN 上にありません。

推奨処置   Cisco CAD Installation Guide at Cisco Unified CCX に VoIP Monitor がインストールさ

れている場合は、『Cisco CAD Installation Guide』（Cisco Unified Contact Center Express Install 
and Upgrade Guides web site）の「Appendix」で VoIP 用に複数の NIC を使用する場合の記述を参

照してください。CRS 5.0 はコンピュータ上にインストールされた VoIP Monitor だけをサポート

します。

Cisco Unified CCX が起動に失敗する

症状   Cisco Unified CCX ノード マネージャが起動に失敗する。

エラー メッセージ   None

考えられる原因   Cisco Unified CCX サーバ上に 2 つの NIC があります。2 番目の NIC が Voice 
Monitor に使用されています。

状況を把握するために、次の手順に従ってください。

ステップ 1 Windows 2003 で [Start] > [Settings] > [Network Connection] の順に選択します。

ステップ 2 [Advanced] ドロップ ダウン メニューをクリックします。

ステップ 3 [Advanced Settings] > [Adapters and Bindings] の順に選択します。

ステップ 4 [Connections] ウィンドウで、VoIP Monitor 用の NIC が上位の順番になっていることを確認します。

推奨処置   VoIP Monitor の NIC を、Cisco Unified CCX の通信に使用されている NIC より下のプ

ライオリティに設定してください。
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VoIP Monitor の問題
CDA の [VoIP Monitor] タブでエラーが発生する

症状   CCM と CME の両方の展開で、これらが正しく設定されていないと CDA の [VoIP Monitor] タ
ブでエラー メッセージが表示される。

エラー メッセージ   Error Reading from Directory services

推奨処置   CCM 展開では、電話機を Cisco Unified CM の RmCm アプリケーション ユーザに対応

付けてください。

CME 展開では CME ルータで次のコマンドを実行して、CDA の VoIP タブ に設定されている電話機を

確認してください。

Cisco2800(config)#ixi transport http 

Cisco2800(conf-xml-trans)#response size 64 

Cisco2800(conf-xml-trans)#no shutdown 

Cisco2800(conf-xml-trans)#exit 

VoIP Monitor の電話機リストに表示されない電話機がある

症状   Cisco Communications Manager Express（CME）展開の Web ベースの Cisco Desktop 
Administrator で [VOIP Monitoring Device] タブをクリックすると次のエラー メッセージが表示され

る。

エラー メッセージ   CDAUI2000 An error has occurred.Contact technical support

回避策：

ステップ 1 Cisco CME routerにログインして （ハイパー ターミナルまたは telnet で）、ユーザ名とパスワードを入

力します。

ステップ 2 enable と入力して、Privilege コマンドを有効にします。

ステップ 3 Return キーを押します。

ステップ 4 パスワード入力を求めるメッセージが表示されるので、パスワードとして enable と入力します。

ステップ 5 Return キーを押します。

ステップ 6 Configure t と入力します。

ステップ 7 Return キーを押します（ここから設定モードに移行し、端末から CME ルータの設定を変更をできる

ようになります）。

ステップ 8 次のコマンドを実行してバッファ サイズを 4K から 64K に増やします。

 • ixi transport http

 • response size 64

 • no shutdown

 • request outstanding 1 
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CDP の問題 
ステップ 9 CME ルータで write コマンドを実行します。これにより現在の設定情報がメモリ、ネットワーク、ま

たは端末に書き込まれます。

ステップ 10 Web ベースの Cisco Desktop Administrator を起動します。

ステップ 11 [Services Configuration] > [Silent Monitoring and Recording] > [VOIP Monitor Device] の順に選択し

ます。

以上の変更により電話機が [VOIP Monitor Device] に表示されるようになります。

CDP の問題
このセクションでは次のトラブルシューティングのヒントを提供します。

「Device Manager に CDP Protocol Driver が無い」（P.8-105）

Device Manager に CDP Protocol Driver が無い

症状   ノードで修復作業を行うと CDP Protocol Driver が Device Manager から無くなる。

回避策：

ステップ 1 cdp.sys が C:¥winNT¥system32¥drivers に有ることを確認します。

ステップ 2 レジストリのHKEY_LOCAL_MACHINE¥SYSTEM¥CurrentControlSet¥Services を開きます。

ステップ 3 次の手順で CDP を見つけます。

 • Device Manager を開きます。[My Computer] を右クリックして、[Properties] > [Hardware] タブ

へと進み、[Device Manager] をクリックします。

 • [View] メニューをクリックして [show hidden devices] アイテムを確認します。

 • [View] メニューで [Devices by connection] オプションを選択します。

 • ノードをいずれか右クリックして [Scan for Hardware Changes] オプションを選択します。

[CDP Driver Protocol] が有るか確認します。もし有れば CDP ドライバがインストールされています。
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CDP の問題
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